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Dear Customer:

You have probably heard from news reports and from your sales 
representative that as of November 1, 1999, four of Hewlett-Packard’s 
businesses became a new company -- Agilent Technologies. The new 
company includes the following former HP businesses: test and measurement, 
semiconductor products, healthcare solutions and chemical analysis.

We at Agilent Technologies are working diligently to make this transition as 
seamless as possible for you, however, we are not able to make all changes 
immediately. As a result, the products and related documentation contained in 
this shipment may be labeled with either the Hewlett-Packard name and logo 
or the Agilent Technologies name and logo. Rest assured that whatever logo 
you see, the information, products and services come from the same reliable 
source. 

In addition, it is our sincere intent that the transition from Hewlett Packard to 
Agilent Technologies should have no impact on your warranties, service 
levels, or purchase volume credits.

For more information about this transition, please visit our website at:
http://www.agilent.com and click on Frequently Asked Questions about doing 
business with Agilent, or contact your local sales representative.   It has been 
our pleasure to work with you for the past 60 years as part of Hewlett-
Packard. We look forward continuing to serve you as Agilent Technologies 
for years to come.
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Notice

The information contained in 
this document is subject to 
change without notice. 
Companies, names, and data 
used in examples herein are 
fictitious unless otherwise 
noted. 
Agilent Technologies, Inc. 
makes no warranty of any kind 
with regard to this material, 
including but not limited to, the 
implied warranties of 
merchantability and fitness for a 
particular purpose. 
Agilent Technologies, Inc. shall 
not be liable for errors 
contained herein or for 
incidental or consequential 
damages in connection with the 
furnishing, performance, or use 
of this material.

Restricted Rights Legend

Use, duplication, or disclosure 
by the U.S. Government is 
subject to restrictions as set 
forth in subparagraph (c) (1) (ii) 
of the Rights in Technical Data 
and Computer Software clause 
at DFARS 252.227-7013 for 
DOD agencies, and 
subparagraphs (c) (1) and (c) (2) 
of the Commercial Computer 
Software Restricted Rights 
clause at FAR 52.227-19 for 
other agencies.

Warranty

This Agilent Technologies, Inc. 
instrument product is warranted 
against defects in material and 
workmanship for a period of 
one year from date of shipment. 
During the warranty period, 
Agilent Technologies, Inc. 
Company will, at its option, 
either repair or replace products 
which prove to be defective. For 
warranty service or repair, this 
product must be returned to a 
service facility designated by 
Agilent Technologies, Inc.. 
Buyer shall prepay shipping 
charges to 
Agilent Technologies, Inc. and 
Agilent Technologies, Inc. shall 
pay shipping charges to return 
the product to Buyer. However, 
Buyer shall pay all shipping 
charges, duties, and taxes for 
products returned to 
Agilent Technologies, Inc. from 
another country.

Agilent Technologies, Inc. 
warrants that its software and 
firmware designated by 
Agilent Technologies, Inc. for 
use with an instrument will 
execute its programming 
instructions when properly 
installed on that instrument. 
Agilent Technologies, Inc. does 
not warrant that the operation of 
the instrument, or software, or 
firmware will be uninterrupted 
or error-free. 

Limitation of Warranty

The foregoing warranty shall 
not apply to defects resulting 
from improper or inadequate 
maintenance by Buyer, Buyer-
supplied software or interfacing, 
unauthorized modification or 
misuse, operation outside of the 
environmental specifications for 
the product, or improper site 
preparation or maintenance.

No other warranty is expressed 
or implied. 

Agilent Technologies, Inc. 
specifically disclaims the 
implied warranties of 
merchantability and fitness for a 
particular purpose. 

Exclusive Remedies

The remedies provided herein 
are Buyer’s sole and exclusive 
remedies. 
Agilent Technologies, Inc. shall 
not be liable for any direct, 
indirect, special, incidental, or 
consequential damages, whether 
based on contract, tort, or any 
other legal theory.

Hewlett-Packard ® is a 
registered trademark of 
Hewlett-Packard Limited.

ArcView ® is a registered 
trademark of Environmental 
Systems Research Institute, Inc.

MapInfo ® is a registered 
trademark of MapInfo 
Corporation.

Pentium ® is a registered 
trademark of Intel Corporation.

PlaNET ® is a registered 
trademark of Mobile Systems 
International.

Adobe ® is a trademark of 
Adobe Systems Incorporated.

Windows NT ® and 
Windows 95 ® and 
Windows 98 ® are U.S. 
registered trademarks of 
Microsoft Corporation.
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Safety and Regulatory Information

Review this product and related documentation to familiarize yourself with 
safety markings and instructions before you operate the system. This product 
has been designed and tested in accordance with appropriate international 
standards.

For more details on Safety and Regulatory Information, refer to Chapter 7, 
“Safety and Regulatory Information”

MUST READ FIRST

WARNING The WARNING notice denotes a hazard. It calls attention to a procedure, 
practice, or the like, that, if not correctly performed or adhered to, could result in 
personal injury. Do not proceed beyond a WARNING notice until the indicated 
conditions are fully understood and met.

CAUTION The CAUTION notice denotes a hazard. It calls attention to an operating 
procedure, practice, or the like, which, if not correctly performed or adher
to, could result in damage to the product or loss of important data. Do no
proceed beyond a CAUTION notice until the indicated conditions are fully 
understood and met. 
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Welcome to Your Agilent Wireless Solutions
Welcome to Your Agilent Wireless Solutions

Thank you for choosing Agilent Technologies, Inc.. In this getting started 
guide, you’ll find the setup instructions you need to begin taking 
measurements.

Follow These Steps

If You Need Help...

To Do This See This And Check This

1  Install the software. Chapter 1, “Installing the 
Software”

If you have purchased a computer from 
Agilent with your system, the software 
came pre-installed. Go to step 2.

2 Set up your system. Chapter 2, “Setting Up 
Your System”

You’ll find all system configuration 
information, including GPS (Global 
Positioning System) setup here.

3 Verify the system. Chapter 4, “Verifying the 
System”

Perform these tests to ensure that your 
system is ready to make measurements.

4 Start the software. Chapter 3, “Starting and 
Learning to Use the 
Software”

An online tutorial and online help instruct 
you how to use your system.

To Do This... See This

Get training http://agilent.com/find/drive_test 

Check the web site for information about training registration, software 
updates, phone support, FAQs, and more.

Get help Chapter 5, “Solving Problems and Updating Your System”

Find GPS installation tips and more.

Check specification or 
confirm the contents of 
your system.

Chapter 6, “Hardware and Software Specifications”

Agilent E74xx System Options and Accessories Guide (refer to 
Chapter 3, “Viewing and Printing Online Documents”)
Wireless Solutions Getting Started Guide v
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For 
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 ® 
Online Getting Started Guide

If you would like an additional copy of this Guide, check the following web 
site for the latest PDF1 version:

http://www.agilent.com/find/manuals and then search for your system type

This PDF version has also be loaded with your application software, if you 
chose the typical installation. For more information on accessing this and 
other online documentation, refer to “Additional Documentation” on 
page 3-14.

Systems Covered by this Guide

The following table outlines the wireless solutions covered by this guide. 
more detailed lists of system options and accessories, refer to the online
Agilent E74xx System Options and Accessories Guide. This guide has been 
loaded with application, if you chose the typical installation. For more 
information on accessing this guide and other online documentation, refe
“Additional Documentation” on page 3-14. 

1. Portable Document Format - online version that can be viewed using Adobe

Acrobat reader.

For more information about this reader, refer to http://www.adobe.com

System Part Number Description

Agilent E7473A CDMA Cellular and PCS Network Test System

Agilent E7474A TDMA Cellular and PCS Network Test System

Agilent E7475A GSM900, DCS1800 and GSM1900 Network Test Systems

Agilent E7490A CDMA Base Station Over Air Maintenance Test System
vi Wireless Solutions Getting Started Guide
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Chapter 1: Installing the Software
What You’ll Find in This Chapter
What You’ll Find in This Chapter

Read This First

If you purchased your laptop computer as part of Agilent 86154A option 010 
or option 030, the software came factory-installed. Skip this procedure and go 
to Chapter 2, “Setting Up Your System”.

The factory-installed software does not include Adobe Reader.

To Do This See This

Install the system software “Installing the Software” on page 1-3

Install the License Manager software “Agilent Technologies License Manager” on 
page 1-5

Install Adobe Reader “Installing Adobe Reader” on page 1-6

Install Socket I/O card software “Installing Socket PCMCIA I/O Card Software” 
on page 1-7
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Before you begin installing the software, ensure that your computer system is 
configured with the minimum requirements. Check “Personal Computer 
Recommendations, Minimum” on page 6-68 for information.

Follow These Steps

Do This See This

1 Insert the CD-ROM into the CD-ROM drive, 
choose Start>Run, and type d:\setup where 
d: is the drive containing the software CD-
ROM. Click OK.

A Welcome dialog box appears instructing you to 
close any currently running Windows 
applications before you begin installation.

2 Click Next when you are ready to continue the 
installation. Type your name and the name of 
the company you work for, then click Next.

The “Choose Destination Location” dialog box 
appears. The default folder for installation is 
C:\Program Files\Agilent Technologies\E74xx 
(depending on the system you’re installing). 

3 If you wish to install the program in a folder 
other than the default, click Browse to display 
text. When the correct destination folder 
appears in the field, click Next. 

The Setup Type box appears.

4 Select the type of installation you want: 
typical, compact, or custom, and click Next. 

•Typical: Includes Agilent E74xx application, 
online help files, tutorial and documentation.

•Compact: Includes Agilent E74xx application 
and online help files

•Custom: Lets you select individual 
components. 

The Destination Folder box appears.

Agilent Technologies recommends using the 
Typical installation. Refer to page 6-68 to see if 
you have enough disk space available to perform 
the Typical installation before proceeding.
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e 

NOTES • It is recommended that new users go through the online tutorial before 

using the software. Refer to Chapter 3, “Starting and Learning to Use th
Software” for instructions on running the online tutorial.

• When you run the software, disable the Windows 95 Advanced Power 
Management Support capabilities to significantly improve the 
performance of the system.

5 Select the destination folder for the program. 
The default folder is “C:\Program Files\Agilent 
Technologies\ E74xx” or you can select a 
different folder that can be found on your 
system. Click Next.

The list of folders found on your system is 
displayed.

Agilent Technologies recommends using the 
default folder

6 Read the list of software installation options 
and check that Setup Type, Target Folder, and 
User Information are correct, and click Next.

The software installs from CD to PC.

7 Click Finish to complete the installation. Depending on the files installed or updated you 
may be prompted to reboot your system.

Do This See This
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Agilent Technologies License Manager

The hardware key that came with your Agilent Technologies system enables 
and secures the functionality you purchased from Agilent. The Agilent 
License Manager, automatically installed when you install the 
Agilent Wireless Solutions Software, enables you to manage licensing 
security information. You can use the software to:

• Add product options to license keys. You can add licenses (temporary or 
permanent) to the license key by entering a string obtained from an 
Agilent representative.

• Transfer licensed product options between license keys in order to 
consolidate licenses onto one key.

• Transfer a license from one key to another.
• Transfer licenses between keys on different computers. You can move 

license options to license keys on another computer that is located 
anywhere from the same room to another country.

For more information on learning and using the license manager refer to 
“Learning the License Manager” on page 3-13. Details on the operation of the
license manager can be found in the online help.
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NOTE Before starting the installation process, ensure that you have removed 
previous versions of Adobe reader. This version is Adobe Reader 4.05.

Do This See This

1 Insert the CD-ROM into the CD-ROM 
drive, choose Start>Run, and type 
d:\Acrobat\rs405eng.exe where d: is the 
drive containing the software CD-ROM. 
Click OK.

A Welcome dialog box appears detailing copyright 
information.

2 Click Next when you are ready to 
continue the installation.

The “Choose Destination Location” dialog box 
appears. The default folder for installation is 
C:\Program Files\Adobe\Acrobat4.0

3 If you wish to install the program in a 
folder other than the default, click 
Browse to display text. When the correct 
destination folder appears in the field, 
click Next. 

The software will install from CD to PC. 

4 Once the installation is complete, click 
OK. 

A user guide for the Adobe Reader has been 
provided on the CD in PDF format.
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Installing Socket PCMCIA I/O Card Software

If you have a phone or phone/receiver-based system, a serial I/O card (such as 
the Socket Ruggedized Serial I/O card) must be installed in the PCMCIA slot 
(Personal Computer Memory Card International Association) to configure the 
system properly. See Chapter 2, “Setting Up Your System” for instructions on 
installing the I/O card. The software that is provided with the serial I/O ca
must be installed at the time the I/O card is installed. 

NOTE See Chapter 3, “Software Setup” of the Serial I/O ™ and Ruggedized Serial
I/O Card ™ User’s Guide for instructions on installing the software for that 
specific card.

If you are using the USB 4-Port adapter, Agilent 86154A option 036, refer to 
the Agilent Technologies Indoor Test System Setup Guide for more 
information.
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What You’ll Find in This Chapter
What You’ll Find in This Chapter

NOTE Trimble provides downloadable documentation on the Web. At the time of 
this printing, you can find the files (Microsoft Word and PDF formats) at 
http://www.trimble.com/mpc/placer/download/manuals.htm. If the 
URL has changed, use the search facility provided at the Web site 
(www.trimble.com). For further information about support and training, you 
can contact Trimble at a phone number on their Web site.

To Do This See This

Connect the hardware “Hardware Installation Tips” on page 2-3 covers 
important setup information.

“Connecting the Hardware” on page 2-7 covers 
setup of all types of systems. Refer to this page 
for the pages that cover your particular system.

Configure hardware automatically. “Automatic Configuration” on page 2-5

Configure internal GPS. “Internal GPS & Internal GPS with Differential 
Setup” on page 2-26

Configure multiple receivers and/or multiple 
phones.

“Configuring Multiple Receivers and Phones” on 
page 2-74

Review receiver connection panels and 
connectors.

“Universal Serial Bus (USB), 4-port Adapter 
Configuration” on page 2-87

Set pin-out specifications for serial port 
connection.

“Receiver to PC Serial Port Cable Configuration” 
on page 2-91

Configure other GPS units. “RS-232 to GPS Unit Cable Configuration” on 
page 2-92

Set pin-out specifications for connecting 
differential GPS receiver to a receiver with an 
internal GPS.

“RS-232 to Differential Unit Cable Configuration” 
on page 2-93
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Item Information

Hardware security key The hardware security key must be connected to the parallel port 
of the PC. The application runs with a limited feature set without 
the key. You cannot configure projects or collect data without the 
key.

Power supply connections Make sure that power supply connections to the GPS, the 
receiver, the PC, and the phones (if applicable) are correct. 

PC turn on After all cables are connected, turn on the PC. The PC should 
be the last device you turn on.

Create a project Make sure your hardware is properly configured.

1 Verify hardware type and COM port settings.

2 Open application and choose a project from the Project drop- 
down list that best represents your hardware configuration.

3 Click Configuration and go to Hardware tab. Verify or add 
descriptions to complete hardware configuration or use the 
Automatic Configuration wizard (refer to “Automatic 
Configuration” on page 2-5).

4 Click Collection to verify that there are no COM errors. If 
errors appear, repeat previous steps or refer to Chapter 5, 
“Solving Problems and Updating Your System”.

5 Click Save As and name current project.

6. Set project as default project under Tools > Options >New 
Project and click OK.
Wireless Solutions Getting Started Guide 2-3



Chapter 2: Setting Up Your System
Hardware Installation Tips
NOTE For continued protection against fire hazard, replace the line fuse (cigarette 
lighter/2 amp 32 V FB fuse, Agilent part number 2110-0002) only with the 
same type of rating (type nA/nV). The use of other fuses or materials is 
prohibited.

Configuring hardware The Wireless Solutions system assigns the serial port of the 
receiver to COM1 by default. If you want to use a different port, 
modify the serial port setting for the receiver in the application 
software as follows. 

1 After starting the Wireless Solutions application software, click 
the Configuration button. 

2 Select the Hardware tab and highlight the Agilent E645x 
receiver. Click the Modify button. 

3 Set the desired COM port. It is recommended that you accept 
the program defaults for other settings.

4 If the system includes a GPS receiver, you must also change 
its COM port.

Cable handling Verify all cable connections against the illustrations in the 
following sections of this chapter. Cables can be damaged. 
Please handle them carefully.

GPS verification Can be done two ways:

• Use the appropriate Trimble or GPS software, if applicable.

• Use your Agilent system software.

GPS software selection See “Selecting GPS Hardware” on page 3-4 for information on 
selecting GPS hardware in the GPS software.

Socket Serial I/O card installation Refer to the User’s Guide supplied by Socket Communications 
for instructions on installing the Socket Serial I/O card and driver 
software.

Universal Serial Bus, 4-port 
adapter (Agilent 86154A, 
option 036)

See “Universal Serial Bus (USB), 4-port Adapter Configuration” 
on page 2-87 for information on installing and using this piece of 
hardware.

Troubleshooting See Chapter 5, “Solving Problems and Updating Your System” 
for troubleshooting information.

Item Information
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The Agilent Wireless Solutions Software can automatically configure 
hardware that has been connected to your laptop. By clicking the Auto Config 
button, you begin the automatic configuration wizard (see Figure 2-1). This 
wizard checks a defined list of COM ports for recognized hardware. Once all 
ports have been checked, the attached hardware is automatically set up with 
the correct settings.

The automatic configuration wizard can be used for setting up new hardware 
and projects, or for updating previously saved configurations.

You can speed up the configuration process by selecting the types of hardware 
to be attached to your system and the COM ports used. This limits the list of 
hardware types and COM ports searched during configuration. To enable this 
feature select Tools > Options > Other >”Enable auto-config COM and device customization”. 
See Figure 2-2, and Figure 2-3 on page 2-6.

Figure 2-1 Accessing the Automatic Configuration Wizard

Automatic
Configuration
button
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Figure 2-2 Enabling the auto-configuration customization features

Figure 2-3 Defining COM ports and device types to be searched during the 
configuration process
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Connecting the Hardware

The software must be installed before you install the hardware. If your system 
includes 86154A option 010, a laptop computer, or 86154A option 030, a pen 
tablet computer, the software was factory-installed. Otherwise, refer to 
Chapter 1, “Installing the Software” for instructions. 

Table 2-1 directs you to the configuration instructions for receiver, phone, a
combination systems with most types of GPS. If you have a GPS that is n
listed, use Table 2-1 to find the one that most resembles your own. Also re
to the pin-out illustration “RS-232 to GPS Unit Cable Configuration” on 
page 2-92. 

Table 2-1 GPS System Configurations
. 

NOTE Your system can be configured using either Agilent Technologies supplie
options or customer-supplied components.

If You Have This with Receiver 
Only

with Phone Only with Receiver 
and Phone

Trimble Placer GPS/DR page 2-10 page 2-54 page 2-32

Trimble Placer GPS 455 page 2-18 page 2-62 page 2-40

Trimble Placer 455 & Differential page 2-22 page 2-66 page 2-44

Trimble Placer GPS 455 with 
Dead Reckoning

page 2-28 page 2-70 page 2-50

Internal GPS & Differential page 2-26 page 2-48

Trimble Placer GPS 400 or 
SVeeSix

page 2-14 page 2-58 page 2-36
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st, 
tart” 
CAUTIONS • The input power to the Agilent digital receiver should not exceed
-10 dBm. Receiver measurements are not warranted for power levels 
between -10 dBm and 10 dBm. Power levels greater than 10 dBm damage 
the instrument.

• For optimum performance, it is recommended that no more than -40 dBm 
be applied to the input of all other types of receivers.

• Never test the vehicle’s battery when your GPS is connected to it. Fir
disconnect the GPS receiver, and then test your battery. Never “jumps
your vehicle’s battery with the GPS connected. It may cause severe 
damage to the GPS receiver.
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Connecting the Hardware
NOTES • Agilent Technologies suggests that you verify that the GPS is working 
properly before you connect it to the Agilent Wireless Solutions system.

• The Trimble Placer DR, Trimble Placer GPS 400, and SVeeSix Plus DO 
NOT have battery backup. If the DC power supply is removed (without 
external lithium battery backup), these GPS receivers will lose their 
settings after 15 minutes, which causes them to re-set to their default 
values.

• If the Trimble GPS has no battery backup connected, when the Trimble 
GPS receiver is turned on again, it will be set to the defaults. You will 
have to wait some time until the Trimble GPS receiver is locked and 
tracking the satellites before the correct coordinates are shown. 
Otherwise, the Trimble GPS receiver will see (by design) the Santa Clara, 
CA, coordinates. If this happens, allow some time (up to 30 minutes) 
before doing the actual network test, to ensure the correct coordinates are 
acquired.
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Trimble Placer GPS/DR

The setup for the Trimble Placer GPS/DR receiver is shown in Figure 2-4. 
When connecting your system with a Trimble Placer GPS/DR receiver, the 
86154A option 211 (adapter cable) is required.

Before you begin the hardware installation procedure, please review 
“Hardware Installation Tips” on page 2-3.

Figure 2-4 Trimble Placer GPS/DR 
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Configuring with a Trimble Placer GPS/DR

1. Connect the hardware security key to the parallel port of the PC.

2. Connect the serial port of the PC to the RS-232 port of the 
Agilent E645x receiver using an RS-232 straight-through cable. The 
default serial port used by the application is multiplexed serial, COM1. If 
your PC uses a different COM port, you can specify a different serial port 
number.

3. Connect the RF antenna to the RF input of the Agilent E645x receiver. 
Use the supplied Type-N to TNC adapter, if necessary.

4. Connect the end of Agilent cable 86154A option 211, labeled GPS RS-
232, to the GPS RS-232 port of the receiver.

5. Connect the 37-pin connector of the Agilent cable 86154A option 211 to 
the existing Trimble Placer GPS/DR connector. Connect the remaining 
end of the Agilent cable 86154A option 211 to the Trimble Placer GPS/
DR cable. 

6. Connect the GPS antenna to the GPS ANT port of the Trimble Placer 
GPS/DR antenna. Agilent Technologies recommends that a “bulkhea
mount” GPS antenna be used whenever possible for improved 
performance.

7. Connect power to the Trimble Placer GPS/DR and the PC.

8. Turn on the Trimble Placer GPS/DR and the Agilent E645x receiver.

9. Turn on the PC and run the application. 

10. Select or create the project you are going to use.

11. Configure the GPS unit for the Trimble Placer GPS/DR with TAIP 
(Trimble ASCII Interface Protocol) protocol: 

a. Select the Configuration mode.

b. Select the Hardware tab.

c. Double-click the GPS icon, or select GPS, then click the Modify button.

d. In the Hardware Type box, select the GPS (Placer DR, 400, SV6;
TAIP), and click OK.
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ts, 
Accept the default settings for baud rate, parity, and so forth. See “Selecting 
GPS Hardware” on page 3-4 for more information.

NOTE If you need to change the GPS coordinate datum, select the Advanced tab of 
GPS hardware configuration box. The default datum can be set using the
Tools > Options and selecting the Default Datum tab.

For additional information and vehicle connections for Trimble Placer uni
refer to Trimble Navigation Limited documentation.
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Trimble Placer GPS 400 or SVeeSix

The setup for the receiver with a Trimble Placer GPS 400 or SVeeSix receiver 
is shown in Figure 2-5. When using the Trimble Placer GPS 400 or SVeeSix 
receiver, a standard, straight-through, RS-232 9-pin cable is required.

Before you begin the hardware installation procedure, please review 
“Hardware Installation Tips” on page 2-3.

Figure 2-5 Trimble Placer GPS 400 or SVeeSix 

NOTE The Trimble Placer SVeeSix Plus operates from 9 to 32 VDC (NO interna
battery backup). The red wire must be tied to the positive side of the pow
supply. The black wire must be tied to the negative side of the power sup
Optionally, the yellow wire may be tied to a backup power source, such a
lithium battery (operates from 3.5 to 14 VDC).
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Configuring a Trimble Placer GPS 400 or SVeeSix

1. Connect the hardware security key to the parallel port of the PC.

2. Connect the serial port of the PC to the RS-232 port of the 
Agilent E645x receiver using an RS-232 cable. The default serial port 
used by the application is multiplexed serial, COM1. If your PC uses a 
different com port, you can specify a different serial port number.

3. Connect the RF antenna to the RF input of the Agilent E645x receiver. 
Use the supplied Type-N to TNC adapter, if necessary.

4. Connect one end of a standard, straight-through, RS-232 9-pin cable to 
the GPS RS-232 port of the Agilent E645x receiver. Connect the other 
end of the RS-232 cable to the Trimble Placer GPS 400 or SVeeSix 
connector.

5. Connect the GPS antenna to the GPS ANT port of the Trimble Placer 
GPS 400 or SVeeSix unit.

6. Connect power to the Trimble Placer GPS 400 or SVeeSix and the PC.

7. Turn on the Trimble Placer GPS 400 or SVeeSix, and the PC, and run the 
application.

8. Select or create the project you are going to use. 

9. Select Configuration mode.

a. Select the Hardware tab.

b. Double-click the GPS icon, or select GPS then click Modify.

c. In the Hardware Type box, select GPS (Placer DR, 400, SV6; TAIP) 
if the Trimble Placer SVeeSix has TAIP.
See part number XXXXX-63.

d. In the Hardware Type box, select GPS (SV6, SK8; TSIP) if the 
Trimble Placer SVeeSix has TSIP (Trimble Standard Interface 
Protocol). See part number XXXXX-61.

e. In the Hardware Type box, select GPS (NMEA) if the Trimble Placer 
SVeeSix has NMEA. See part number XXXXX-62.

f. Click OK.
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ts, 
Accept the default settings for baud rate, parity, and so forth. See “Selecting 
GPS Hardware” on page 3-4 for more information.

NOTE If you need to change the GPS coordinate datum, select the Advanced tab of 
GPS hardware configuration box. The default datum can be set using the
Tools > Options and selecting the Default Datum tab.

For additional information and vehicle connections for Trimble Placer uni
refer to Trimble Navigation Limited documentation.
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r is 
Trimble Placer GPS 455 

The setup for the receiver with a Trimble Placer GPS 455 receiver is shown in 
Figure 2-6.

Before you begin the hardware installation procedure, please review 
“Hardware Installation Tips” on page 2-3.

If the Trimble Placer GPS 455 receiver is supplied by Agilent as option 21
all necessary cables are included. If the Trimble Placer GPS 455 receive
customer supplied, 86154A option 212 is required.

Figure 2-6 Trimble Placer GPS 455 
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NOTE The Trimble Placer GPS 455 operates on 10 to 32 VDC (internal battery 
backup keeps the last GPS settings). The red and white wires must be tied to 
the positive side of the power supply. The black wire must be tied to the 
negative side of the power supply. To turn on the GPS receiver when starting 
the vehicle, the white wire must be tied to the ignition switch. 

Configuring a Trimble Placer GPS 455 

NOTE Never set your GPS receiver protocol as TAIP and TSIP together. The 
Agilent Wireless Solutions Software is designed to work with one protocol at 
a time. Having both protocols active may confuse the system.

1. Connect the hardware security key to the parallel port of the PC.

2. Connect the serial port of the PC to the RS-232 port of the Agilent E645x 
Receiver using the RS-232 cable included with the system. The default 
serial port used by the application is multiplexed serial, COM1. If your 
PC uses a different COM port, you can specify a different serial port 
number.

3. Connect the RF antenna to the RF input of the Agilent E645x receiver. 
Use the supplied Type-N to TNC adapter, if necessary.

4. Connect the GPS RS-232 port of the Agilent E645x receiver to the GPS 
RS-232 port of the adapter box, using the RS-232 straight-through cable.

5. Connect the MDT port of the adapter box to the MDT/RTCM port of the 
Trimble Placer GPS 455 unit, using the RS-232 straight through cable.

6. Connect the digital port of the adapter box to the Digital IO port of the 
Trimble Placer GPS 455 unit, using the RS-232 straight-through cable.

7. Connect the GPS antenna to the GPS ANT port of the Trimble Placer 
GPS 455 unit. Agilent Technologies recommends that a “bulkhead 
mount” GPS antenna be used whenever possible for improved 
performance.
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8. Turn on the Trimble Placer GPS 455 unit and the PC.

9. Configure the Trimble Placer GPS 455 unit for the correct settings. See 
“Selecting GPS Hardware” on page 3-4 for more information. 
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Trimble Placer GPS 455 & Differential 

The setup for the receiver with a Trimble Placer GPS 455 and Differential 
receiver is shown in Figure 2-7. 

Before you begin the hardware installation procedure, please review 
“Hardware Installation Tips” on page 2-3.

86154A option 230 provides a differential GPS, with all necessary cables
included. A differential GPS may also be customer supplied. 

If the Trimble Placer GPS 455 receiver is supplied by Agilent as option 21
all necessary cables are included. If the Trimble Placer GPS 455 receive
customer supplied, 86154A option 212 is required.

Figure 2-7 Trimble Placer GPS 455 and Differential GPS
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Configuring a Trimble Placer GPS 455 and Differential 

1. Connect the hardware security key to the parallel port of the PC.

2. Connect the serial port of the PC to the RS-232 port of the Agilent E645x 
receiver using the RS-232 cable included with the system. The default 
serial port used by application is multiplexed serial, COM1. If your PC 
uses a different COM port, you can specify a different serial port number.

3. Connect the RF antenna to the RF input of the Agilent E645x receiver. 
Use the supplied Type-N to TNC adapter, if necessary.

4. Connect the GPS RS-232 port of the Agilent E645x receiver to the GPS 
RS-232 port of the adapter box, using the RS-232 cable.

5. Connect the RTCM port of the Trimble-supplied communications cable to 
the differential GPS receiver, using the RS-232 cable included with the 
system. Connect the remaining port of the Trimble-supplied 
communications cable to the MDT/RTCM port of the Trimble Placer GPS 
455 unit.

6. Connect the digital port of the adapter box to the Digital IO port of the 
Trimble Placer GPS 455 unit, using the RS-232 cable.

7. Connect the MDT/RTCM port of the adapter box to the MDT port of the 
Trimble-supplied communications “T” cable, connected to the 
Differential, using the RS-232 cable.

8. Connect the GPS antenna to the GPS ANT port of the Trimble Place
GPS 455 unit. Agilent Technologies recommends that a “bulkhead 
mount” GPS antenna be used whenever possible for improved 
performance.

9. Connect the VHF Differential GPS antenna to the Differential GPS un

10. Connect power to the differential GPS unit, the Trimble Placer GPS 4
unit, and the PC.

11. Turn the differential GPS unit, the Trimble Placer GPS 455 unit, and 
PC on. Refer to “Selecting GPS Hardware” on page 3-4 to configure the 
Agilent Wireless Solutions Software.
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NOTE Never set your GPS receiver protocol as TAIP and TSIP together. The 
Agilent Wireless Solutions Software is designed to work with one protocol at 
a time. Having both protocols active may confuse the system.

Configuring the Differential GPS Communications Port When 
Using a Differential GPS

1. If your system includes an Agilent E645x receiver 86154A option 230 
differential GPS receiver, the baud rate of the Differential Corrections 
Inc., (DCI) Differential GPS model RDS 3000, and the baud rate of the 
Trimble GPS receiver unit must be the same. 

Please refer to the manuals supplied by Differential Corrections, Inc. and 
Trimble Navigation, Limited.

2. Connect the differential GPS to the serial port of the PC. 

3. Run the software supplied by DCI with the differential GPS (rtcmon.exe). 
(The file is contained on the disk that comes with 86154A option 230.)

4. Press F1 to set the correct baud rate for the differential GPS. Use the 
following table to set the baud rate for the Trimble model you are using.

When the differential GPS is correctly configured, it will start to send legible 
information to the PC. If the subscription is active, this information will be 
correction data, otherwise it will be scanned frequencies.

Table 2-2 Trimble Baud Rate Settings

Differential GPS Use F1 to set the baud rate of 
the DCI model RDS 3000 
differential GPS

Then use F2 to set the baud 
rate of the PC serial port

Placer GPS/DR 9600 9600

Trimble Placer GPS 455 9600 9600

Agilent E645x with internal 
GPS (Trimble model SK-8)

4800 4800
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NOTE If you need to change the GPS coordinate datum, select the Advanced tab of 
GPS hardware configuration box. The default datum can be set using the 
Tools > Options and selecting the Default Datum tab.

Please contact DCI for information about getting a subscription to activate 
your differential GPS. When it is activated, it will be ready to work with the 
Agilent Technologies system.
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S 
Internal GPS & Internal GPS with Differential Setup

The setup for the internal GPS, including 86154A option 230, Differential 
GPS, is shown in Figure 2-8. Before you begin the hardware installation 
procedure, please review “Hardware Installation Tips” on page 2-3.

The internal GPS can not be used with Dead Reckoning. The internal GP
can, and most often will, be used without the differential GPS.

Figure 2-8 Internal GPS and Internal GPS with Differential
2-26 Wireless Solutions Getting Started Guide



Chapter 2: Setting Up Your System
Receiver-Based System Setup

ved 

er, 

it.

tial 

 

that 
Configuring an Internal GPS

1. Connect the hardware security key to the parallel port of the PC.

2. Connect the serial port of the PC to the RS-232 port of the Agilent E645x 
receiver using the RS-232 cable included with the system. The default 
serial port used by the application is multiplexed serial COM1. If your PC 
uses a different COM port, you can specify a different serial port number.

3. Connect the RF antenna to the RF input of the Agilent E645x receiver. 
Use the supplied Type-N to TNC adapter, if necessary.

4. Connect the GPS antenna to the GPS ANT port of the 
Agilent E645x receiver. Agilent Technologies recommends that a 
“bulkhead mount” GPS antenna be used whenever possible for impro
performance.

If the system includes a differential GPS receiver, continue. If it does not, 
skip to step 7.

5. Connect the GPS RS-232 port of the Agilent E645x receiver to the 
differential GPS. The cable is included with the differential GPS receiv
86154A option 230.

6. Connect the differential GPS VHF antenna to the differential GPS un

7. Connect power to the Agilent E645x receiver, the PC, and the differen
GPS unit, if used.

8. Turn the differential GPS unit, and the PC, on.

9. Refer to “Selecting GPS Hardware” on page 3-4 to configure the 
Agilent Wireless Solutions Software.

10. Refer to “Configuring the Differential GPS Communications Port When
Using a Differential GPS” on page 2-24 for instructions on setting the 
COM ports.

NOTE If you have a Differential GPS other than the 86154A option 230, refer to 
suppliers manual for configuration instructions.
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Trimble Placer GPS 455 with Dead Reckoning 

The setup for the Trimble Placer GPS 455 receiver and GPS antenna is shown 
in Figure 2-9. 

Before you begin the hardware installation procedure, please review 
“Hardware Installation Tips” on page 2-3.

86154A option 210 provides a Trimble Placer GPS 455 receiver and two G
antennas. All necessary cables and adapters are included. The speedom
interface is not included. If the Trimble Placer GPS 455 receiver and GPS 
antennas are customer supplied, 86154A option 212 (adapter and cables
required.

Figure 2-9 Trimble Placer GPS 455 with Dead Reckoning
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Configuring a Trimble Placer GPS 455 with Dead Reckoning

NOTE When the heading sensor is connected to the GPS 455 receiver, Dead 
Reckoning must be calibrated before the software will provide correct GPS 
information.

1. Connect the hardware security key to the parallel port of the PC.

2. Connect the serial port of the PC to the RS-232 port of the Agilent E645x 
receiver using the RS-232 cable included with the system. The default 
serial port used by the application is multiplexed serial COM1. If your PC 
uses a different COM port, you can specify a different serial port number.

3. Connect the RF antenna to the RF input of the Agilent E645x receiver. 
Use the supplied Type-N to TNC adapter, if necessary.

4. Connect the GPS RS-232 port of the Agilent E645x receiver to the GPS 
RS-232 port of the adapter box, using the RS-232 cable.

5. Connect the MDT port of the adapter box to the MDT/RTCM port of the 
Trimble Placer GPS 455 unit, using the RS-232 straight-through cable.

6. Connect the digital port of the adapter box to the Digital IO port of the 
Trimble Placer GPS 455 unit, using the RS-232 cable.

7. Connect the Heading Sensor to the Heading Sensor port of the Trimble 
Placer GPS 455 through the female 9-pin connector on the DR sensor 
cable supplied by Trimble. See Figure 2-9. The connector labeled 
Heading Sensor connects to the heading sensor; the connector labeled 
Sensors connects to the Placer GPS 455. See Figure 2-10.

8. Connect the GPS antenna to the GPS ANT port of the Trimble Placer 
GPS 455 unit. Agilent Technologies recommends that a “bulkhead 
mount” GPS antenna be used whenever possible for improved 
performance.

9. Connect power to the Trimble Placer GPS 455, the 
Agilent E645x receiver, and the PC and turn them on.
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10. Calibrate the DR unit using Trimble supplied software Plcrinit.exe or 
GPSSK. If you do not have this software, it is available on the Trimble 
web page. For more details and the URL, refer to page 2-2.

11. Start the Agilent Technologies application software. Verify that both the 
software and the Trimble Placer GPS 455 are configured for the same 
communication protocol. Refer to “Selecting GPS Hardware” on page 3-4 
to configure the Agilent Wireless Solutions Software.

NOTE Never set your GPS receiver protocol as TAIP and TSIP together. The 
Agilent Wireless Solutions Software is designed to work with one protoco
a time. Having both protocols active may confuse the system.

NOTE If you need to change the GPS coordinate datum, select the Advanced tab of 
GPS hardware configuration box. The default datum can be set using the
Tools > Options and selecting the Default Datum tab.

For additional information and vehicle connections for Trimble Placer uni
refer to Trimble Navigation Limited documentation.
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Figure 2-10 Heading Sensor Cable
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Receiver and Phone-Based System Setup

Trimble Placer GPS/DR

The setup for the Trimble Placer GPS/DR receiver and GPS antenna is shown 
in Figure 2-11. 

Before you begin the hardware installation procedure, please review 
“Hardware Installation Tips” on page 2-3.

Figure 2-11 Trimble Placer GPS/DR Receiver and Phone
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Configuring a Trimble Placer GPS/DR

1. Connect the hardware security key to the parallel port of the PC.

2. Connect the serial port of the PC to the RS-232 port of the 
Agilent E645x receiver using an RS-232 straight-through cable. The 
default serial port used by the application is multiplexed serial, COM1. If 
your PC uses a different COM port, you can specify a different serial port 
number.

3. Connect the RF antenna to the RF input of the Agilent E645x receiver. 
Use the supplied Type-N to TNC adapter, if necessary.

4. Connect the end of Agilent cable 86154A option 211, labeled GPS RS-
232, to the GPS RS-232 port of the receiver.

5. Connect the 37-pin connector of the Agilent cable 86154A option 211 to 
the existing Trimble Placer GPS/DR connector. Connect the remaining 
end of the Agilent cable 86154A option 211 to the Trimble Placer GPS/
DR cable. 

6. Connect the GPS antenna to the GPS ANT port of the Trimble Placer 
GPS/DR antenna. Agilent Technologies recommends that a “bulkhea
mount” GPS antenna be used whenever possible for improved 
performance.

7. Connect the phone cable to a second COM port (different than used 
step 1). On most laptop PCs this will require the use of a Socket Seria
RS-232 card that is installed into the PCMCIA slot on your PC. 

8. Connect power to the Trimble Placer GPS/DR and the PC.

9. Turn on the Trimble Placer GPS/DR, the Agilent E645x receiver and 
phone.

10. Turn on the PC and run the application. 

11. Select or create the project you are going to use.

12. Configure the GPS unit for the TAIP protocol: 

a. Select Configuration mode.

b. Select the Hardware tab.
Wireless Solutions Getting Started Guide 2-33



Chapter 2: Setting Up Your System
Receiver and Phone-Based System Setup
c. Double-click the GPS icon, or select GPS, then click Modify.

d. In the Hardware Type box, select the GPS (Placer DR, 400, SV6; 
TAIP)

e. Click OK when you are satisfied with the settings.

NOTE If you need to change the GPS coordinate datum, select the Advanced tab of 
GPS hardware configuration box. The default datum can be set using the 
Tools > Options and selecting the Default Datum tab.

13. Configure the phone:

a. Select Configuration mode.

b. Select the Hardware tab.

c. Double-click the phone icon or select the phone icon and click Modify.

d. In the Hardware Type box, select the phone used.

e. Click the Port Selections and Port Settings tabs to modify and confirm 
the correct COM port setting for the phone. The port selection should 
be serial. Select the Com port you are using.

f. Use the default port settings or use the values according to the 
PCMCIA Socket I/O card you are using. 

g. Click OK when you are satisfied with the settings.

h. Select Collection mode to start the measurements.

Accept the default settings for baud rate, parity, and others. 

For additional information and vehicle connections for Trimble Placer units, 
refer to Trimble Navigation Limited documentation.
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Trimble Placer GPS 400 or SVeeSix

The setup for the Trimble Placer SVeeSix/Placer GPS 400 is shown in Figure 
2-12. 

Before you begin the hardware installation procedure, please review 
“Hardware Installation Tips” on page 2-3.

Figure 2-12 Trimble Placer GPS 400 or SVeeSix Receiver and Phone

NOTE The Trimble Placer SVeeSix Plus operates from 9 to 32 VDC (NO interna
battery backup). The red wire must be tied to the positive side of the pow
supply. The black wire must be tied to the negative side of the power sup
Optionally, the yellow wire may be tied to a backup power source, such a
lithium battery (operates from 3.5 to 14 VDC).
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Configuring a Trimble Placer GPS 400 or SVeeSix

1. Connect the hardware security key to the parallel port of the PC.

2. Connect the serial port of the PC to the RS-232 port of the 
Agilent E645x receiver using the RS-232 cable included with the system. 
The default serial port used by the application is multiplexed serial, 
COM1. If your PC uses a different COM port, you can specify a different 
serial port number.

3. Connect the RF antenna to the RF input of the Agilent E645x receiver. 
Use the supplied Type-N to TNC adapter, if necessary.

4. Connect one end of a standard, straight-through, RS-232 9-pin cable to 
the GPS RS-232 port of the Agilent E645x receiver. Connect the other 
end of the RS-232 cable to the Trimble Placer GPS 400 or SVeeSix 
connector.

5. Connect the GPS antenna to the GPS ANT port of the Trimble Placer 
SVeeSix/Placer GPS 400 unit.

6. Connect the phone cable to a second COM port (different than used in 
step 1). On most laptop PCs this will require the use of a Socket Serial I/O 
RS-232 card that is installed into the PCMCIA slot on your PC.

7. Connect power to the Trimble Placer GPS 400 or SVeeSix and the PC.

8. Turn on the Trimble Placer GPS 400 or SVeeSix, the PC, and the phone 
and run the application.

9. Select or create the project you are going to use. 

10. Select Configuration mode.

a. Select the Hardware tab.

b. Double-click the GPS icon, or select GPS and click Modify.

c. In the Hardware Type box, select GPS (Placer DR, 400, SV6; TAIP) 
if the Trimble Placer GPS 400 or SVeeSix has TAIP. See part number 
XXXXX-63.

d. In the Hardware Type box, select GPS (SV6, SK8; TSIP) if the 
Trimble Placer SVeeSix has TSIP. See part number XXXXX-61.
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e. In the Hardware Type box, select GPS (NMEA) if the Trimble Placer 
SVeeSix has NMEA (National Marine Electronics Association: a 
GPS protocol). See part number XXXXX-62.

f. Click the Port Selections and Port Settings tabs to modify and confirm 
the correct COM port setting for the GPS.

g. Click OK when you are satisfied with the settings.

NOTE If you need to change the GPS coordinate datum, select the Advanced tab of 
GPS hardware configuration box. The default datum can be set using the 
Tools > Options and selecting the Default Datum tab.

11. Configure the phone:

a. Select Configuration mode.

b. Select the Hardware tab.

c. Double-click the phone icon or select the phone icon and click the 
Modify button.

d. In the Hardware Type box, select the phone used.

e. Click the Port Selections and Port Settings tabs to modify and confirm 
the correct COM port setting for the phone. The port selection should 
be serial and select the Com port you are using.

f. Use the default port settings or use the values according to the 
PCMCIA Socket I/O card you are using. 

g. Click OK when you are satisfied with the settings.

h. Select Collection mode to start the measurements.

Accept the default settings for baud rate, parity, and others. 

For additional information and vehicle connections for Trimble Placer units, 
refer to Trimble Navigation Limited documentation.
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Trimble Placer GPS 455

The setup for the Trimble Placer GPS 455 is shown in Figure 2-13. 

Before you begin the hardware installation procedure, please review 
“Hardware Installation Tips” on page 2-3.

If the Trimble Placer GPS 455 receiver is supplied by Agilent as option 21
all necessary cables are included. If the Trimble Placer GPS 455 receive
customer supplied, 86154A option 212 is required.

Figure 2-13 Trimble Placer GPS 455 Receiver and Phone
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NOTE The Trimble Placer GPS 455 operates on 10 to 32 VDC (internal battery 
backup keeps the last GPS settings). The red and white wires must be tied to 
the positive side of the power supply. The black wire must be tied to the 
negative side of the power supply. To turn on the GPS receiver when starting 
the vehicle, the white wire must be tied to the ignition switch. 

Configuring a Trimble Placer GPS 455 

1. Connect the hardware security key to the parallel port of the PC.

2. Connect the serial port of the PC to the RS-232 port of the Agilent E645x 
receiver using the RS-232 cable included with the system. The default 
serial port used by the application is multiplexed serial, COM1. If your 
PC uses a different COM port, you can specify a different serial port 
number.

3. Connect the RF antenna to the RF input of the Agilent E645x Receiver. 
Use the supplied Type-N to TNC adapter, if necessary.

4. Connect the GPS RS-232 port of the Agilent E645x receiver to the GPS 
RS-232 port of the adapter box, using the RS-232 straight-through cable.

5. Connect the MDT port of the adapter box to the MDT/RTCM port of the 
Trimble Placer GPS 455 unit, using the RS-232 straight-through cable.

6. Connect the digital port of the adapter box to the Digital IO port of the 
Trimble Placer GPS 455 unit, using the RS-232 straight-through cable.

7. Connect the GPS antenna to the GPS ANT port of the Trimble Placer 
GPS 455 unit. Agilent Technologies recommends that a “bulkhead 
mount” GPS antenna be used whenever possible for improved 
performance.

8. Connect the phone cable to a second COM port (different than used 
step 1). On most laptop PCs this will require the use of a Socket Seria
RS-232 card that is installed into the PCMCIA slot on your PC.

9. Turn on the Trimble Placer GPS 455 unit, the PC, and the phone.
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10. Configure the Trimble Placer GPS 455 unit for the correct settings. See 
“Selecting GPS Hardware” on page 3-4 for more information. 

11. Configure the phone:

a. Select Configuration mode.

b. Select the Hardware tab.

c. Double-click the phone icon or select the phone icon and click Modify.

d. In the Hardware Type box, select the phone used.

e. Click the Port Selections and Port Settings tabs to modify and con
the correct COM port setting for the phone. The port selection sho
be serial and select the COM port you are using.

f. Use the default port settings or use the values according to the 
PCMCIA Socket I/O card you are using. 

g. Click OK when you are satisfied with the settings.

h. Select Collection mode to start the measurements.

NOTE Never set your GPS receiver protocol as TAIP and TSIP together. The 
Agilent Wireless Solutions Software is designed to work with one protoco
a time. Having both protocols active may confuse the system.

NOTE If you need to change the GPS coordinate datum, select the Advanced tab of 
GPS hardware configuration box. The default datum can be set using the
Tools > Options and selecting the Default Datum tab.
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Trimble Placer GPS 455 & Differential

The setup for the Trimble Placer GPS 455 and Differential is shown in Figure 
2-14.

Before you begin the hardware installation procedure, please review 
“Hardware Installation Tips” on page 2-3.

86154A option 230 provides a differential GPS, with all necessary cables
included. A differential GPS may also be customer supplied. 

If the Trimble Placer GPS 455 receiver is supplied by Agilent as option 21
all necessary cables are included. If the Trimble Placer GPS 455 receive
customer supplied, 86154A option 212 is required.

Figure 2-14 Trimble Placer GPS 455 and Differential Receiver and Phone 
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Configuring a Trimble Placer GPS 455 and Differential 

1. Connect the hardware security key to the parallel port of the PC.

2. Connect the serial port of the PC to the RS-232 port of the Agilent E645x 
receiver using the RS-232 cable included with the system. The default 
serial port used by the application is multiplexed serial, COM1. If your 
PC uses a different COM port, you can specify a different serial port 
number.

3. Connect the RF antenna to the RF input of the Agilent E645x receiver. 
Use the supplied Type-N to TNC adapter, if necessary.

4. Connect the GPS RS-232 port of the Agilent E645x receiver to the GPS 
RS-232 port of the adapter box, using the RS-232 cable.

5. Connect the RTCM port of the Trimble-supplied communications cable to 
the differential GPS receiver, using the RS-232 cable included with the 
system. Connect the remaining port of the Trimble-supplied 
communications cable to the MDT/RTCM port of the Trimble Placer GPS 
455 unit.

6. Connect the digital port of the adapter box to the Digital IO port of the 
Trimble Placer GPS 455 unit, using the RS-232 cable.

7. Connect the MDT/RTCM port of the adapter box to the MDT port of the 
Trimble-supplied communications “T” cable, connected to the 
Differential, using the RS-232 cable.

8. Connect the GPS antenna to the GPS ANT port of the Trimble Place
GPS 455 unit. Agilent Technologies recommends that a “bulkhead 
mount” GPS antenna be used whenever possible for improved 
performance.

9. Connect the VHF Differential GPS antenna to the Differential GPS un

10. Connect the phone cable to a second COM port (different than used 
step 1). On most laptop PCs this will require the use of a Socket Seria
RS-232 card that is installed into the PCMCIA slot on your PC.

11. Connect power to the differential GPS unit, the Trimble Placer GPS 4
unit, and the PC.
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12. Turn on the differential GPS unit, the Trimble Placer GPS 455 unit, the 
PC, and the phone. Refer to “Selecting GPS Hardware” on page 3-4 to 
configure the Agilent Wireless Solutions Software.

13. Configure the Trimble Placer GPS 455 unit for the correct settings. S
“Selecting GPS Hardware” on page 3-4 for more information.

14. Configure the phone:

a. Select Configuration mode.

b. Select the Hardware tab.

c. Double-click the phone icon or select the phone icon and click Modify.

d. In the Hardware Type box, select the phone used.

e. Click the Port Selections and Port Settings tabs to modify and con
the correct COM port setting for the phone. The port selection sho
be serial and select the Com port you are using.

f. Use the default port settings or use the values according to the 
PCMCIA Socket I/O card you are using. 

g. Click OK when you are satisfied with the settings.

h. Select Collection mode to start the measurements.

NOTE Never set your GPS receiver protocol as TAIP and TSIP together. The 
Agilent Wireless Solutions Software is designed to work with one protoco
a time. Having both protocols active may confuse the system.

Configuring the Differential GPS Communications Port When 
Using a Differential GPS

1. If your system includes an Agilent E645x receiver 86154A option 230
differential GPS receiver, the baud rate of the DCI (Differential 
Corrections Inc.) Differential GPS model RDS 3000, and the baud rat
the Trimble GPS receiver unit must be the same. 

Please refer to the manuals supplied by Differential Corrections, Inc. 
Trimble Navigation, Limited.
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2. Connect the differential GPS to the serial port of the PC. 

3. Run the software supplied by DCI with the differential GPS (rtcmon.exe). 
(The file is contained on the disk that comes with 86154A option 230.)

4. Press F1 to set the correct baud rate for the differential GPS. Use the 
following table to set the baud rate for the Trimble model you are using.

When the differential GPS is correctly configured, it will start to send legible 
information to the PC. If the subscription is active, this information will be 
correction data, otherwise it will be scanned frequencies.

NOTE If you need to change the GPS coordinate datum, select the Advanced tab of 
GPS hardware configuration box. The default datum can be set using the 
Tools > Options and selecting the Default Datum tab.

Please contact DCI for information about getting a subscription to activate 
your differential GPS. Once activated, it is ready to work with the 
Agilent Technologies system.

Table 2-3 Trimble Baud Rate Settings

Differential GPS Use F1 to set the baud rate of 
the DCI model RDS 3000 
differential GPS

Then use F2 to set the baud 
rate of the PC serial port

Placer GPS/DR 9600 9600

Trimble Placer GPS 455 9600 9600

Agilent E645x with internal 
GPS (Trimble model SK-8)

4800 4800
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Internal GPS & Internal GPS with Differential 

The setup for the internal GPS, including 86154A option 230, Differential 
GPS, is shown in Figure 2-15. Before you begin the hardware installation 
procedure, please review “Hardware Installation Tips” on page 2-3.

The internal GPS can not be used with Dead Reckoning. The internal GP
can, and most often will, be used without the differential GPS.

Figure 2-15 Internal GPS and Internal GPS with Differential Receiver and Phone
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Configuring an Internal GPS and Differential

1. Connect the hardware security key to the parallel port of the PC.

2. Connect the serial port of the PC to the RS-232 port of the Agilent E645x 
receiver using the RS-232 cable included with the system. The default 
serial port used by the application is multiplexed serial, COM1. If your 
PC uses a different COM port, you can specify a different serial port 
number.

3. Connect the RF antenna to the RF input of the Agilent E645x receiver. 
Use the supplied Type-N to TNC adapter, if necessary.

4. Connect the GPS antenna to the GPS ANT port of the 
Agilent E645x receiver. Agilent Technologies recommends that a 
“bulkhead mount” GPS antenna be used whenever possible for impro
performance.

If the system includes a differential GPS receiver, continue. If it does not, 
skip to step 7.

5. Connect the GPS RS-232 port of the Agilent E645x receiver to the 
differential GPS. The cable is included with the differential GPS receiv
86154A option 230.

6. Connect the differential GPS VHF antenna to the differential GPS un

7. Connect the phone cable to a second COM port (different than used 
step 1). On most laptop PCs this will require the use of a Socket Seria
RS-232 card that is installed into the PCMCIA slot on your PC.

8. Connect power to the Agilent E645x receiver, the PC, and the differen
GPS unit, if used.

9. Turn on the differential GPS unit, the PC, and the phone.

10. Refer to “Selecting GPS Hardware” on page 3-4 to configure the 
Agilent Wireless Solutions Software.

11. Refer to “Configuring the Differential GPS Communications Port When
Using a Differential GPS” on page 2-46 for instructions on setting the 
COM ports.
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Trimble Placer GPS 455 with Dead Reckoning

The setup for the Trimble Placer GPS 455 with Dead Reckoning is shown in 
Figure 2-16. 

Before you begin the hardware installation procedure, please review 
“Hardware Installation Tips” on page 2-3.

If the Trimble Placer GPS 455 receiver is supplied by Agilent as option 21
all necessary cables are included. If the Trimble Placer GPS 455 receive
customer supplied, 86154A option 212 is required.

Figure 2-16 Trimble Placer GPS 455 with Dead Reckoning Receiver and Phone
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Configuring a Trimble Placer GPS 455 with Dead Reckoning

NOTE When the heading sensor is connected to the GPS 455 receiver, Dead 
Reckoning must be calibrated before the software will provide correct GPS 
information.

1. Connect the hardware security key to the parallel port of the PC.

2. Connect the serial port of the PC to the RS-232 port of the Agilent E645x 
receiver using the RS-232 cable included with the system. The default 
serial port used by the application is multiplexed serial, COM1. If your 
PC uses a different COM port, you can specify a different serial port 
number.

3. Connect the RF antenna to the RF input of the Agilent E645x receiver. 
Use the supplied Type-N to TNC adapter, if necessary.

4. Connect the GPS RS-232 port of the Agilent E645x receiver to the GPS 
RS-232 port of the adapter box, using the RS-232 cable.

5. Connect the MDT port of the adapter box to the MDT/RTCM port of the 
Trimble Placer GPS 455 unit, using the RS-232 straight through cable.

6. Connect the digital port of the adapter box to the Digital IO port of the 
Trimble Placer GPS 455 unit, using the RS-232 cable.

7. Connect the Heading Sensor to the HS port of the Trimble Placer GPS 
455 through the female 9-pin connector on the DR sensor cable supplied 
by Trimble. See Figure 2-16. The connector labeled Heading Sensor 
connects to the heading sensor; the connector labeled Sensors connects to 
the Placer GPS 455. See Figure 2-17.

8. Connect the GPS antenna to the GPS ANT port of the Trimble Placer 
GPS 455 unit. Agilent Technologies recommends that a “bulkhead 
mount” GPS antenna be used whenever possible for improved 
performance.
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9. Connect the phone cable to a second COM port (different than used in 
step 1). On most laptop PCs this will require the use of a Socket Serial I/O 
RS-232 card that is installed into the PCMCIA slot on your PC.

10. Turn on the Trimble Placer GPS 455, the Agilent E645x receiver, the PC, 
and phone.

11. Calibrate the DR unit using Trimble supplied software Plcrinit.exe or 
GPSSK. If you do not have this software, it is available on the Trimble 
web page. For more details and the URL, refer to page 2-2.

12. Start the Agilent Technologies application software. Verify that both the 
software and the Trimble Placer GPS 455 are configured for the same 
communication protocol.

13. Configure the Trimble Placer GPS 455 unit for the correct settings. See 
“Selecting GPS Hardware” on page 3-4 for more information.

14. Configure the phone:

a. Select Configuration mode.

b. Select the Hardware tab.

c. Double-click the phone icon or select the phone icon and click Modify.

d. In the Hardware Type box, select the phone used.

e. Click the Port Selections and Port Settings tabs to modify and con
the correct COM port setting for the phone. The port selection sho
be serial and select the Com port you are using.

f. Use the default port settings or use the values according to the 
PCMCIA Socket I/O card you are using. 

g. Click OK when you are satisfied with the settings.

h. Select Collection mode to start the measurements.

NOTE Never set your GPS receiver protocol as TAIP and TSIP together. The 
Agilent Wireless Solutions Software is designed to work with one protoco
a time. Having both protocols active may confuse the system.
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NOTE If you need to change the GPS coordinate datum, select the Advanced tab of 
GPS hardware configuration box. The default datum can be set using the 
Tools > Options and selecting the Default Datum tab.

For additional information and vehicle connections for Trimble Placer units, 
refer to Trimble Navigation Limited documentation.

Figure 2-17 Heading Sensor Cable
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Phone-Based System Setup

Trimble Placer GPS/DR

The setup for the Trimble Placer GPS/DR is shown in Figure 2-18. 

Before you begin the hardware installation procedure, please review 
“Hardware Installation Tips” on page 2-3.

Figure 2-18 Trimble Placer GPS/DR with Phone
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Configuring with a Trimble Placer GPS/DR

1. Connect the hardware security key to the parallel port of the PC.

2. Connect the serial port of the PC to the RS-232 port of the 
Placer GPS/DR  using an RS-232 cable from the Trimble connector. The 
default serial port used by the application is serial, COM1. If your PC 
uses a different com port, you can specify a different serial port number.

3. Connect the GPS antenna to the GPS ANT port of the Trimble Placer 
GPS/DR. Agilent Technologies recommends that a “bulkhead mount”
GPS antenna be used whenever possible for improved performance.

4. Connect the phone cable to a second COM port (different than used 
step 1). On most laptop PCs this will require the use of a Socket Seria
RS-232 card that is installed into the PCMCIA slot on your PC.

5. Connect power to the Trimble Placer GPS/DR and the PC.

6. Turn on the Trimble Placer GPS/DR, the phone, and the PC. Run the
application.

7. Select or create the project you are going to use.

8. Configure the GPS unit for the TAIP protocol: 

a. Select Configuration mode.

b. Select the Hardware tab.

c. Double-click the GPS icon, or select GPS, then click Modify.

d. In the Hardware Type box, select the GPS (Placer DR, 400, SV6;
TAIP)

e. Click OK.

NOTE If you need to change the GPS coordinate datum, select the Advanced tab of 
GPS hardware configuration box. The default datum can be set using the
Tools > Options and selecting the Default Datum tab.
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9. Configure the phone:

a. Select Configuration mode.

b. Select the Hardware tab.

c. Double-click the phone icon or select the phone icon and click Modify.

d. In the Hardware Type box, select the phone used.

e. Click the Port Selections and Port Settings tabs to modify and confirm 
the correct COM port setting for the phone. The port selection should 
be serial. Select the Com port you are using.

f. Use the default port settings or use the values according to the 
PCMCIA Socket I/O card you are using. 

g. Click OK when you are satisfied with the settings.

h. Select Collection mode to start the measurements.

Accept the default settings for baud rate, parity, and others. Verify that the 
software is also configured for the TAIP protocol. Refer to the GPS selection 
procedure.

For additional information and vehicle connections for Trimble Placer units, 
refer to Trimble Navigation Limited documentation.
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Trimble Placer GPS 400 or SVeeSix

The setup for the Trimble Placer GPS 400/Placer SVeeSix is shown in Figure 
2-19. 

Before you begin the hardware installation procedure, please review 
“Hardware Installation Tips” on page 2-3.

Figure 2-19 Trimble Placer GPS 400 or SVeeSix with Phone

NOTE The Trimble Placer SVeeSix Plus operates from 9 to 32 VDC (NO interna
battery backup). The red wire must be tied to the positive side of the pow
supply. The black wire must be tied to the negative side of the power sup
Optionally, the yellow wire may be tied to a backup power source, such a
lithium battery (operates from 3.5 to 14 VDC).
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Configuring a Trimble Placer GPS 400 or SVeeSix

1. Connect the hardware security key to the parallel port of the PC.

2. Connect the serial port of the PC to the RS-232 port of the 
Placer GPS 400 or SVeeSix receiver using an RS-232 straight-through 
cable. The default serial port used by the application is multiplexed serial, 
COM1. If your PC uses a different com port, you can specify a different 
serial port number.

3. Connect the GPS antenna to the GPS ANT port of the Trimble Placer 
GPS 400 or SVeeSix unit.

4. Connect the phone cable to a second COM port (different than used in 
step 1). On most laptop PCs this will require the use of a Socket Serial I/O 
RS-232 card that is installed into the PCMCIA slot on your PC.

5. Connect power to the Trimble Placer GPS 400 or SVeeSix and the PC.

6. Turn on the Trimble Placer GPS 400 or SVeeSix, the PC, and the phone. 
Run the application.

7. Select or create the project you are going to use. 

8. Select Configuration mode.

a. Select the Hardware tab.

b. Double-click the GPS icon, or select GPS then click Modify.

c. In the Hardware Type box, select GPS (Placer DR, 400, SV6; TAIP) 
if the Trimble Placer SVeeSix has TAIP. See part number XXXXX-
63.

d. In the Hardware Type box, select GPS (SV6, SK8; TSIP) if the 
Trimble Placer SVeeSix has TSIP. See part number XXXXX-61.

e. In the Hardware Type box, select GPS (NMEA) if the Trimble Placer 
SVeeSix uses NMEA. See part number XXXXX-62.

f. Click OK.
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NOTE If you need to change the GPS coordinate datum, select the Advanced tab of 
GPS hardware configuration box. The default datum can be set using the 
Tools > Options and selecting the Default Datum tab.

9. Configure the phone:

a. Select Configuration mode.

b. Select the Hardware tab.

c. Double-click the phone icon or select the phone icon and click Modify.

d. In the Hardware Type box, select the phone used.

e. Click the Port Selections and Port Settings tabs to modify and confirm 
the correct COM port setting for the phone. The port selection should 
be serial. Select the Com port you are using.

f. Use the default port settings or use the values according to the 
PCMCIA Socket I/O card you are using. 

g. Click OK when you are satisfied with the settings.

h. Select Collection mode to start the measurements.

Accept the default settings for baud rate, parity, and others. Verify that the 
system software is also configured for the correct GPS protocol.

For additional information and vehicle connections for Trimble Placer units, 
refer to Trimble Navigation Limited documentation.
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Trimble Placer GPS 455 

The setup for the Trimble Placer GPS 455 is shown in Figure 2-20. 

Before you begin the hardware installation procedure, please review 
“Hardware Installation Tips” on page 2-3.

If the Trimble Placer GPS 455 receiver is supplied by Agilent as option 21
all necessary cables are included. If the Trimble Placer GPS 455 receive
customer supplied, 86154A option 212 is required.

Figure 2-20 Trimble Placer GPS 455 with Phone
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NOTE The Trimble Placer 455 operates on 10 to 32 VDC (internal battery backup 
keeps the last GPS settings). The red and white wires must be tied to the 
positive side of the power supply. The black wire must be tied to the negative 
side of the power supply. To turn on the GPS receiver when starting the 
vehicle, the white wire must be tied to the ignition switch. 

Configuring a Trimble Placer GPS 455 

1. Connect the hardware security key to the parallel port of the PC.

2. Connect the serial port of the PC to the MDT port of the Placer GPS 455 
Receiver using an RS-232 straight-through cable. The default serial port 
used by the application is serial, COM1. If your PC uses a different COM 
port, you can specify a different serial port number.

3. Connect the GPS antenna to the GPS ANT port of the Trimble Placer 
GPS 455 unit. Agilent Technologies recommends that a “bulkhead 
mount” GPS antenna be used whenever possible for improved 
performance.

4. Connect the phone cable to a second COM port (different than used 
step 1). On most laptop PCs this will require the use of a Socket Seria
RS-232 card that is installed into the PCMCIA slot on your PC.

5. Turn on the Trimble Placer GPS 455 unit, the PC, and the phone.

6. Configure the Trimble Placer GPS 455 unit for the correct settings. S
“Selecting GPS Hardware” on page 3-4 for more information. 

7. Configure the phone:

a. Select Configuration mode.

b. Select the Hardware tab.

c. Double-click the phone icon or select the phone icon and click Modify.

d. In the Hardware Type box, select the phone used.

e. Click the Port Selections and Port Settings tabs to modify and con
the correct COM port setting for the phone. The port selection sho
be serial. Select the Com port you are using.
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f. Use the default port settings or use the values according to the 
PCMCIA Socket I/O card you are using. 

g. Click OK when you are satisfied with the settings.

h. Select Collection mode to start the measurements.

NOTE Never set your GPS receiver protocol as TAIP and TSIP together. The 
Agilent Wireless Solutions Software is designed to work with one protocol at 
a time. Having both protocols active may confuse the system.

NOTE If you need to change the GPS coordinate datum, select the Advanced tab of 
GPS hardware configuration box. The default datum can be set using the 
Tools > Options and selecting the Default Datum tab.
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Trimble Placer GPS 455 & Differential

The setup for the Trimble Placer GPS 455 and differential is shown in Figure 
2-21. 

Before you begin the hardware installation procedure, please review 
“Hardware Installation Tips” on page 2-3.

86154A option 230 provides a differential GPS, with all necessary cables
included. A differential GPS may also be customer supplied. 

If the Trimble Placer GPS 455 DR receiver is supplied by Agilent as 
option 210, all necessary cables are included. If the Trimble Placer GPS 
receiver is customer supplied, 86154A option 212 is required.

Figure 2-21 Trimble Placer GPS 455 and Differential with Phone
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Configuring a Trimble Placer GPS 455 and Differential 

1. Connect the hardware security key to the parallel port of the PC.

2. Connect the serial port of the PC to the RS-232 port of the differential 
receiver using the RS-232 straight-through cable, connected to the RS-
232 “T” cable. The default serial port used by the application is serial,
COM1. If your PC uses a different COM port, you can specify a differe
serial port number.

3. Connect the RTCM port of the Trimble-supplied communications cabl
the differential GPS receiver, using the RS-232 “T” cable included wit
the system. Connect the remaining port of the Trimble-supplied 
communications cable to the MDT/RTCM port of the Trimble Placer 
GPS 455 unit.

4. Connect the GPS antenna to the GPS ANT port of the Trimble Place
GPS 455 unit. Agilent Technologies recommends that a “bulkhead 
mount” GPS antenna be used whenever possible for improved 
performance.

5. Connect the VHF Differential GPS antenna to the Differential GPS un

6. Connect the phone cable to a second COM port (different than used 
step 1). On most laptop PCs this will require the use of a Socket Seria
RS-232 card that is installed into the PCMCIA slot on your PC.

7. Connect power to the differential GPS unit, the Trimble Placer GPS 4
unit, and the PC.

8. Turn on the differential GPS unit, the Trimble Placer GPS 455 unit, th
PC, and the phone. Refer to “Selecting GPS Hardware” on page 3-4 to 
configure the Agilent Wireless Solutions Software.

9. Configure the phone:

a. Select Configuration mode.

b. Select the Hardware tab.

c. Double-click the phone icon or select the phone icon and click Modify.

d. In the Hardware Type box, select the phone used.
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e. Click the Port Selections and Port Settings tabs to modify and confirm 
the correct COM port setting for the phone. The port selection should 
be serial. Select the Com port you are using.

f. Use the default port settings or use the values according to the 
PCMCIA Socket I/O card you are using. 

g. Click OK when you are satisfied with the settings.

h. Go to Collection to start the measurements.

NOTE Never set your GPS receiver protocol as TAIP and TSIP together. The 
Agilent Wireless Solutions Software is designed to work with one protocol at 
a time. Having both protocols active may confuse the system.

Configuring the Differential GPS Communications Port When 
Using a Differential GPS

1. If your system includes an Agilent E645x receiver 86154A option 230 
differential GPS receiver, the baud rate of the Differential Corrections 
Inc., (DCI) Differential GPS model RDS 3000, and the baud rate of the 
Trimble GPS receiver unit must be the same. 

Please refer to the manuals supplied by Differential Corrections, Inc. and 
Trimble Navigation, Limited.

2. Connect the differential GPS to the serial port of the PC. 

3. Run the software supplied by DCI with the differential GPS (rtcmon.exe). 
(The file is contained on the disk that comes with 86154A option 230).
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4. Press F1 to set the correct baud rate for the differential GPS. Use the 
following table to set the baud rate for the Trimble model you are using.

When the differential GPS is correctly configured, it will start to send legible 
information to the PC. If the subscription is active, this information will be 
correction data, otherwise it will be scanned frequencies.

NOTE If you need to change the GPS coordinate datum, select the Advanced tab of 
GPS hardware configuration box. The default datum can be set using the 
Tools > Options and selecting the default datum tab.

Please contact DCI for information about getting a subscription to activate 
your differential GPS. Once activated, it is ready to work with the 
Agilent Technologies system.

Table 2-4 Trimble Baud Rate Settings

Differential GPS Use F1 to set the baud rate of 
the DCI model RDS 3000 
differential GPS

Then use F2 to set the baud 
rate of the PC serial port

Placer GPS/DR 9600 9600

Trimble Placer GPS 455 9600 9600

Agilent E645x with internal 
GPS (Trimble model SK-8)

4800 4800
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Trimble Placer GPS 455 with Dead Reckoning

The setup for the Trimble Placer GPS 455 with Dead Reckoning is shown in 
Figure 2-22. 

Before you begin the hardware installation procedure, please review 
“Hardware Installation Tips” on page 2-3.

86154A option 210 provides a Trimble Placer GPS 455 receiver and two G
antennas. All necessary cables and adapters are included. The speedom
interface is not included. If the Trimble Placer GPS 455 receiver and GPS 
antennas are customer supplied, 86154A option 212 (adapter and cables
required.

Figure 2-22 Trimble Placer GPS 455 with Dead Reckoning and Phone
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Configuring a Trimble Placer GPS 455 with Dead Reckoning

NOTE When the heading sensor is connected to the GPS 455 receiver, Dead 
Reckoning must be calibrated before the software will provide correct GPS 
information.

1. Connect the hardware security key to the parallel port of the PC.

2. Connect the serial port of the PC to the MDT port of the Trimble Placer 
GPS 455 using an RS-232 straight-through cable. The default serial port 
used by the application is serial, COM1. If your PC uses a different COM 
port, you can specify a different serial port number.

3. Connect the Heading Sensor to the HS port of the Trimble Placer GPS 
455 through the female 9-pin connector on the DR sensor cable supplied 
by Trimble. See Figure 2-10. The connector labeled Heading Sensor 
connects to the heading sensor; the connector labeled Sensors connects to 
the Placer GPS 455.

4. Connect the GPS antenna to the GPS ANT port of the Trimble Placer 
GPS 455 unit. Agilent Technologies recommends that a “bulkhead 
mount” GPS antenna be used whenever possible for improved 
performance.

5. Connect the phone cable to a second COM port (different than used 
step 1). On most laptop PCs this will require the use of a Socket Seria
RS-232 card that is installed into the PCMCIA slot on your PC.

6. Turn on the Trimble Placer GPS 455, the phone, and the PC.

7. Calibrate the DR unit using Trimble supplied software Plcrinit.exe or 
GPSSK. If you do not have this software, it is available on the Trimble
web page. 

8. Start the Agilent Technologies application software. Verify that both th
software and the Trimble Placer GPS 455 are configured for the sam
communication protocol.
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9. Configure the phone:

a. Select Configuration mode.

b. Select the Hardware tab.

c. Double-click the phone icon or select the phone icon and click Modify.

d. In the Hardware Type box, select the phone used.

e. Click the Port Selections and Port Settings tabs to modify and confirm 
the correct COM port setting for the phone. The port selection should 
be serial and select the Com port you are using.

f. Use the default port settings or use the values according to the 
PCMCIA Socket I/O card you are using. 

g. Click OK when you are satisfied with the settings.

h. Select Collection mode to start the measurements.

NOTE Never set your GPS receiver protocol as TAIP and TSIP together. The 
Agilent Wireless Solutions Software is designed to work with one protocol at 
a time. Having both protocols active may confuse the system.

For additional information and vehicle connections for Trimble Placer units, 
refer to Trimble Navigation Limited documentation.
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Figure 2-23 Heading Sensor Cable
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Configuring Multiple Receivers and Phones

The Agilent Wireless Solutions support up to four receivers (all options) and/
or four phones (option 150 only). 

Multiple Receivers

NOTE When connecting multiple receivers, it is recommend that you use the 
automatic configuration wizard. For more information refer “Automatic 
Configuration” on page 2-5.

When you configure multiple receivers, only one receiver (the master 
receiver) is physically connected to the computer and is able to supply inp
from the GPS. You attach an external GPS system (unless it has internal 
to the master receiver only. The other receiver(s) receive their GPS signa
from the master receiver via the cabling shown in Figure 2-24. If other 
receivers contain internal GPS systems, their GPS is ignored. When you
configure the receivers in the software, do not attempt to configure more 
one GPS receiver (the one provided by the master receiver).

If you are using an external GPS, refer to the appropriate section
(seeTable 2-1 on page 2-7) for instructions on how to connect it to your 
master receiver. The setup for multiple receivers is shown in Figure 2-24.

Before you begin the hardware installation procedure, please review 
“Hardware Installation Tips” on page 2-3.
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NOTE • Each receiver you purchase comes with one short cable. Configuring 
multiple receivers requires a short cable for each receiver, but only one 
long cable, so you may end up with some extra cables. Cables can be 
ordered using Agilent 86154A option 099.

• The Agilent E6450A receiver is not capable of multiple-receiver 
functionality. However, it can be upgraded to an Agilent E7473A Options 
320 or 330. This upgrade is covered by ordering Agilent 86150A special 
upgrade (see your Agilent Technologies representative for more 
information).

• To operate multiple receivers, you must be running version A.03.01, or 
later, of the software, and version 3.00.00, or later, of the firmware.

• To operate multiple phones, you must be running software that supports 
multiple phone measurement and be using the correct hardware security 
key.
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Figure 2-24 Multiple Receiver Configuration

Configuring a multiple receiver system

1. Begin by connecting the receivers to each other using the illustrations 
shown in Figure 2-24 on page 2-76 and Figure 2-25 on page 2-80 to guide 
you. Decide which receiver will act as the master receiver, the receiver to 
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which you connect the computer and the GPS (or one that has internal 
GPS).

NOTE You should not connect GPS antennas to other, non-master receivers, which 
may have internal GPS. Only connect a GPS antenna to the master receiver or 
GPS system.

a. Attach one end of a short cable to the RX LOOP IN connector on the 
master receiver. Attach the other end of the short cable to the RX 
LOOP OUT of the second receiver. The receivers are designed to 
stack one on top of the other.

b. Continue to attach receivers (up to a total of four receivers) as in 
step a.

c. When all receivers are connected with short cables, connect one end 
of a long cable to the RX LOOP OUT connector on the master 
receiver to the RX LOOP IN on the last receiver in the series.

2. Connect the hardware security key to the parallel port of the PC.

3. Connect the serial port of the PC to the RS-232 port of the 
master receiver with an RS-232 cable. The default serial port used by the 
application is multiplexed serial, COM1. If your PC uses a different com 
port, you can specify a different serial port number in the software when 
you configure the project.

4. Connect the RF antenna to the RF input of each of the Agilent E645x 
receivers. Use the supplied Type-N to TNC adapter, if necessary.

5. When applicable, connect the GPS system and antenna as instructed 
earlier in this guide. See Table 2-1, “GPS System Configurations,” on 
page 2-7 for the page to which to refer for your specific GPS and recei

6. Turn on the GPS system and the PC, and run the application.

7. Select or create the project you are going to use. 
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8. To configure each individual receiver: 

a. Select Configuration mode.

b. Choose the Hardware tab, and click Add. The Hardware Editor opens. 
(Alternatively, you can click the right mouse button to display the 
Edit menu, and then choose Add.)

c. Enter a description of the receiver in the Description field. It is 
important with multiple receivers that you are very specific in your 
descriptions to help you identify a particular receiver in a 
measurement setup.

d. Select the type of hardware you want to use from the Hardware Type 
drop-down list.

e. Select the COM Port you want from the Port Selection drop-down 
list.

f. Click the Port Settings tab to configure the COM port you selected.

g. Click the Advanced tab, and indicate in the RX Loop Position box the 
position in which the receiver is located (“Determining Where in the 
Chain a Receiver Is Positioned” on page 2-79). If all receivers are 
unique, you can select Auto to accept the default settings which a
based on the receivers’ physical position.

9. Select Configuration mode.

a. Select the Hardware tab.

b. Double-click the GPS icon, or select GPS then click Modify.

c. In the Hardware Type box, select the appropriate GPS system.

d. Click OK.

NOTES • If the receivers are not different models or are in unique situations (such 
as one receiver with the antenna on the roof and the other receiver with 
the antenna in an isolation box), you can set the RX loop positions 
yourself to ensure that you can differentiate between them for 
measurements and the resulting data.
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• When receiver position is assigned by the system (when you select Auto), 
an effort is made to match as closely as possible the physical order of the 
receivers.

• The receiver in position 1 has a higher data rate than receiver 2, which is 
higher than receiver 3, etc.

Accept the default settings for baud rate, parity, and others. See “Selecting 
GPS Hardware” on page 3-4 for more information.

NOTE If you need to change the GPS coordinate datum, select the Advanced ta
GPS hardware configuration box. The default datum can be set using the
Tools > Options and selecting the Default Datum tab.

For additional information and vehicle connections for Trimble Placer uni
refer to Trimble Navigation Limited documentation.

Determining Where in the Chain a Receiver Is Positioned

The position of a particular receiver in a chain of receivers is determined b
proximity in the chain to the master receiver (the receiver connected direc
to the computer). The connection is made from RX LOOP OUT on one 
receiver to RX LOOP IN on the next in the chain. Therefore, the receiver 
is connected to the master receiver’s RX LOOP OUT becomes the secon
module in the chain. The third module is the one connected to the secon
one’s RX LOOP OUT, and so on. Figure 2-25 on page 2-80 illustrates how the 
receivers are configured and numbered by the system.
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Figure 2-25 Positioning a Series of Receivers
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Multiple Phones (Option 150)

The Wireless Solutions system supports up to four phones. The phones attach 
to the computer via a PCMCIA card (see Figure 2-26). Agilent Technologies 
recommends and supports the Socket™ I/O1 card (86154A option 020) which
provides two phone connectors. Refer to the User’s Guide that comes wit
card for installation instructions. To attach four phones, you will need two
Socket™ Port Ruggedized Serial I/O cards and your computer must have
PCMCIA slots.

NOTE NT 4.0 does not support two serial I/O cards.

Agilent 86154A option 036 can also provide four RS-232 Serial ports thro
a Universal Serial Bus (USB) adapter.

NOTES Be advised that when you add two cards, more resources are required th
many laptops have. It is possible that you will experience slowdowns or e
crashes. Please refer to Chapter 5, “Troubleshooting Resource Problems, 
COM Errors and GPS Problems” for recommendations on how to avoid this
situation and Chapter 6, “General Hardware Specifications and Minimum 
System Requirements” for minimum PC requirements.

To operate multiple phones and receivers, you must be running version 
A.03.01 of the software or later and have the appropriate multiple resourc
license security key.

Before you begin the hardware installation procedure, please review 
“Hardware Installation Tips” on page 2-3.

1. The Socket™ Port Ruggedized Serial I/O card is produced by Socket 

Communications, Inc.
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Checking for a Free Interrupt

Each dual port serial I/O card you insert requires one free interrupt request 
(IRQ) to operate. Check the following entries in the Windows 95 help index 
for more information: 

• Resources for hardware
• Freeing resource settings used by disabled hardware
• Troubleshooting conflicts

Figure 2-26 Multiple Phone Configuration

Configuring a Multiple Phone System

1. Connect the hardware security key to the parallel port of the PC.

2. Connect the GPS system and antenna as instructed earlier in this guide. 
See Table 2-1, “GPS System Configurations,” on page 2-7 for the page 
that covers your specific GPS.

3. Connect the phone cable to a second COM port (different than you u
step 2). On most laptop PCs this will require the use of a Socket Dual
card, installed into the PCMCIA slot on your PC. If you are installing 
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three or four phones, you’ll need to insert a second I/O card and then
connect the additional phone cable. To verify COM port allocation:

a. On your Windows desktop, open the Start menu and choose Settings > 

Control Panel and double-click the System icon to open the System 
Properties window.

b. Select the Device Manager tab.

c. Open Ports (COM and LPT) and check that the COM ports you n
are defined and available. Make a note of the COM numbers that 
assigned.

NOTE Some I/O cards provide their own icon on the Control Panel. Select it to 
expedite configuration.

4. Turn on the GPS, the PC, and the phone(s), then start the application

5. Select or create the project you are going to use. 

6. Select Configuration mode.

a. Select the Hardware tab.

b. Double-click the GPS icon, or select GPS then click Modify.

c. In the Hardware Type box, select the appropriate GPS.

d. On the Port Selection tab, select the appropriate COM port (typic
COM1). If the GPS is connected to a receiver (or is built into that 
receiver), connect the receiver to the main COM port. 

e. If the GPS is connected to a PC, select Serial. If the GPS is connected 
to an Agilent receiver, select Multiplex Serial.

f. Click OK.

NOTE If you need to change the GPS coordinate datum, select the Advanced ta
GPS hardware configuration box. The default datum can be set using the
Tools > Options and selecting the Default Datum tab.
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7. Configure each phone individually as follows:

a. In Configuration mode, select the Hardware tab.

b. Double-click the phone icon or select the phone icon and click Modify 
to display the Hardware editor. Or, click Add to add a new phone.

c. Enter a description for the phone.

NOTE When you describe (name) a project, the more descriptive you are, the easier 
it will be later to distinguish among resources when you are creating 
measurements that use similar or multiple resources.

d. In the Hardware Type box, select the phone type.

e. Click the Port Selections and Port Settings tabs to modify and confirm 
the correct COM port setting for the phone. The port selection should 
be serial. Select the Com port you are using.

f. Use the default port settings or use the values according to the 
PCMCIA Socket I/O card you are using. 

g. Click OK when you are satisfied with the settings.

8. Select Collection mode to start the measurements.

Multiple Receivers and Phones

Refer to “Multiple Receivers” on page 2-74 and “Multiple Phones (Option 
150)” on page 2-81 for information about installing multiple receivers and 
multiple phones. There are no special considerations for installing both 
multiple phones and multiple receivers. Figure 2-27 on page 2-86 illustrates a 
sample setup.

Before you begin the hardware installation procedure, please review 
“Hardware Installation Tips” on page 2-3.
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NOTE The GPS must be physically connected through the Agilent receiver and 
designated in the software as Multiplex Serial.
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Figure 2-27 Multiple Receiver and Phone Configuration
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 a 
Universal Serial Bus (USB), 4-port Adapter 
Configuration

The USB-to-Serial Converter, EdgePort/4, from Inside Out Networks™ is
true plug-and-play compatible device. It reduces the number of cables 
required by multiplexing up to four serial ports onto one USB cable. 

NOTES • Currently only Windows 98 provides true USB and plug-and-play 
capability. These instructions only apply to Windows 98. In the near 
future, Windows NT (2000) will have plug-n-play USB support.

• The USB serial converter has an optional +5V input which in NOT 
required for use. The USB connection provides sufficient power to the 
converter to support four serial devices.

WARNING Do not connect power to the EdgePort/4 USB. It does not require external power, 
even though there is a power connector on the back. Any power source that is of 
an incorrect voltage, such as the receiver battery, can damage the Acceleport 4.
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To Connect the USB Serial Converter for Use with a Laptop or a 
Non-Agilent Provided Pen Tablet

This procedure is for customers wishing to use the device on laptop systems in 
a drive test environment, or, indoor customers installing on their own 
computing device.

1. Plug in the EdgePort/4 to the USB port. The device is recognized by 
Windows as new hardware.

2. Insert the Windows 98 Inside Out Networks Acceleport 4 driver diskette 
in the device’s floppy drive.

(For the Fujitsu pen tablet computer, the floppy drive is connected via
connector exposed by removing the battery. This must be done with 
external power connected.)

3. Follow the directions in the New Hardware wizard to select the floppy
drive as the source for the drivers.

4. The drivers load and are configured automatically. The converter is n
ready to use.

To Connect the USB Serial Converter for Backpack Usage

1. Unzip the left shoulder strap pocket.

2. Feed the USB connector through the strap, out through the top, then d
through the hole in the top of the backpack.

3. Pull the cable in and plug it into the USB serial converter.

4. Fasten the USB hub into the case.

CAUTION The USB connector attaches to the pen tablet on the outside of the case
you collect data, watch that you don’t bump the USB connector against y
surroundings. Also, be aware of backpack dimensions and weight. Dropp
or bumping the system may cause the measurement system to fail.
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Receiver Connector Panel

Make all connections before applying power. The default serial port used by 
the application is COM1. If desired, you can specify a different serial port in 
the application.

When the Agilent E645x receiver is turned on, the ACTIVE indicator is 
lighted. The light will turn off for 1-2 seconds during the software start up and 
configuration process.

Figure 2-28 The Agilent Receiver Connector Panel
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Internal GPS Receiver Connector Panel

The receiver provides an internal GPS as identified in the application.

Make all connections before applying power. The default serial port used by 
the application is COM1. If desired, you can specify a different serial port in 
the application.

When the receiver is turned on, the ACTIVE indicator is lighted. The light will 
turn off for 1-2 seconds during the software start up and configuration 
process.

Once the receiver is turned on and the GPS antenna is properly placed, the 
GPS is functional; however it may take several minutes to acquire GPS lock.

Figure 2-29 The Agilent Digital Receiver with Internal GPS, Connector Panel
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m” 
Receiver to PC Serial Port Cable Configuration

Figure 2-30 shows the pin-out specifications for the connection between the 
Receiver and the PC. The cable provided with the system is a “Null Mode
cable.

Figure 2-30 Agilent E645x Receiver Connections to PC Serial Port 
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RS-232 to GPS Unit Cable Configuration

Figure 2-31 is supplied in case the GPS unit you are using is different from 
those described in this guide. The Agilent Wireless Solutions Software can 
usually operate any GPS unit employing the TAIP, TSIP, or NMEA protocols.

NOTE 1PPS must be provided on Pin 9 for CDMA Pilot and Code-Domain Power 
measurements, to be accurate and stable.

Figure 2-31 RS-232 Cable Connecting the Agilent E645x Receiver to a GPS Unit
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RS-232 to Differential Unit Cable Configuration

Figure 2-32 shows the pin-out specifications for connection of the differential 
GPS receiver to an Agilent E645x receiver (with internal GPS). 

Figure 2-32 RS-232 Cable Connecting the Agilent E645x Receiver to a Differential Unit
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RX Loop In/Out Cable Configuration

Figure 2-32 shows the pin-out numbers for the cable used to connect 
receivers, in a multiple receiver setup. Connections are made between the 
Rx Loop in and Rx Loop out of the Agilent E645x receivers. The pin-out 
numbers apply to both the short and long cables.

Figure 2-33 Cable Connecting the Agilent E645x Receiver to Another Agilent E645x 
Receiver
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Mounting the Receiver

The vehicle mounting kit is used to mount the Agilent digital receiver in a 
vehicle or rack. These parts are supplied with an Agilent digital receiver or 
can be ordered separately as 86154A Option 510. 

Figure 2-34 Vehicle Mounting Kit (Agilent 86154A Option 510)
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Mounting a Receiver

1. Remove the rubber bumpers from each end of the receiver.

2. To attach the brackets to the top of the receiver, remove the top two screws 
from the front and rear panels of the receiver.

3. To attach the brackets to the bottom of the receiver, remove the bottom 
two screws from the front and rear panels of the receiver.

4. Attach the brackets using the two screws you removed in step 2 (for top 
attachment) or step 3 (for bottom attachment).
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What You’ll Find in This Chapter
What You’ll Find in This Chapter

To Do This See This

Start the software. “Starting the Agilent Wireless Solutions 
Software” on page 3-3

Select GPS Hardware. “Selecting GPS Hardware” on page 3-4 

Learn to use the software. “Using the Online Tutorial” on page 3-7

Get information about taking measurements. “Using Online Help” on page 3-9

Start and use the License Manager. “Using the License Manager” on page 3-12

Get an online version of this guide and other 
documentation (PDF format).

“Additional Documentation” on page 3-14
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Starting the Agilent Wireless Solutions Software

Be sure that you have installed the software. Refer to “Installing the Software” 
on page 1-1for instructions.

CAUTION It is possible to exceed Windows 95/98 allocated resource levels by open
too many windows while running your system. This causes erratic behavio
the application and requires the operator to reboot the operating system 
order to recover. This will also corrupt an open Wireless Solutions databa
with potential loss of data. Windows 95 does not display any warning or 
feedback when this occurs. Refer to Chapter 5, “Troubleshooting Resource 
Problems, COM Errors and GPS Problems” for more information.

Do This See This

1 Choose the Start menu and click Programs, 
then click Agilent E74xx (the name of your 
Agilent Wireless Solutions).

The options include:

• Agilent E74xx Help

• Agilent E74xx Series (application software)

• Agilent E74xx Tutorial

• Getting Started Guide

• License Manager

• Read Me

• Support Information

2 Click Agilent E74xx to start the software. The copyright screen appears for a few seconds, 
then the software appears on your screen, ready 
to use.

Note: The first time you start the software you 
have the opportunity to run the online tutorial, a 
tool that is designed to help you get the most 
from the software.
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Selecting GPS Hardware

The Agilent Wireless Solutions Software is designed to support several types 
of GPS hardware. The application must be configured for your system in 
order to operate correctly. The following procedure describes how to select 
the appropriate GPS hardware.

NOTE If you are unsure of your GPS communication protocols and configuration, 
use the automatic configuration wizard to set up your GPS. Refer to 
“Automatic Configuration” on page 2-5.

Do This See This

1 Set up the hardware. Chapter 2, “Setting Up Your System” for your 
hardware configuration.

2 Turn on the hardware. Chapter 2, “Setting Up Your System” for your 
hardware configuration.

3 Turn on the PC and run the Agilent Wireless 
Solutions Software.

See “Starting the Agilent Wireless Solutions 
Software” on page 3-3.

4 Create or select a Project. Project name appears in the field.

5 Select Configuration mode. You switch to Configuration mode.

6 Select the Hardware tab. See Figure 3-1.

7 Select GPS, then click Modify, or double-
click the GPS icon.

You can now select the appropriate GPS protocol. 
See Figure 3-2. 
3-4 Agilent Technologies Wireless Solutions Getting Started Guide



Starting and Learning to Use the Software
Selecting GPS Hardware
Figure 3-1 A List of Hardware in Configuration Mode

8 In the Hardware Type box, select the 
appropriate GPS hardware. Click the Port 
Selections and Port Settings tabs to set the 
communications protocol for your system.

Refer to Table 4-5 on page 4-19 for a listing of the 
GPS protocols 

9 Click OK when you are satisfied with the 
settings.

10Select Collection mode to start 
measurements.

Do This See This
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Figure 3-2 Hardware Editor Where You Select Your GPS Protocol
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Using the Online Tutorial 

As part of the product, the Agilent Wireless Solutions Software includes an 
online tutorial. The opening screen is shown in Figure 3-3. It is strongly 
recommended that you complete the online tutorial before you perform any 
measurements.

Figure 3-3 The Opening Screen of the Agilent Wireless Solutions Online Tutorial

The tutorial provides an overview of the capabilities of the Agilent Wireless 
Solutions. It also demonstrates the most important tasks you’ll perform, a
then guides you through practicing those tasks in the program.

Agilent Technologies supplies Wireless Solutions for GSM, CDMA, and 
TDMA systems. This tutorial includes training for all types of systems, bu
is not necessary to view all parts of the tutorial if you are only going to be
analyzing your particular system.
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Run the Tutorial

After the Tutorial

When you have finished running the tutorial, you can continue learning about 
the system by looking at these online help topics.

• Introducing the system

• Getting started

• Receiver Based Procedures

• Phone Based Procedures

• Importing, exporting, and mapping data

See “Using Online Help” on page 3-9 for more information.

Do This See This

1 Choose the Start menu and click Programs, 
then click Agilent E74xx (the name of your 
Agilent Wireless Solutions).

The options include:

• Agilent E74xx Help

• Agilent E74xx Series (application software)

• Agilent E74xx Tutorial

• Getting Started Guide

• License Manager

• Read Me

• Support Information

2 Click Agilent E74xx Tutorial to start the 
software.

The tutorial begins as shown in Figure 3-3 on 
page 3-7.

Note: The first time you start the software you 
have the opportunity to run the online tutorial, a 
tool that is designed to help you get the most 
from the software.
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Using Online Help

As part of the product, the software also includes context-sensitive online help 
and How Do I? help, designed to answer many commonly asked operation 
and application questions. You can also select Support Help from the Help 
menu to see a description of available support resources, including phone 
numbers. Figure 3-4 shows sample lists of help topics.

.

Figure 3-4 Online Help and How Do I Help Contents
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Run the Online Help

NOTE You can press F1 when running the application software to open help for the 
displayed screen. If F1 is not active, you can click the Help button.

Do This See This

1 Choose the Start menu and click Programs, 
then click Agilent E74xx (the name of your 
Agilent Wireless Solutions).

The options include:

• Agilent E74xx Help

• Agilent E74xx Series (application software)

• Agilent E74xx Tutorial

• Getting Started Guide

• License Manager

• Read Me

• Support Information

2 Click Agilent E74xx Help to start the 
software.

Or,

You can choose Topics from the Help menu in 
the Agilent E74xx software.

Or,

You can choose How Do I? from the Help 
menu in the Agilent E74xx software.

Or,

You can choose Support from the Help menu 
in the Agilent E74xx software.

The help opens, a sample of which is shown in 
Figure 3-4 on page 3-9.

3 Click the Contents tab to view all the topics in 
the online help. 

• Double-click a book icon to view its contents.

• Double-click to display the topic you want.

The topic you’ve selected opens in the help 
window. Procedures can be left on the screen to 
guide you as you work in the software.
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4 Click the Index tab to search through an 
alphabetical list of topics. 

• Scroll through the list or type in the text box to 
locate the subject you want. 

• Double-click the index term when you find it.

The topic you’ve selected opens in the help 
window. Procedures can be left on the screen to 
guide you as you work in the software.

5 Use the Find tab to search the online help to 
find topics that include the words or phrases 
you type in the text box. 

• Double-click the topic to open the help window 
for that topic.

The topic you’ve selected opens in the help 
window. Procedures can be left on the screen to 
guide you as you work in the software.

6 Click Close to exit help. The help window closes.

Do This See This
Agilent Technologies Wireless Solutions Getting Started Guide 3-11



Starting and Learning to Use the Software
Using the License Manager
Using the License Manager

The hardware key that came with your Agilent Technologies system enables 
and secures the functionality you purchased from Agilent Technologies. 

Starting the License Manager

Do This See This

1 Choose the Start menu and click 
Programs, then click Agilent E74xx (the 
name of your Agilent Wireless Solutions).

The options include:

• Agilent E74xx Help

• Agilent E74xx Series (application software)

• Agilent E74xx Tutorial

• Getting Started Guide

• License Manager

• Read Me

• Support Information

2 Click Agilent E74xx License Manager 
to start the software.

The License Manager begins showing the enabled 
software options, Figure 3-5 on page 3-13.
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Figure 3-5 License Manager

Learning the License Manager

For further information about the Agilent Technologies License Manager, 
refer to the following resources:

Resource Description

Online Help Available from the software’s Help menu or by pressing F1, 
covers all functionality. It is the program’s reference and includes 
step-by-step instructions for basic operations.

Support Available from the Help menu, directs you to the support 
provided by Agilent Technologies.
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Additional Documentation

Additional documents are supplied with your system. These include:

• This Getting Started Guide (PDF format)

• Agilent Indoor Wireless Solutions Getting Started Guide: a guide that 
describes how to use the elements of the indoor solution, such as the 
backpack, the hands-free platform, and the receiver batteries (PDF 
format).

• Agilent E74xx System Options and Accessories Guide: a guide containing 
system options and accessories, including part numbers (PDF format).

These documents can be viewed online or printed.

Location of Online Documents

The documents were installed with your software application, if you used the 
typical installation option. The documents were installed in the following 
location:

C:\Program Files\Agilent Technologies\E74xx\Documents

If you chose not to install the documents during software installation, you can 
copy them from the CD. The documents can be found in the following 
location on the CD:

D:\documents\

(d: represents the drive letter of your CD-ROM reader.)
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Viewing and Printing Online Documents

Before you can view and print these documents, you must have the Adobe 
Reader installed on your system. For more information about PDF files and 
the Adobe Reader, refer to the Adobe Web site (http://www.adobe.com).

The Adobe Reader is supplied on your CD. Refer to “Installing Adobe 
Reader” on page 1-6 for more information.

NOTE The latest version of the Adobe Reader can also be downloaded from the
Adobe Web site (http://www.adobe.com).

To View a PDF Document Installed with Your System:

Do This Additional Information

1 From the program task bar, select Start, Programs, 
Adobe, Adobe Reader

The Reader software is displayed.

2 From the File menu of the Reader, select Open. A dialog box appears listing the available 
drives you can read.

3 Select the C: drive and then select the documents 
folder.
C:\Program Files\Agilent Technologies\E74xx\Documents

The dialog box displays the PDFs contained 
on your CD.

4 Choose the document you wish to view. • Getting Started Guide.PDF - a PDF file 
of this Guide.

• Support Information.PDF - a guide 
containing system and accessory options 
and part numbers.

• Indoor Getting Started Guide.PDF - a 
guide that helps you set up your system 
for indoor measurements (Option 180).

5 Search for the information you require. This can be done using:

• Hypertext links (blue text)

• The Adobe Reader search tool, found on 
the Tools menu.
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To Print a PDF Document or Sections from It:

Do This Additional Information

1 With the document opened, search for the 
information you require to be printed.

2 Note the page number(s) displayed at the 
bottom of the Reader.

Note: The page numbers shown in the document 
may not correspond to the page numbers 
displayed by the reader.

3 Select File > Print and configure the print 
options for your printer.

CAUTION: when printing sections from the 
Getting Started Guide, ensure that a page or 
page range is specified. The Getting Started 
Guide is approximately 250 pages.
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What You Will Find In This Chapter
What You Will Find In This Chapter

There are four methods you can use to verify your system. These methods are:

If you have a phone-only system, use method 4 to verify your system. If you 
have an Agilent digital receiver as part of your system, you need to use at least 
2 methods. These are method 4 and either method 1, or 2, or 3. Method 1 and 
2 provide the highest level of confidence. Method 3 should only be used if you 
do not have a signal generator and there is no known channel in the system.

NOTE • The verification tests are only used to alert you to possible non-operating 
conditions. To measure actual receiver specifications, the unit must be 
measured in a controlled environment, using Agilent Technologies’ 
prescribed measurement techniques.

• Before you start the verification procedures, familiarize yourself with the 
system, by completing the online tutorial. See Chapter 3, “Using the 
Online Tutorial”.

Method Additional Information

1 “Method 1: Using a Signal Generator” on page 4-3

2 “Method 2: Measuring a Known Channel in the System” on page 4-10

3 “Method 3: Measuring the Noise Floor” on page 4-13

4 “Method 4: GPS Measurement Verification Procedure” on page 4-18
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Method 1: Using a Signal Generator

This procedure requires the Agilent 8648B signal generator. A similar signal 
generator can be used, providing it meets or exceeds the frequency ranges of 
your Agilent digital receiver and can produce an amplitude in the range of 
-70 dBm to -50 dBm.

CAUTIONS The input power to the Agilent digital receiver should not exceed -10 dBm. 
Receiver measurements are not warranted for power levels between -10 dBm 
and 10 dBm. Power levels greater than 10 dBm damage the instrument.

For optimum performance, it is recommended that no more than -25 dBm be 
applied to the input of the Agilent digital receiver.

Do not connect the signal generator until you have checked the output power 
level is below -10 dBm.
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Figure 4-1 System Measurement Verification Setup Using a Signal Generator

Preparing the Hardware

Do This Additional Information

1 Connect the system as shown in Figure 4-1, 
but do not connect the signal generator 
output.

The Agilent receiver requires a 30 minute 
warm-up period to meet the guaranteed 
specifications.

There is a three minute delay after power-up or 
re-configuration, before the internal temperature 
sensor is activated and measurements are 
nominally correct.

For more information on how to connect the 
receiver and laptop, refer to step 1 and step 2 of 
any of the procedures listed in Chapter 2, 
“Receiver-Based System Setup”

2 Depending on your system type, set the 
frequency/power levels using Table 4-1 on 
page 4-6.

3 Check that the correct values are set on the 
signal generator.

Do not connect the signal generator at this 
stage.
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Preparing the Software

Do This Additional Information

1 Start the application program by going to the 
Start menu, selecting Programs, Agilent E74xx.

The software starts.

2 Create a new project called
Verification Test 1 (External generator). 

We recommend you use the automatic 
configuration wizard for this process. Refer to 
Chapter 2, “Automatic Configuration”.

3 Click Configuration and then add the receiver 
hardware.

Refer to Chapter 2, “Hardware Installation Tips”

4 Click Collection and select the Spectrum VFP 
(Virtual Front Panel)

5 Click Maximize button in the upper-right corner 
of the main window. 

The display size increases to fill the available 
space.

6 Connect the signal generator output to the RF 
input of the receiver. 

7 Turn on the signal generator. 

8 Set the measurement software as follows:

Band: Uplink

Frequency: See Table 4-1 on page 4-6

Span: 1 MHz

Averaging: Running

Averages: 32

You should see a signal trace showing a single 
spectral peak in the middle of the display.

Figure 4-2 on page 4-6 shows a example trace.
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Table 4-1 Signal Generator Uplink Settings

Figure 4-2 Spectrum Display with Marker Set to a Center Frequency of 898 MHz 
(GSM900 band system)

Model Frequency and Power Setting

GSM1900, TDMA and CDMA PCS band systems 1879 MHz at –60 dBm

GSM DCS1800 band systems 1748 MHz at –60 dBm

GSM900 band systems 898 MHz at –60 dBm

Cellular CDMA and TDMA band systems 837 MHz at -60 dBm
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Testing the Signal

Table 4-2 Signal Generator Downlink Settings

NOTE Wait for at least one minute before using the displayed marker value. The 
default trace display is set to display a running average of 32. With time, the 
marker value will approach the value of the signal generator output.

Do This Additional Information

1 In the Markers group, click Add and To Max. The level and frequency are displayed at the top-left 
corner of the Spectrum display. 

2 In the Band group, select Downlink.

3 In the Freq/Channel group, change the 
Center frequency according to the Table 4-2.

4 On the signal generator, set the frequency 
according to the Table 4-2.

You should see a signal trace showing a single 
spectral peak in the middle of the display.

Figure 4-3 on page 4-9 shows a example trace.

Model Frequency and Power Settings

GSM1900, TDMA and CDMA PCS band systems 1959 MHz at -60 dBm

GSM DCS1800 band systems 1843 MHz at -60 dBm

GSM900 band systems 943 MHz at –60 dBm

Cellular CDMA and TDMA band systems 882 MHz at -60 dBm
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Accuracy

The accuracy is calculated as:

Frequency accuracy = signal generator accuracy + 1 ppm.

Amplitude accuracy = ± (0.5 dB + signal generator accuracy + mismatch error 
+ cable loss).

Assuming the Agilent receiver and Agilent 8648B signal generator 
specifications, with nominal values of mismatch and cable losses of 
approximately 1 dB, you can expect:

• Frequency reading, approximately: Frequency selected ±450 kHz
• Amplitude reading, approximately: Amplitude selected ±2.5 dB

NOTE You can save the settings of the project at any time. If you experience 
measurement or configuration problems, you can refer to the settings shown 
in the corresponding verification test.
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Method 1: Using a Signal Generator
Figure 4-3 Spectrum Display with Marker Set to a Center Frequency of 943 MHz 
(GSM900 band system)

Passing the Test

If the display shows a single spectral peak, and reports frequency and power 
levels that match the output of the signal generator, the system has passed the 
test.

Now continue with the “Method 4: GPS Measurement Verification 
Procedure” on page 4-18. If you are having problems with setting up these 
tests, refer to Chapter 5, “Solving Problems and Updating Your System” for 
additional information.
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Method 2: Measuring a Known Channel in the 
System

Preparing the Hardware

Figure 4-4 System Configuration for Measuring a Known Channel in the System

Do This Additional Information

1 Connect the system as shown in 
Figure 4-4.

The Agilent receiver requires a 30 minute 
warm-up period to meet the guaranteed 
specifications.

There is a three minute delay after power-up or 
re-configuration, before the internal temperature 
sensor is activated and measurements are 
nominally correct.

To connect the receiver and laptop, refer to step 1 
and step 2 of any of the procedures listed in 
Chapter 2, “Receiver-Based System Setup”

2 Turn on the Agilent receiver.
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Preparing the Software

Do This Additional Information

1 Start the application program by going to the Start menu. 
Select Programs, Agilent E74xx.

The software starts.

2 Create a new project called:
Verification Test 2 (Using the Antenna).

It is recommended that you use the 
automatic configuration wizard for this 
process. Refer to Chapter 2, “Automatic 
Configuration”.

3 Click Configuration and then add the receiver hardware. Refer to Chapter 2, “Hardware 
Installation Tips”

4 Click Collection and select the Spectrum VFP (Virtual 
Front Panel)

5 Click Maximize button in the upper-right corner of the 
main window. 

The display size increases to fill the 
available space.

6 Select either Frequency or Channel in the Frequency 
Units.

Frequency is displayed on the Spectrum 
VFP.

7 Set the measurement software as follows:

Band: Downlink
Frequency: User specified
Span: 2 MHz or 1 MHz depending on the channel used

Averaging: Running
Averages: 32

The frequency you specify and enter in 
the Center field, should be known 
communication frequency or channel.
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Testing the Signal

NOTE Wait for at least one minute before using the displayed marker value. The 
system is set to display a running average of 32. With time, the marker value 
will approach the value of the measured signal.

Passing the Test

If the signal trace is of an acceptable amplitude above the noise floor, 
depending on the distance from transmitters and antenna placement, at the 
appropriate frequency for the channel measured, the system passed the test.

Now continue with the “Method 4: GPS Measurement Verification 
Procedure” on page 4-18. If you are having problems with setting up these 
tests, refer to Chapter 5, “Solving Problems and Updating Your System” for 
additional information.

Do This See This

In the Markers group, click Add and To Max. The level and frequency are displayed at the 
top-left corner of the Spectrum display. 
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Method 3: Measuring the Noise Floor

NOTE Use this procedure only if you do not have a signal generator and there is no 
known channel in the system. Connect a 50 ohm load (customer supplied) to 
the input of the receiver.

Figure 4-5 System Configuration for Measuring the Noise Floor
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Preparing the Hardware

Do This Additional Information

1 Connect the system as shown 
in Figure 4-5 on page 4-13, using a 
calibrated 50Ω load fitted to the RF input.

The Agilent receiver requires a 30 minute 
warm-up period to meet the guaranteed 
specifications.

There is a three minute delay after power-up or 
re-configuration, before the internal temperature sensor 
is activated and measurements are nominally correct.

For more information on how to connect the receiver and 
laptop, refer to step 1 and step 2 of any of the 
procedures listed in Chapter 2, “Receiver-Based System 
Setup”

2 Turn on the Agilent receiver. 
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Preparing the Software

Do This Additional Information

1 Run the application program by going to the Start 
menu, selecting Programs, Agilent E74xx.

The software starts.

2 Create a new project called:
Verification Test 3 (Noise Floor).

It is recommended that you use the automatic 
configuration wizard for this process. Refer to 
Chapter 2, “Automatic Configuration”.

3 Click Collection and select the Spectrum VFP 
(Virtual Front Panel)

4 Click Maximize button in the upper-right corner of 
the main window. 

The display size increases to fill the available 
space.

5 Set the measurement software as follows:

Band: Downlink
Frequency: See Table 4-3 on page 4-16 for 
values to use.
Span: 300 kHz

Averaging: Running
Averages: 100

6 In the Markers group, click Add button then To 
Max and note the Marker 1 frequency and level. 

The level and frequency are displayed at the 
top-left corner of the Spectrum VFP.

7 In the Markers group, click Add to place a second 
marker on the display.

8 Use the mouse to drag Marker 2 to the minimum 
level of the trace. Note the Marker 2 frequency 
and level.
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Table 4-3 Noise Floor Frequency Settings for Step 5

Table 4-4 Noise Floor Frequency Settings for Step 11

9 Calculate the average noise level of the downlink. Average noise level = (Marker 1 level + Marker 2 
level) / 2

10 Select Uplink in the Band group. Frequency is displayed on the Spectrum VFP.

11  Perform step 6 through step 9 to determine the 
average noise level of the uplink. Substitute the 
frequencies from Table 4-4 on page 4-16 in 
step 5.

Average noise level = (Marker 1 level + Marker 2 
level) / 2

Model Marker 1 Frequency (step 5)

PCS CDMA and TDMA band systems 1959 MHz

GSM DCS1800 band systems 1843 MHz

GSM900 band systems 943 MHz

Cellular CDMA and TDMA band systems 882 MHz

Do This Additional Information

Model Marker 1 Frequency (step 11)

PCS CDMA and TDMA band systems 1879 MHz

GSM DCS1800 band systems 1745 MHz

GSM900 band systems 898 MHz

Cellular CDMA and TDMA band systems 837 MHz
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NOTE The measurement is making 100 averages, which will require approximately 
three minutes to stabilize the noise level. After completion, stop the 
measurement and note the levels.

Passing the Test

You have passed the if the average noise level is below –122 dBm.

Now continue with the “Method 4: GPS Measurement Verification 
Procedure” on page 4-18. If you are having problems with setting up these 
tests, refer to Chapter 5, “Solving Problems and Updating Your System” for 
additional information.
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Method 4: GPS Measurement Verification 
Procedure

NOTE If you have an Agilent digital receiver, make sure that you have tested the 
receiver using either method 1 (page 4-3), method 2 (page 4-10), or method 3 
(page 4-13) described earlier in this chapter.

It is recommended that you know the GPS position, the longitude and latitude, 
of where you do the test.

Setting Up the Hardware

Do This Additional Information

1 Connect the GPS receiver as shown in 
Chapter 2, “Setting Up Your System”.

Refer to the section specific to the GPS you own.

2 Click Configuration to review or modify the 
existing GPS hardware settings.

You switch to Configuration mode.

3 Select the Hardware tab. You can use the Automatic Configuration wizard to 
help set up the GPS attached to your system. For 
more information refer to “Automatic 
Configuration” on page 2-5

4 Highlight the appropriate GPS unit and click 
Modify.

You can now set the appropriate GPS protocol.

5 Use the information in Table 4-5 on page 4-19 
to establish the GPS protocol and serial port 
settings for your particular GPS unit.

The serial port settings are Trimble factory 
defaults. If you have difficulty determining your 
serial port configuration, contact Trimble 
Navigation.
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In order to configure any GPS unit, you have to know the settings of that unit. 
The default settings of the Trimble GPS units supported by Agilent have been 
included in the Agilent Wireless Solutions Software. New settings can be 
selected using Port Settings Tab of the Hardware Editor in Configuration 
Mode. See Table 4-5 on page 4-19 for the default settings.

Table 4-5 GPS Settings

Trimble Placer 
GPS/DR 

Trimble Placer 
GPS 400/ 
SVeeSix Plusa

a. The SVeeSix Plus GPS Unit is built by TRIMBLE to work only as TSIP, NMEA, or TAIP
according to the last 2 digits of the part number:XXXXX-61 is TSIP only; XXXXX-62 is NMEA
only; XXXXX-63 is TAIP only. Verify first what protocol is used, to find out the default settings
of that unit.

Trimble Placer
GPS 455 

Internal GPS 
(Trimble Placer 
Model SK-8) or 
SVeeSix Plus

Protocol TAIP TAIP TAIPb

b. The GPS 455 unit can work as TAIP or TSIP. By default it is configured as TAIP. If you want the
unit to work as TSIP, you must set the GPS 455 to TSIP.

TSIP

Bits per Second 4800 4800 9600 9600

Data Bits 8 8 8 8

Parity None None None Odd

Stop Bits 1 1 1 1

Flow Control None None None None
Wireless Solutions Getting Started Guide 4-19



Chapter 4: Verifying the System
Method 4: GPS Measurement Verification Procedure
Selecting the Test

NOTE If the GPS receiver is configured for TAIP or NMEA, you can not see the 
satellite bar chart.

Do This Additional Information

1 Start the application program by going to the 
Start menu, select Programs, Agilent E74xx.

The software starts.

2 Create a new project called:
Verification Test 4 (GPS).

The Measurement or Hardware configuration is 
shown.

You can use the Automatic Configuration wizard to 
help set up the GPS receiver. For more 
information, refer to “Automatic Configuration” on 
page 2-5 

3 Click Collection and select the GPS VFP 
(Virtual front Panel).

4 Select measurement types: Satellites or 
Statistics

Assuming the GPS antenna is properly located 
and the GPS receiver has a fix, the current location 
parameters, such as latitude, longitude, velocity, 
and altitude are displayed as shown in Figure 4-6.
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Method 4: GPS Measurement Verification Procedure
Figure 4-6 GPS Virtual Front Panel Display

NOTE The units used for displaying the GPS statistics can be changed using the 
Display controls on the GPS virtual front panel.

If you need to change the GPS coordinate datum, select the Advanced tab of 
GPS hardware configuration box. The default datum can be set using the 
Tools > Options and selecting the Default Datum tab.
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Passing the Test

If the display shows a clear set of satellite signals and reports the same 
longitude and latitude of your current location, the system passed the GPS test 
and is ready to be used.

Figure 4-6 on page 4-21 shows an example of what a typical GPS display 
should look like.

If you are having problems with setting up these tests, refer to Chapter 5, 
“Solving Problems and Updating Your System” for additional information.
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What You’ll Find in This Chapter
What You’ll Find in This Chapter

To Do This See This

Troubleshoot resource problems. “Resource Problems” on page 5-3.

Troubleshoot COM errors. “COM Errors” on page 5-4. For more information 
refer to Chapter 2, “Setting Up Your System”.

Troubleshoot GPS problems. “Locating and Eliminating GPS Errors” on 
page 5-8. For more information refer to 
Chapter 2, “Setting Up Your System”.

Update the software. “Updating the Software” on page 5-11.

Update the firmware. “Updating the Firmware” on page 5-12.

Get telephone assistance. “Calling for Assistance” on page 5-14.

Return an Agilent Technologies instrument for 
service.

“Returning the Instrument for Service” on 
page 5-17.
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Troubleshooting Resource Problems, COM 
Errors and GPS Problems

Resource Problems

CAUTION It is possible to exceed Windows 95/98 allocated resource levels by opening 
too many windows while running your Wireless Solutions system. This will 
cause erratic behavior of the application and require the operator to reboot the 
operating system in order to recover. This will also corrupt an open Wireless 
Solutions database, with potential loss of data. Windows 95/98 will not 
display any warning or feedback when this occurs.

The number of allowable open windows is dependent on the types you 
choose, as different windows require varying amounts of Windows 95/98 
resources. The maximum number of windows is approximately 12, although 
up to 14 can be opened in certain configurations.

To provide the maximum amount of available Windows 95/98 resources to the 
measurement application, it is strongly recommended that you close all other 
applications before running the Wireless Solutions software. This includes all 
applications found in the Startup folder. It is also recommended that you run 
the Windows 95/98 resource meter in a minimized configuration in order to 
monitor available remaining resources. 

To start the Windows 95/98 resource meter

1. Choose Start > Programs > Accessories > System Tools > Resource Meter. 
The Resource Meter dialog box appears.

2. Click OK.
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While this application utilizes system resources, it provides a way of 
determining when the system is running low on available resources. Opening 
new windows with less than 20% remaining resources in any of the three 
categories could cause Windows 95/98 to overrun its resources.

One solution for increasing the potential number of measurements made in a 
given project without exceeding Windows 95/98 resources is to configure the 
measurement with the associated virtual front panel turned off. You will be 
able to record the data but not display it. This can be done in Configuration 
mode, under the Display/Logging tab found under the Measurement tab. 

The only solution for increasing the number of windows available during a 
measurement is to use Windows NT. It does not have the same systems 
resource limitations as Windows 95/98. 

NOTE While using option 160, real time mapping, operating with a 256-color 
display setting may cause erratic behavior or memory problems. Adjust your 
color display to High Color (16 bit) or higher.

COM Errors

The following procedure is suggested for locating and eliminating COM 
errors when using the Agilent Wireless Solutions system.

NOTES • To ensure that hardware is configured correctly, it is highly recommended 
that you use the Automatic Configuration Wizard for setting up your 
projects. for more information on the auto-configure process, refer to 
“Automatic Configuration” on page 2-5

• You must create the verification tests in chapter 4 as projects prior to 
troubleshooting COM errors.
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NOTE COM Errors may occur if the SAGEM phone is not set in the correct 
operating mode. The correct mode is TRACE.

When the SAGEM phone is in DATA mode, the interface connection is used 
for transmitting fax and other data transmission types. When the SAGEM 
phone is in TRACE mode, the interface connection is used for transmitting 
measurement reports.

To change the mode, switch on the phone and use the following phone 
keystrokes:

• [Menu], [44], Down Arrow, [#], [8]

• Use the up and down arrows to select TRACE mode, then select OK.

Do This Additional Information

1 Check the project and configuration being 
used by the application.

• Does the hardware configuration for the 
project selected match the actual system 
hardware?

• Are the correct GPS receiver model number, 
protocol, COM port selection, and port 
settings shown in Configuration mode on the 
Hardware tab?

• Is the correct coordinate datum being used?

• Is the correct Agilent receiver model number 
and COM port selection shown in 
Configuration mode on the Hardware tab?

• Are the correct phone model number and 
COM port selection shown in Configuration 
mode on the Hardware tab?

2 Check system hardware components. • Is DC power provided to the Agilent digital 
receiver?

• Is the null modem cable connected between 
the PC and the Agilent digital receiver?
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Do This Additional Information

2 (Continued) Check system hardware 
components.

• Is DC power provided to the GPS receiver 
(external GPS)?

• Is the proper RS-232 cable, or cable 
assembly, connected between the GPS 
receiver and Agilent E645x receiver 
(external GPS)?

• Is the GPS receiver functioning with the 
correct GPS antenna connected, and 
providing a 3-D fix?

• Is the correct cable connected between the 
GPS receiver and the PC (phone-based 
system)?

• Is the phone turned on and does the battery 
show sufficient power (phone-based system)?

• Is the interface cable connected between the 
phone and the PC (phone-based system)?

• Is the second COM port defined and 
functioning (phone-based system)?

3 Troubleshoot COM errors. • Verify steps 1 and 2 are true.

• Check the Agilent E645x receiver by selecting 
Verification Test 1, 2, or 3 project and 
confirm no COM errors by going to Collection 
mode and viewing the Spectrum virtual front 
panel.

• Check the GPS receiver by selecting 
Verification Test 4 project, choosing the 
correct GPS receiver model number, protocol, 
COM port settings and confirm no COM errors 
by going to Collection mode and viewing the 
GPS virtual front panel.

• Check the phone by defining a new project 
with only the correct phone model number 
and COM port selection, then going to 
Collection mode and viewing the Phone 
Measurements virtual front panel (phone-
based system).
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Do This Additional Information

3 (Continued) Troubleshoot COM errors. • If the previous steps are not successful, refer 
to the GPS Problems section, “Locating and 
Eliminating GPS Errors” on page 5-8, or refer 
to Trimble utilities for more information.

• Check the RS-232 interface cable between 
the PC and Receiver.

• If the RS-232 connection between the 
Receiver and PC is bad (broken or damaged 
cable or connectors) or communication is 
broken, then the error displayed will indicate 
that the Receiver may be in fault. Check the 
RS-232 cable or replace it. If the fault persists, 
contact Agilent Technologies.
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Locating and Eliminating GPS Errors

There is no way to communicate with the GPS receivers if the port settings are 
unknown. It is strongly recommended that you write down ALL GPS receiver 

4 If all else fails. • Define a new project, checking on all items 
listed in steps 1 and 2.

• Use a different database by selecting File > 
Open Database, or creating a new database 
by selecting File > New Database, then 
defining a new project, checking on all items 
listed in steps 1 and 2.

• Repair the existing database by creating a 
new database, then using Tools >Database 
Utilities > Repair to open the original 
database (usually data.mdb). Once 
repaired, return to the original database by 
selecting File >Open Database with the 
original file name. Select the original project, 
checking on all items listed in steps 1 and 2.

• Use a brand new database. Using Windows 
Explorer, copy the file Design.mdb found 
in the working directory for the application 
(usually \Program Files 
\Agilent Technologies 
\E74xx), to a new file name then repeat 
step 4.

• When nothing else works, re-install the 
application. Copy the database in question to 
another location. Uninstall the current 
installation of the application by using the 
Add/Remove Program application, found in 
the Control Panel under Start > Settings. 
Once the application has been uninstalled, 
re-install the application.

Do This Additional Information
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settings and tape the list to the unit. The primary cause of COM errors 
between the PC and the GPS receiver is usually incorrect port settings. 

The following procedure is suggested for locating and eliminating GPS errors 
and problems when using the Agilent Wireless Solutions system.

Do This Additional Information

1 Check hardware connections (verify cabling 
and power supply).

If you have hardware configuration errors and/or 
communications errors, exit the Agilent Wireless 
Solutions Software. Cycle the power on the GPS 
receiver and the Agilent E645x receiver, then 
check both RS-232 connections and DC 
connections. Run the Agilent Wireless Solutions 
Software again.

2 Start the Agilent Wireless Solutions Software, 
select your project, select Collection mode, 
and note what error messages occur.

If there are no error messages, the hardware 
connections are OK. Skip to step 3.

If there are error messages, write them down 
and review the entire Troubleshooting section. If 
you are unable to resolve the error messages, 
refer to “Calling for Assistance” on page 5-14.

There are three main messages when something 
is wrong:

• Hardware Error

• Application Error

• Communications Error

If there is an application error, it is likely that the 
GPS receiver configuration in the Hardware 
Editor of the configuration is different than the 
actual settings of the Trimble GPS receiver.

A common error is “Application Error: Failed to 
read serial device. Please make sure the 
hardware configuration is correct and the 
hardware is connected and turned on. Device = 
COM 1”. 
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Do This Additional Information

4 (Continued) Verify the GPS configuration. • Verify that the Hardware Type (for example, 
GPS Placer 450, 455: TAIP) is selected. If 
not, select the correct model and protocol 
in the Hardware Type field.

• Review the settings specific to the GPS 
receiver used. If the settings are wrong, 
correct them. 

• For port selection, if the GPS receiver is 
connected to the Agilent E645x receiver 
through the GPS RS-232 port, select 
Multiplexed Serial. If the GPS receiver is 
connected directly to the computer (and the 
Agilent E645x receiver is not used) select 
Serial.

• COM 1 is the default serial port, but if a 
different serial port is used with the 
Agilent E645x receiver, select the correct 
COM port.

• For port settings, if the protocol of your 
GPS receiver is known and the default 
settings are used, nothing needs to 
change. But if the GPS receiver has been 
configured to work with Qualcomm’s Mobile 
Diagnostic Monitor (MDM), it is very likely 
that it is set as: TAIP and 4800 bps. 
Change the bps to the correct speed 
(usually, other parameters will not need to 
change, but be sure to verify them against 
the known hardware settings).

• When all port selections and port settings 
have been configured to the settings of the 
GPS receiver, click OK in the Hardware 
Editor. The Agilent Wireless Solutions 
Software should be ready to successfully 
communicate with the GPS receiver. Select 
Collection mode and repeat step 3.
5-10 Wireless Solutions Getting Started Guide



Chapter 5: Solving Problems and Updating Your System
Updating the Software
Updating the Software

Software updates are available to download from the web. Your computer 
must be web-enabled to perform this process: you must have a modem or 
LAN access to the web, a service provider, and a web browser. If you are set 
up to access the web, go to the following web site for information about 
software updates:

http://agilent.com/find/software

Then click on the Wireless Software Updates and Firmware Upgrades link.

NOTE If you are unable to access the web, contact your Agilent Technologies 
representative for information about updating the software.
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Updating the Firmware

Sometimes a software update (see “Updating the Software” on page 5-11) 
also requires a firmware update. With the software update installed, when
run the updated software and select Collection mode, you will be notified
firmware update is required. A series of messages will walk you through 
firmware update process. Before you update the firmware, you must first 
insert a firmware write enable key (E6450-60007) into the RX LOOP OUT
connector, as shown in Figure 5-1, then follow the instructions on the screen
Remember to remove and safely store the firmware write enable key whe
you are prompted to do so by the software.

Figure 5-1 Firmware Write Enable Key
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Replacement Firmware Security Key

If you have misplaced your firmware write enable key, you can order a new 
one (order from your Agilent Technologies representative, E6450-60007), or 
you can substitute a piece of wire that shorts pins 8 to 10 on the RX LOOP 
OUT connector (see Figure 5-2). Remember to follow on screen instructions, 
and remove the wire when you are prompted by the software.

Figure 5-2 Short These Pins to Update the Firmware

Details on this process can be found on the product web site:

http://agilent.com/find/software

Then click on the Wireless Software Updates and Firmware Upgrades link.
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Calling for Assistance

Your Agilent Wireless Solutions are designed to provide dependable service. 
It is unlikely that you will experience a problem. However, 
Agilent Technologies sales and service organization is ready to provide the 
support you need.

The Agilent Technologies web site provides very detailed lists of frequently 
asked questions, which address the most commonly encountered problems. It 
is highly recommended that you search these questions before contacting 
Agilent Technologies.

If You Have a Problem

If you have a problem, refer to the following for possible help:

• This guide
• Online help
• Online tutorial

If you are unable to resolve your problem, refer to the information in the 
following section.

NOTE For continued protection against fire hazard, replace the line fuse (cigarette 
lighter/2 amp 32 V FB fuse, Agilent part number 2110-0002) only with the 
same type of rating (type nA/nV). The use of other fuses or materials is 
prohibited.
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Frequently Asked Questions

If you need installation or application assistance, refer to the web site at

http://agilent.com/find/drive_test.

To access the frequently asked questions section, use the following procedure:

1. Click on the Technical Support link.

2. Select the Frequently Asked Questions - Search

3. For the Search key, type the keyword "drive test"

If you do not have access to the web, contact your local Agilent Technologies 
representative for information.

Technical Telephone Assistance

Your Agilent Wireless Solutions come with 12 months of technical telephone 
assistance and a 12 month hardware warranty period. To use the telephone 
assistance:

1. Install the software.

2. The Customer Business Center will provide you with a packet of 
information, which includes your system handle number. Please refer to 
that number when calling for support.

To establish a Support Contact, please call the Customer Business Center. 

3. Ask the Agilent Technologies engineer your question.
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Numbers to call

For a more detailed list of contact numbers, please refer to the Agilent web 
site, or contact your local Agilent Technologies Sales and Service Office.

Before calling, ensure you have all the information described in step 2, above.

Region Phone Number

Americas +1-800-698-0061, press 3

Asia, Australasia +65 271 0915

Europe, Africa, Middle East +31 20 547 9900
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Returning the Instrument for Service

The instructions in this section show you how to properly package the 
instrument for return to Agilent Technologies. 

Warranty

If the instrument is still under warranty or is covered by an 
Agilent Technologies maintenance contract, it will be repaired under the 
terms of the warranty or contract (the warranty is at the front of this manual). 
If the instrument is no longer under warranty or is not covered by an 
Agilent Technologies maintenance plan, Agilent Technologies will notify you 
of the cost of the repair after examining the unit.

When an instrument is returned to Agilent Technologies for servicing, it must 
be adequately packaged (see “Preparing the Instrument for Shipping” on 
page 5-18) and have a complete description of the failure symptoms attach

When describing the failure, please be as specific as possible about the n
of the problem. Include copies of additional failure information (such as 
instrument failure settings, data related to instrument failure, and error 
messages) along with the instrument being returned. 

Please notify Agilent Technologies before returning your instrument for 
service. Any special arrangements for the instrument can be discussed a
time. This will help Agilent Technologies repair and return your instrument
quickly as possible. 
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Preparing the Instrument for Shipping

Do This Additional Information

1 Write a complete description of the failure and 
attach it to the instrument.

Include any specific performance details related 
to the problem. The following information should 
be returned with the instrument:

• Type of service required

• Date instrument was returned for repair

• Description of the problem:

• Whether problem is constant or intermittent

• Whether instrument is temperature-sensitive

• Whether instrument is vibration sensitive

• Instrument settings required to reproduce the 
problem

• Error Code

• Performance data

• Company name and return address

• Name and phone number of technical contact 
person

• Model number of returned instrument

• Full serial number of returned instrument

• List of any accessories returned with the 
instrument

2 Cover all front and rear panel connectors that 
were originally covered when you first 
received the instrument.

3 Pack the instrument in the original shipping 
containers. Original materials are available 
through Agilent Technologies office. See step 
4 for more information.
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CAUTION • Cover electrical connectors to protect sensitive components from 
electrostatic damage.

• Instrument damage can result from using packaging materials other than 
the original materials. Never use styrene pellets as packaging material. 
They do not adequately cushion the instrument or prevent it from shifting 
in the carton. They may also cause instrument damage by generating 
static electricity. 

4 Wrap the instrument in antistatic plastic to 
reduce the possibility of damage caused by 
electrostatic discharge.

• For instruments weighing less than 54 kg 
(120 lbs), use a double-walled, corrugated 
cardboard carton of 159 kg (350 lbs) test 
strength.

• The carton must be large enough to allow 3 to 
4 inches on all sides of the instrument for 
packing material, and strong enough to 
accommodate the weight of the instrument.

• Surround the equipment with 3 to 4 inches of 
packing material, to protect the instrument 
and prevent it from moving in the carton. If 
packing foam is not available, the best 
alternative is S.D-240 Air Cap from Sealed 
Air Corporation (Commerce, California 
90001). Air Cap looks like a plastic sheet filled 
with air bubbles. Use the pink (antistatic) Air 
Cap to reduce static electrical damage. 
Wrapping the instrument several times in this 
material will protect the instrument and 
prevent it from moving in the carton.

5 Seal the carton with strong nylon adhesive 
tape and mark it “FRAGILE, HANDLE WITH 
CARE”.

6 Retain copies of all shipping papers.

Do This Additional Information
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What You’ll Find in This Chapter
What You’ll Find in This Chapter

To Review Go To

General Software Specifications and Functionality “General System Software Specifications 
and Functionality” on page 6-4

CDMA

Agilent E7473A Cellular and PCS CDMA 
Wireless Solutions Software Measurement 
Specifications

“Software Measurement Specifications” on 
page 6-14

Agilent E7490A Over Air Maintenance Test 
Software Measurement Specifications

“Software Measurement Specifications” on 
page 6-25

Agilent E7473A and Agilent E7490A Cellular and 
PCS CDMA Wireless Solutions Hardware 
Specifications

“Hardware Specifications” on page 6-30

TDMA

Agilent E7474A Cellular and PCS TDMA 
Wireless Solutions Software Measurement 
Specifications

“Software Measurement Specifications” on 
page 6-34

Agilent E7474A Cellular and PCS TDMA 
Wireless Solutions Hardware Specifications

“Hardware Specifications” on page 6-45

GSM

Agilent E7475A GSM900, DCS1800, GSM1900 
Software Measurement Specifications

“Software Measurement Specifications” on 
page 6-49

Agilent E7475A GSM900, DCS1800, GSM1900 
Hardware Specifications

“Hardware Specifications” on page 6-64

General Hardware Specifications and Minimum 
System Requirements

“General Hardware Specifications and 
Minimum System Requirements” on 
page 6-68
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Specifications and Hardware Information

This chapter lists specifications and characteristics of the systems. 
Specifications apply over the temperature range 0°C to +55°C (unless 
otherwise noted) after the temperature of the Receiver has been stabilized by 
30 minutes of continuous operation. 

Specifications Describe warranted performance over the temperature range of 0°C to +55°C 
and include a 30 minute warm-up from ambient conditions.

Typical Provides useful information by giving non-warranted performance 
parameters. Typical refers to test data at the fiftieth percentile for a 25°C roo
temperature.

Characteristics Provide useful information by giving non-warranted performance paramet
Characteristics information describes product information for parameters
are either not subject to variation, non-measurable, verifiable through 
functional pass/fail tests, or as a matter of routine, not measured. 
Characteristics are printed in italics.

Calibration Cycle Agilent Technologies warrants instrument specifications over the 
recommended calibration interval. To maintain specifications, periodic 
recalibrations are necessary. We recommend that the Receiver be calibra
an Agilent Technologies service facility every 12 months.
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General System Software Specifications and 
Functionality

Some of the functionality of the system is common across all platforms. The 
following sections describe the specifications and functionality of these 
cross-platform features.

• “Data Export” on page 6-4
• “Alerts and Alarms” on page 6-8
• “Link Editor” on page 6-10
• “Real-time Mapping (Option 160)” on page 6-11
• “Report Generation” on page 6-11
• “Virtual Front Panel Printing” on page 6-12
• “Indoor Measurements (Option 180)” on page 6-13

Data Export

Data can be exported from the Wireless Solutions database for display a
post-processing. Any measurement data can be exported. The export fun
provides flexible filtering capability to define the specific data to be export
Multiple data types can be exported to a single output file.

You can save export plans, and once saved, those plans can be quickly 
accessed for easy data export. An export plan is made up of:

Export Plan Element Description

Data types Defines which data will be exported. Column order is user-definable.

Alarms Defines which alarms will be exported.

Notes Exports any user note or auto-note entered while recording data
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Several different operations can be executed in order to provide the desired 
data in the desired format.

Processing functions

• All values
• Count - counts number of values above or below a specified threshold
• Maximum
• Minimum
• Value(x)

Conditionals

• Greater than (>) a threshold
• Less than (<) a threshold
• All values
• Qualified against another measurement

Sorting

• Ascending
• Descending
• None

Geographic binning methods

• Bin size
User defines the size of bin to be used in meters.

• Percentage of low and high values to discard
User defines the percentage of values to ignore from new raw 
data before calculating the bin.

Processing functions Defines the functions that will be applied to the data during export.

Exclusion rules Defines a set of conditions that, if true, the associated data will be 
excluded from the export.

Geographic binning Data-reduction process in which the data is averaged based on 
geographic area or distance

Export Plan Element Description
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• Bin by location (grid binning)
Define the reference bin to be used, choices are:

• Southwest extent of drive data
• Southeast extent of drive data
• Northwest extent of drive data
• Northeast extent of drive data
• User-defined reference coordinates

• Bin by distance travelled (linear binning)
Data is averaged based on the distance traveled.

Data Output Formats

The output formats supported by the Wireless Solutions are listed below. The 
system is designed to work with MapInfo®1 in an integrated manner via an 
OLE (object link embedded) link to the MapInfo application (MapInfo via 
COM). This exports the data, launches MapInfo, creates the necessary 
MapInfo table, and creates a thematic map display in MapInfo. This 
functionality does require MapInfo be present.

• Arcview®2 compatible file
• MapInfo via COM (optional - run MapBasic program after export)
• MapInfo compatible file
• PlaNET ®3 compatible file
• Text file

Export Column Data Delimiters

• Tab
• Comma

1. MapInfo® is a registered trademark of MapInfo Corp. 

2. ArcView ® is a registered trademark of Environmental Systems Research 

Institute, Inc.

3. PlaNET ® is a registered trademark of Mobile Systems International.
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Optional Data parameters

• Position
• Altitude
• Time
• Date
• Fill column data
• Column headings

Position Formats

• Decimal degrees with direction
• Deg: Min: Sec with direction
• Signed decimal degrees
• Signed Deg: Min: Sec with direction
• UTM (Universal Transverse Mercator)

Coordinate Datums

It is possible to change to the coordinate datum being applied by the 
application. It can be changed either during the configuration or export stages.

The following datums are available:

• AGD66
• AGD84
• European
• Hu-Tzu-Shan
• NAD27 (default) (North American)
• NAD83 (North American)
• OS36 (GB)
• SAD69 (Brazil)
• SAD69 (Mean)
• Tokyo (J6)
• Tokyo-Korea
• WGS72 (World Geodetic System)
• WGS84 (World Geodetic System)
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Integrated Mapping Software

MapInfo can be run from within the system software. The system can also 
export data in ASCII format. The data can then be imported into other 
applications.

The system can also run with Agilent E7480A (CDMA only) Post-processing 
software. The Agilent E7480A is an optimization and performance-monitor-
ing tool designed to process large amounts of collected data to simplify the 
task of optimization. The Agilent E7480A provides the ability to analyze one 
or multiple drives at a time through either separate maps, or together in a 
merged format.

Alerts and Alarms

The Wireless Solutions Software has sophisticated alert and alarm 
capabilities. An alert is defined as a single condition on a single measurement. 
An alarm is a boolean expression made up of single or multiple conditions on 
single or multiple measurements. When an alert or alarm condition occurs, 
any, or all, of the actions listed below can be executed. If the alert or alarm 
condition occurs, while data is being logged, each data record includes the 
alert/alarm information.

Alarm Wizard

The alarm wizard can be used to simplify setting up some of the more 
common alarms.

Features of the Alarm Wizard Set up

• Specify type of alarm required
• Notification of new or changed measurements
• Notification of resources required
• Customize settings, actions and other user-definable aspects
• Set of default Male and Female voice alarm messages
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Actions (Alarms and Alerts)

• Play a .WAV audio file
• Display a text message
• Pause or stop measurements

Alert Conditions

• Greater than (>)
• Greater than or equal to (≥)
• Less than (<)
• Less than or equal to (≤)
• Equal to (=)
• Not equal to (≠)

Alert Operators

• Value
• Maximum
• Minimum

Alarm Conditions

• Greater than (>)
• Greater than or equal to (≥)
• Less than (<)
• Less than or equal to (≤)
• Equal to (=)
• Not equal to (≠)
• Is a subset
• Is not a subset
• Sets intersect
• Sets do not intersect

Alarm Operators

• Value
• Maximum
• Minimum
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• Subset
• OR
• AND
• XOR (exclusive OR)

Any measurement can be an operand in an alert or alarm. Below are some 
examples (Agilent E7473A CDMA system example shown) to illustrate alerts 
and alarms. In example number four, the alarm triggers when the receiver 
measures a pilot signal above -18 dB Ec/Io that the handset does not measure. 
This provides very quick identification of neighbor list problems.

• Alerts
1.Value(FER) > 2.0%

2. Maximum(TopN Eo/Io) < -10 dB

• Alarms
3. (Value(FER) > 2.0%) AND (Maximum(TopN Ec/Io)< -10 dB)

4. Subset(Pilot Multipath Top N) NOT Subset (Value PNList)

System status parameters can also be used as operands in alerts and alarms. 
For example, an alert can be defined to trigger when the available disk space 
on the PC drops below 10 MB or when the GPS position fix is lost.

Link Editor

The Link Editor is available from the Tools menu and enables you to link 
controls in one virtual front panel (the source) with parameters in another 
virtual front panel (the destination). Links can be configured from either 
Configuration mode or Collection mode. You can:

• Link simple measurement results to parameters for other measurements.

• Link measurement parameters to parameters for other measurements.

• Invoke an action (such as a button click) on all virtual front panels of the 
same type.

• Invoke an action (such as a button click) on a select set of virtual front 
panels of the same type.
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Real-time Mapping (Option 160)

Using the GPS virtual front panel, you can display vector and raster-based 
maps against a real-time, plotted measurement result. The following features 
are available: 

• Load and control map layers (TAB format).

• Add raster maps (GIF, TIF, and PNG format).

• Zoom in and Zoom out of map detail.

• Pan automatically and manually.

• Scale automatically.

• Add labels and identify points.

• Display alarms on map. Click on alarm symbol to display the message 
associated with the alarm.

• Link a measurement result, via the link editor for display on the map.

• Map result values controlled via the Legend button in color. Pre-defined 
Legends exist for most common measurement results.

• Specify base stations in StationInfo.txt are displayed on the map.

• Link the active server for a phone to the map and draw a line from the 
current position to the appropriate base station.

Report Generation

The report generator is accessed using the Tools > New Report (Ctrl+R) menu 
option, or by clicking the report generator button in Collection mode. The 
reports generated are in HTML format with referenced images, which are 
captured in PNG format. The reports and images are stored in the report folder 
(C:\Program Files\Agilent Technologies\E74xx\Reports\reportname\). The 
following details can be entered by the user:

• Title (also used for the report folder name)
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• User name

• Company name

• Time report generated. By default, this is the PC system time.

• Date. By default, this is the PC system date.

• Location. By default, these are the GPS coordinates identified at the time 
the report was generated.

• Comments. This is optional text, entered by the user.

• A report can include all opened Virtual Front Panels, or just those 
maximized.

• A report may also contain textual and/or table information for specific 
measurements like the CDMA Code Domain Power, Base Station 
Spectrum Analyzer, and MOST.

Once the report has been generated, it is displayed on the screen, using your 
default browser. A report can include multiple virtual front panels. Reports 
can be viewed by selecting the Reports tab while in Configuration mode. 
Reports can be imported and exported.

Virtual Front Panel Printing

It is possible to print virtual front panels. This feature is accessed from the 
File menu. There are two print commands:

• Print (Ctrl+P) prints the active and all other virtual front panels.

• Print VFP prints just the active virtual front panel.

The active virtual front panel is the window with the blue title bar (if default 
windows colors are used).
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Indoor Measurements (Option 180)

The Agilent Wireless Solutions Software can be used for testing and 
measuring indoor coverage areas. These measurements are taken without 
reference to GPS or dead-reckoning position information.

An indoor system supports the following hardware:

• Phones

• Receivers (no PN correlation for CDMA)

• Pen tablet computer

• Computer pen input devices.

• Full set of backpack accessories.

• Portable power supply for computer and receiver.

The measurement control virtual front panel has the following features:

• Selection of data points, such as user features like CW sources

• Automatic interpolation of data between waypoints, during recording.

• Imported maps converted to layer map files. Supports GIF, TIF, and PNG 
formats.

• Way point information for specifying when measurements are to be taken.

• Zoom in and zoom out of map area.

• Automatic and manual pan.

• Automatic scaling.

• Display alarms on map. Click on alarm symbol to display the message 
associated with the alarm.

• Link measurements to display.

• Map result values controlled via the Legend button in color. Pre-defined 
Legends exist for most common measurement results.
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Agilent E7473A CDMA System Specifications

Software Measurement Specifications

The Agilent E7473A measurement software has the following measurement 
capabilities and functionality:

• “CDMA Pilot Channel Analysis” on page 6-14
• “CW Power Measurements” on page 6-17
• “Channel Power Measurements” on page 6-18
• “Spectrum Measurements” on page 6-19
• “CDMA Phone Call Control” on page 6-21
• “CDMA Phone Measurement Data” on page 6-23
• “CDMA Phone Messaging” on page 6-24
• “CDMA Code Domain Power (CDP) Analysis” on page 6-25
• “CDMA Base Station Spectrum Analysis” on page 6-27
• “CDMA Mobile Station Test Measurement (MOST)” on page 6-28

CDMA Pilot Channel Analysis

Part of Agilent E7473A Option 110, 120.

The Agilent E7473A system is capable of measuring IS-95 and J-STD-00
CDMA pilot channels using the Agilent digital receiver. These measureme
are independent of network parameter settings. The system executes fou
different types of CDMA pilot channel measurements (listed below). Any 
all of them can be executed simultaneously. 

Measurement Types

• All pilots
The System measures the power, both Ec and Ec/Io for all 512 
pilot channels. The results are displayed as a trace with one point 
for each of the 512 PN offsets.
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• Top N
The system measures all of the pilots in the network and returns 
the ‘N’ Strongest pilot channels received, where ‘N’ is a user 
definable integer from 1 to 20. The results are displayed in ba
graph format.

• Zoomed pilots
The user sets the center and span in terms of chips (or 
PN offsets). The results are displayed as a trace.

• User list
The user manually inputs a list of up to 20 PN offsets to be 
measured. The measurements are displayed in a bar graph format. 
The user list frequencies can be imported from a text file. This 
allows regularly used sets of frequencies or channels to be stored 
for quick loading into the application.

Measurement Controls

• Carrier frequency
❍ Frequency
❍ Channel

• Measurement types
❍ All pilots
❍ TopN pilots
❍ Zoomed pilots
❍ User list of pilots

• PN increment

Markers (Trace Displays only)

• Multiple markers
• Delta markers
• To Max function
• Drag and drop
• Marker to center

Display Controls

• Power display (Y-axis parameter)
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❍ Ec/Io
❍ Ec

• Show value (bar graphs only)
❍ Peak Ec/Io
❍ Peak Ec
❍ Aggregate Ec/Io
❍ Aggregate Ec
❍ Aggregate - Peak
❍ Delay Spread(Chips)
❍ Pilot delay (Chips)

Measurement Results

• Peak Ec/Io
• Peak Ec
• Io
• Aggregate Ec/Io
• Aggregate Ec
• Aggregate - Peak
• Delay spread
• Pilot delay
• Carrier frequency error

Peak pilot power (both Ec and Ec/Io) are computed by selecting the 
strongest peak of the correlation for each pilot. Io is the total received power 
integrated across the entire 1.2288 MHz signal bandwidth.

Aggregate pilot power (both Ec and Ec/Io) are computed for a given pilot 
by integrating the power received over the time dispersion of that pilot. Delay 
spread is the duration of time over which this power is dispersed. Both 
aggregate pilot power and delay spread are determined with respect to an 
Ec/Io threshold of -17 dB. The system also reports the difference between the 
aggregate and peak pilot power (Aggregate-Peak). This difference along with 
the delay spread provides a characterization of the multipath effect on that 
pilot.

Pilot delay is defined as the difference in time between when a pilot signal is 
received and when it should have been transmitted, as defined by GPS timing. 
For example, a base station transmitting PN offset 0 is expected to start a new 
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short-code pattern synchronous with the GPS even second clock. If the signal 
is received 3 chips after the GPS even second clock, then the pilot delay is 
said to be 3 chips (1 chip = 0.8 microseconds). Timing offsets can be due to 
both propagation delay and base station timing problems. 

Carrier Frequency Error is defined as the difference between the measured 
carrier frequency and the user specified carrier frequency. The measured 
carrier frequency is of the dominant pilot signal. Carrier frequency error can 
be due to both base station carrier error and doppler shift (if moving).

CW Power Measurements

Part of Agilent E7473A Option 110, 120.

The Agilent E7473A can measure the peak power (CW Power) at user defined 
frequencies within a user-defined resolution bandwidth. The user can define 
the frequencies to be measured in two different ways.

Frequency Entry Methods

• List: Enter an arbitrary list of frequencies. The user list frequencies can 
be imported from a text file. This allows regularly used sets of frequencies 
or channels to be stored for quick loading into the application.

• Trace: Enter a start frequency, step size, and count. The system measures 
at the start frequency, at the (start + step) frequency, (start + (count - 
1)*step frequency. For example, if the start frequency is set to 1900 MHz, 
the step size is set to 1 MHz, and the count is set to 4; then measurements 
are made at 1900 MHz, 1901 MHz, 1902 MHz, and 1903 MHz. 
Frequencies can be specified in terms of frequency units or channel 
number.

Measurement Controls

• Frequency 
❍ Arbitrary list (list)
❍ Start/step/count (trace)

• IF Bandwidth
❍ Wideband mode - 1.25 MHz
❍ Narrowband mode - 30 kHz or 200 kHz (options 390 and 391 only)
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• Resolution Bandwidth (CW power, all other options)
❍ 8.36 kHz to 1 MHz in wideband mode
❍ 246 Hz to 28 kHz in narrowband mode

• Resolution bandwidth (CW power, Option 390 and 391 only)
❍ 8.36 kHz to 950 kHz in wideband mode
❍ 1.68 kHz to 190 kHz in narrowband mode

Channel Power Measurements

Part of Agilent E7473A Option 110, 120.

The Agilent E7473A system can measure the total power (Channel Power) 
within a user-defined bandwidth at a user-defined set of frequencies. This 
differs from the CW power measurement in that the total power is integrated 
across the specified channel width. The user can define frequencies to be 
measured in two different ways.

Frequency Entry Methods

• List: Enter an arbitrary list of frequencies. The user list frequencies can 
be imported from a text file. This allows regularly used sets of frequencies 
or channels to be stored for quick loading into the application.

• Trace: The power virtual front panel can be used to quickly diagnose RF 
problems. The system operates in both the downlink and uplink PCS 
bands. Enter a start frequency, step, size and count. The system measures 
at the start frequency, at the (start + step) frequency,..., (start + (count - 
1*step) frequency. For example, if the start frequency is set to 1900 MHz, 
the step size is set to 1 MHz, and the count is set to 4; the measurements 
are made at 1900 MHz, 1901 MHz, 1902 MHz and 1903 MHz.

Frequencies can be specified in terms of frequency units or channel number.

Measurement Controls

• Frequency
❍ Arbitrary list (list)
❍ Start/step/count (trace)
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• IF Bandwidth
❍ Wideband mode - 1.25 MHz
❍ Narrowband mode - 30 kHz or 200 kHz (options 390 and 391 only)

• Resolution bandwidth (CW power only)
❍ 8.36 kHz to 1 MHz in wideband mode
❍ 246 Hz to 28 kHz in narrowband mode

• Channel width (channel power only)
❍ Agilent E7473A Option 320/330

▲ 8.36 kHz to 60 MHz in wideband mode
▲ 246 Hz to 60 MHz in narrowband mode

❍ Agilent E7473A Option 300/310. 380/381
▲ 8.36 kHz to 25 MHz in wideband mode
▲ 246 Hz to 25 MHz in narrowband mode

❍ Agilent E7473A Option 390/391
▲ 30 kHz to 75 MHz in wideband mode
▲ 5 kHz to 75 MHz in narrowband mode

Spectrum Measurements

Part of Agilent E7473A Option 110, 120.

The spectrum virtual front panel can be used to quickly diagnose RF 
problems. The system operates in both the downlink and uplink bands. The 
spectrum display provides the controls listed below. Frequencies can be 
specified in terms of frequency units or channel number.

Measurement Controls

• Frequency, tunable range1

❍ Agilent E7473A Option 320/330
▲ 1850 - 1910 MHz [1845 - 1915 MHz]
▲ 1930 - 1990 MHz [1925 - 1995 MHz]

1. Spectrum measurement allows some out of band tuning above and below 

specified frequency ranges. These extended ranges are shown in brackets - []. 

The performance is not specified in these ranges. Characteristic noise floor 

increase is 2 dB with respect to specified range. Characteristic amplitude 

accuracy is unchanged with respect to specified range.
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❍ Agilent E7473A Option 300/310
▲ 824 - 849 MHz [819 - 854 MHz]
▲ 869 - 894 MHz [864 - 899 MHz]

❍ Agilent E7473A Option 380/381
▲ 832 - 870 MHz [827 - 875 MHz]
▲ 887 - 925 MHz [882 - 930 MHz]

❍ Agilent E7473A Option 390/391
▲ 1710 - 1785 MHz [1705 - 1790 MHz]
▲ 1805 - 1880 MHz [1800 - 1885 MHz]

• Frequency, maximum span
❍ Agilent E7473A Option 320/330

▲ 70 MHz
❍ Agilent E7473A Option 300/310

▲ 35 MHz
❍ Agilent E7473A Option 380/381

▲ 48 MHz
❍ Agilent E7473A Option 390/391

▲ 85 MHz
• IF Bandwidth

❍ Wideband mode - 1.25 MHz
❍ Narrowband mode - 30 kHz or 200 kHz (options 390 and 391 only)

• Resolution bandwidth
❍ 8.36 kHz to 1 MHz in wideband mode
❍ 246 Hz to 28 kHz in narrowband mode

• Resolution bandwidth (Options 390/391 only)
❍ 8.36 kHz to 950 kHz in wideband mode
❍ 1.68 kHz to 190 kHz in narrowband mode

Markers

• Multiple markers
• Delta markers
• To Max function
• Drag and drop
• Marker to center
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CDMA Phone functionality

Part of Agilent E7473A Option 100, 120, 150.

The phone component of the Agilent E7473A system includes three main 
functions. Each one is associated with a control/display window called a 
virtual front panel.

• Phone control (see page 6-21)
• Measurement data (see page 6-23)
• Messaging display (see page 6-24)

CDMA Phone Call Control 

This functionality provides automated control of the handset from the PC. The 
phone control virtual front panel provides the control functions listed below.

Call controls

• Call initiation mode
❍ Sequence
❍ Single (long) call
❍ Termination

• Call initiation control
❍ Start/continue
❍ Pause
❍ Stop

• Automatic call sequencing
❍ Access time (duration of call)
❍ Redial wait (duration between calls)
❍ Total calls (number of calls to be executed)

• Automatic Redial
❍ On a dropped call
❍ On a blocked call (failed origination)
❍ Redial interval (wait duration after drop or block)
❍ Maximum redial attempts

• Phone number pick list
• Call type pick list

❍ Voice (8 or 13 kbps)
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❍ Markov (set 1 or set 2)
❍ Loopback (8 or 13 kbps)
❍ Enhanced Variable Rate Codec (EVRC)

State Controls

• No analog (forces dual mode phone to stay in digital mode)
• Log to file (creates binary file)
• Channel

❍ Channel number
❍ Frequency units

Statistics logging controls

• Attempted calls
• Dropped calls
• Blocked calls (failed originations)
• Markov data

In addition to control functionality, the phone control virtual front panel 
displays the information listed below.

Display fields (text)

• Channel
• Call information

❍ Access time counter
❍ Redial time counter
❍ Calls remaining

• Statistics
❍ Dropped call rate
❍ Blocked call rate
❍ Total attempts
❍ Total drops
❍ Total blocks
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CDMA Phone Measurement Data 

The Agilent E7473A system extracts various measurement data from the 
mobile handset. You control extraction of the specific measurement types with 
a set of check boxes. The data types are listed below.

Display fields (text)

• State
• Status (mode)
• SAT
• PN increment
• Tx Adj (Tx gain adjacent)
• RSSI (mobile received power)
• Tx Power (mobile transmit power)
• FER (frame erasure rate)
• Ec/Io 

❍ Aggregate
❍ Dominant

Tabular displays

• PN list

Bar graph displays

• Finger data (TA fingers)
• Pilot data

❍ Active
❍ Candidate
❍ Neighbor

Line graph displays

• Rx / Tx level
• Temporal analyzer (TA searcher)
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CDMA Phone Messaging 

The Agilent E7473A system extracts and decodes the over-the-air messaging 
from the handset. The user can select any or all of the channel types listed 
below from which to extract and decode messaging.

Message logging controls

• Log to display
• Snapshot

Message type selection controls

• Access
• Paging
• Sync
• Forward traffic
• Reverse traffic

In the messaging display, the user can double-click on any message to expand 
it to the next level of detail. A snapshot function captures the last 50 messages 
to a separate display while the main display continues to update.
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Agilent E7490A and Agilent E7473A CDMA 
System Specifications

Software Measurement Specifications

The Agilent E7490A and Agilent E7473A measurement software has the 
following measurement capabilities and functionality:

• “CDMA Code Domain Power (CDP) Analysis” on page 6-25
• “CDMA Base Station Spectrum Analysis” on page 6-27
• “CDMA Mobile Station Test Measurement (MOST)” on page 6-28

CDMA Code Domain Power (CDP) Analysis

Part of Agilent E7490A or Agilent E7473A option 111.

Measurement Types

• Top N
The system measures all signals in the network and returns the 
‘N’strongest power pilot signals received, where ‘N’ is a user 
definable integer from 1 to 2 for Agilent E7490A and ‘N’ is from
1 to 20 for Agilent E7473A. The results are displayed in bar 
graph format.

• CDP Trace
The system shows the power of each Walsh code and their 
relative status.

• CDP Stats
The system reports the statistics from one or more predefined lists 
selected from the display controls. These lists are:

• Modulation Stats

• Channel Stats
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• All (both)

Measurement Controls

• Carrier frequency
❍ Frequency
❍ Channel

• Measurement types
❍ Top N
❍ CDP trace
❍ CDP stats and CDP reset
❍ PN increment

• Band
❍ Uplink
❍ Downlink

Display Controls

• Power display (Y-axis parameter)
❍ Ec/Io
❍ Ec

• Show value (bar graphs only)
❍ None
❍ Delay (chips)
❍ Ec (dBm)
❍ Ec/Io (dB)
❍ Aggregate - Ec (dBm)
❍ Aggregate - Ec/Io (dB)
❍ Delay spread(chips)
❍ Aggregate - Peak (dB)
❍ Aggregate - Peak (dBm)

• CDP stats display list
❍ Modulation statistics

▲ PN
▲ Delay
▲ Estimated rho
▲ Delta paging
▲ Delta Sync
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▲ Noise floor
▲ Carrier feedthrough
▲ Multiplath power
▲ Pilot dominance
▲ Pilot power, Ec
▲ Channel power, Io
▲ Channel, carrier

❍ Channel Statistics
▲ Multipath power
▲ Pilot dominance
▲ Percentage amplitude
▲ Relative power of traffic channel
▲ Average relative power of active traffic channel
▲ Number of active traffic channels
▲ Peak held across all active traffic channels
▲ Average across all active channels

❍ All lists

CDMA Base Station Spectrum Analysis

Part of Agilent E7490A and Agilent E7473A option 111.

The spectral mask measurement enables you to visually determine whether 
the signals in your band meet the IS-97C specifications.

Measurement Types

• Spectral mask
❍ Frequency segments against which the spectrum is measured.
❍ Pass or fail of transmit power within each frequency segment.
❍ Frequency difference between center and spur of worst spurious 

signal.
❍ Amplitude difference from spur to limit line for worst spurious signal.

Measurement Controls

• Frequency units
❍ Frequency
❍ Channel
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• Carrier
• Band
• Span
• Averages

Display Controls - Markers

• Multiple markers
• Delta markers
• To Max function
• Drag and drop
• Marker to center

CDMA Mobile Station Test Measurement (MOST)

Part of Agilent E7490A and Agilent E7473A option 101.

The Mobile station test measurement (MOST) measures quality, automates 
the measurement actions, and records the results of the measurement. You 
enter the call number, the length of the call, and the code key sequence. The 
MOST test forces the phone to hand the call to the next channel element. It 
records data for the phone on the forward link, including notes, date, and time. 
FER and Walsh codes are recorded for every channel element tested.

Call Status Fields

• Channel
• Site
• Face
• Cluster control
• Channel unit
• Channel element
• FER
• Sequence number
• Walsh code

Automatic Redial

• On a dropped call
• On a blocked call (failed origination)
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• Redial interval (wait duration after drop or block)
• Maximum redial attempts

Call Test Setup Fields

❍ Directory number
❍ Function code
❍ Test interval
❍ Number of iterations
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Hardware Specifications

For full details on receiver types and options, refer to the online Agilent 
System Options and Accessories Guide. For more information on viewing and 
printing this guide, refer to “Viewing and Printing Online Documents” on 
page 3-15

Agilent E7473A and Agilent E7490A Option 300/310, 380/381 
Cellular Receiver Specifications

Model E6452A Receiver
Options 300, 310

E6452A-H02
Options 380, 381

Frequency Frequency range 824 to 849 MHz
869 to 894 MHz

832 to 870 MHz
887 to 925 MHz

Frequency accuracy
With GPS time
synchronization

±1 ppm 

±0.05 ppm, characteristic

IF bandwidth 1.25 MHz, characteristic

30 kHz, characteristic

1.25 MHz, characteristic

30 kHz, characteristic

Aging of TCXO ±1 ppm/year

Amplitude Accuracy, 1.25 MHz IF ±1 dB from –40 dBm to 
–100 dBm (20° to 30°C)

±2 dB from –40 dBm to 
–100 dBm (0° to 55°C)

±1 dB from –40 dBm to 
–100 dBm (20° to 30°C)

±2 dB from –50 dBm to 
–100 dBm (0° to 55°C)

±3 dB from –40 dBm to 
–50 dBm (0° to 55°C)

Accuracy, 30 kHz IF ±1.5 dB from –40 dBm to 
–100 dBm (20° to 30°C)

±2.5 dB from –40 dBm to 
–100 dBm (0° to 55°C)

Noise figure 8.0 dB typical 

Maximum safe input level +10 dBm, 20V DC, characteristic 

1 dB compression point a –15 dBm, characteristic
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s:
Adjacent channel 
desensitization b

Adjacent channel 
rejectionc

Internally generated 
spurious, input referred

–25 dBm typical

45 dB typical

–120 dBm

Input/Output RF input 50Ω Type-N 

Connectors Computer RS-232 (DB9) Male 

GPS RS-232 (DB9) Male 

Power DC power jack 100 mils, positive center

Miscellaneous Operating temperature 
range

0°C to 55°C

Maximum relative 
humidity

80% for temperatures up to 31°C, decreasing linearly to 
50% relative humidity at 40°C

Storage temperature 
range

–40°C to +70°C

Dimensions 6 in × 3-5/8 in × 8 in

15.24 cm x 9.21 cm x 20.32 cm

Weight 4.6 lbs (2.1 kg)

Power (option 300)

Power (internal GPS, 
option 310)

9 to 34 V DC, 9W

9 to 34 V DC, 10W

Internal GPSd 
(Option 310)

GPS Receiver 8 Channel internal GPS receiver

Connector type SMA

Differential compatible without dead reckoning

a. It is recommended the input signal level not exceed –40 dBm.
b. Adjacent channel desensitization: 1 dB compression of tuned signal with interfering signal 

1.25 MHz from tuned signal.
c. Adjacent channel rejection applies to the narrowband mode (30 kHz IF filter) and is defined a

Suppression of interfering signal ± 30 kHz from tuned signal for 30 kHz.
d. Systems fitted with an internal GPS do not support connection to external GPS receivers.

Model E6452A Receiver
Options 300, 310

E6452A-H02
Options 380, 381
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Agilent E7473A and Agilent E7490A Option 320/330, 390/391 PCS 
Receiver Specifications

Model E6450B Receiver
Options 320, 330

E6453A Receiver
Options 390, 391

Frequency Frequency range 1850 to 1910 MHz
1930 to 1990 MHz

1710 to 1785 MHz
1805 to 1880 MHz

Frequency accuracy
With GPS time
synchronization

±1 ppm 

±0.05 ppm, characteristic

IF bandwidth 
(wideband mode)

1.25 MHz, characteristic 1.25 MHz characteristic

IF bandwidth 
(narrowband mode)

30 kHz, characteristic 200 kHz, characteristic

Aging of TCXO ±1 ppm/year

Amplitude Accuracy 1.25 MHz 
IF

±1 dB from –40 dBm to 
–100 dBm (20° to 30°C)

±2 dB from –40 dBm to 
–100 dBm (0° to 55°C)

± 0.5 typical (-25 dBm to 
-100 dBm)

Accuracy, 30 kHz IF ±1.5 dB from –40 dBm to 
–100 dBm (20° to 30°C)

± 2.5 dB from –40 dBm to 
-100 dBm (0° to 55°C)

Accuracy, 200 kHz IF ± 0.5 typical (-25 dBm to 
-100 dBm)

Noise figure 8.0 dB typical 

Maximum safe input 
level

+10 dBm, 20V DC, 
characteristic

1 dB compression 
point a

–15 dBm, characteristic

Adjacent channel 
desensitization b

Adjacent channel 
rejectionc

Internally generated 
spurious, input referred

–25 dBm typical

45 dB typical

–120 dBm
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Input/Output RF input 50Ω Type-N 

Connectors Computer RS-232 (DB9) Male 

GPS RS-232 (DB9) Male 

Power DC power jack 100 mils, positive center

Miscellaneous Operating 
temperature range

0°C to 55°C

Maximum relative 
humidity

80% for temperatures up to 31°C, decreasing linearly to 
50% relative humidity at 40°C

Storage temperature 
range

–40°C to +70°C

Dimensions 6 in x 3-5/8 in x 8 in

15.24 cm x 9.21 cm x 20.32 cm

Weight 4.6 lbs (2.1 kg)

Power (option 320)

Power (internal GPS 
option 330)

9 to 34 V DC, 9W

9 to 34 V DC, 10W

Internal GPSd 
(Option 330)

GPS Receiver 8 Channel internal GPS receiver

Connector type SMA

Differential compatible without dead reckoning

a. It is recommended the input signal level not exceed –40 dBm.
b. Adjacent channel desensitization applies to wideband mode (1.25 MHz IF filter) and is defined

as: 1 dB compression of tuned signal with interfering signal 1.25 MHz from tuned signal.
c. Adjacent channel rejection applies to the narrowband mode (30 kHz and 200 kHz IF filter) and

is defined as: Suppression of interfering signal ± 30 kHz from tuned signal and ± 200 kHz from
tuned signal for 200 kHz.

d. Systems fitted with an internal GPS do not support connection to external GPS receivers.

Model E6450B Receiver
Options 320, 330

E6453A Receiver
Options 390, 391
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A 
Agilent E7474A TDMA System Specifications

Software Measurement Specifications

The Agilent E7474A measurement software has the following measurement 
capabilities and functionality:

• “TDMA Channel Analyzer” on page 6-34
• “TDMA Interference Analysis” on page 6-35
• “CW Power Measurements” on page 6-36
• “Channel Power Measurements” on page 6-37
• “Spectrum Measurements” on page 6-38
• “TDMA Phone call control” on page 6-40
• “TDMA Phone Measurement Data” on page 6-41

❍ “Large Display Virtual Front Panel (Big Font Mode)” on page 6-42
❍ “Handoff/Reselection History” on page 6-43

• “TDMA Phone Messaging” on page 6-44

TDMA Channel Analyzer

Part of Agilent E7474A Option 110, 120.

The Agilent E7475A system channel analyzer virtual front panel provides
channel power measurements with controls designed specifically for TDM
and AMPS channels. The channel width is fixed at 30 kHz.

Measurement Types

• All Channels The system measures the power, of all of the channels in a 
user specified range. The results are displayed as a trace 
with one point for each channel.

• Top N The system measures all of the channels in a user specified 
range and returns the ’N’ channels with the highest power. 
’N’ is a user definable integer from 1 to 20. Results are 
displayed in bar graph format.
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• User list The user manually inputs a list of up to 40 channels to be 
measured. The measurements are displayed in bar graph 
format with up to 20 bars. If more than 20 channels are in 
the list, all channels are measured and recorded, but only 
20 are displayed. The user list frequencies can be imported 
from a text file. This allows regularly used sets of 
frequencies or channels to be stored for quick loading into 
the application.

Measurement Controls

• Frequency units
❍ Frequency
❍ Channel
❍ Channelization selection

• Measurement types
❍ All channels
❍ Top N
❍ User list

• Channel/frequency
❍ Start, start of range
❍ Stop, end of range

Markers (Trace Displays only)

• Multiple markers
• Delta markers
• To Max function
• Drag and drop

TDMA Interference Analysis

Part of Agilent E7474A Option 110, 120.

The adjacent channel power virtual front panel measures the power of a 
serving channel and the upper and lower adjacent channels. This function is 
primarily intended for use in systems with Agilent E7474A option 120. 
Typically, the carrier frequency of the adjacent channel interference 
measurement is linked to the serving channel of the phone. When the phone is 
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handed-off to a new channel, the adjacent channel interference measurement 
tunes to the new channel. 

The adjacent channel interference measurement can also be used 
independently from the phone. A user can define a specific channel to 
measure along with the associated upper and lower adjacent channels. 

Two independent adjacent channel interference measurements are provided in 
a single virtual front panel. This is intended for two-phone configurations 
(option 150). Each adjacent channel interference measurement can be linked 
to one of the phones.

Measurement Controls

• Carrier frequency
❍ Frequency
❍ Channel

Display Controls

• Display mode
❍ Amplitude versus channel (frequency)
❍ Amplitude versus time

Measurement Results

• Adjacent carrier (A)
❍ Ratio of power C/N+1 (dB) (server to upper adjacent)
❍ Ratio of power C/N-1 (dB) (server to lower adjacent)

• Adjacent carrier (B)
❍ Ratio of power C/N+1 (dB)
❍ Ratio of power C/N-1 (dB)

CW Power Measurements

Part of Agilent E7474A Option 110, 120.

The Agilent E7474A can measure the peak power (CW Power) at 
user-defined frequencies within a user-defined resolution bandwidth. The user 
can define the frequencies to be measured in two different ways.
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Frequency Entry Methods

• List Enter an arbitrary list of frequencies.

• Trace Enter a start frequency, step size, and count. The system measures 
at the start frequency, at the (start + step) frequency, (start + (count - 
1)*step frequency. For example, if the start frequency is set to 1900 MHz, 
the step size is set to 1 MHz, and the count is set to 4; then measurements 
are made at 1900 MHz, 1901 MHz, 1902 MHz, and 1903 MHz. 
Frequencies can be specified in terms of frequency units or channel 
number.

Measurement Controls

• Frequency 
❍ Arbitrary list (list)
❍ Start/step/count (trace)

• IF bandwidth
❍ 1.25 MHz (wideband mode)
❍ 30 kHz (narrowband mode)

• Resolution bandwidth (CW power only)
❍ 8.36 kHz to 1 MHz in wideband mode
❍ 246 Hz to 28 kHz in narrowband mode

Channel Power Measurements

Part of Agilent E7474A Option 110, 120.

The Agilent E7474A system can measure the total power (Channel Power) 
within a user-defined bandwidth at a user-defined set of frequencies. This 
differs from the CW power measurement in that the total power is integrated 
across the specified channel width. The user can define frequencies to be 
measured in two different ways.

Frequency Entry Methods

• List Enter an arbitrary list of frequencies.

• Trace The power virtual front panel can be used to quickly diagnose RF 
problems. The system operates in both the downlink and uplink PCS 
bands. Enter a start frequency, step size and count. The system measures 
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at the start frequency, at the (start + step) frequency,..., (start + (count - 
1*step) frequency. For example, if the start frequency is set to 1900 MHz, 
the step size is set to 1 MHz, and the count is set to 4; the measurements 
are made at 1900 MHz, 1901 MHz, 1902 MHz and 1903 MHz.

Frequencies can be specified in terms of frequency units or channel number.

Measurement Controls

• Frequency
❍ Arbitrary list (list)
❍ Start/step/count (trace)

• IF bandwidth
❍ 1.25 MHz (wideband mode)
❍ 30 kHz (narrowband mode)

• Resolution bandwidth (CW power only)
❍ 8.36 kHz to 1 MHz in wideband mode
❍ 246 Hz to 28 kHz in narrowband mode

• Channel width (Channel power only)
❍ Cellular band receiver, Options 300, 310

▲ 8.36 kHz to 25 MHz in wideband mode
▲ 246 Hz to 25 MHz in narrowband mode

• Channel width (channel power only)
❍ PCS band receiver, Options 320, 330

▲ 8.36 kHz to 60 MHz in wideband mode
▲ 246 Hz to 60 MHz in narrowband mode

Spectrum Measurements

Part of Agilent E7474A Option 110, 120.

The spectrum virtual front panel can be used to quickly diagnose RF 
problems.The system operates in both the downlink and uplink bands. The 
spectrum display provides the controls listed below. Frequencies can be 
specified in terms of frequency units or channel number.

Measurement Controls

• Frequency, tunable range1

❍ Cellular band receiver, Options 300, 310
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▲ 824 - 849 MHz [819 - 854 MHz]
▲ 869 - 894 MHz [864 - 899 MHz]

• Frequency, tunable range
❍ PCS band receiver, Options 320, 330

▲ 1850 - 1910 MHz [1845 - 1915 MHz]
▲ 1930 - 1990 MHz [1925 - 1995 MHz]

• Frequency, maximum span
❍ Cellular band receiver, Options 300, 310

▲ 35 MHz
❍ PCS band receiver, Options 320, 330

▲ 70 MHz
• IF bandwidth

❍ 1.25 MHz (wideband mode)
❍ 30 kHz (narrowband mode)

• Resolution bandwidth
❍ 8.36 kHz to 1 MHz in wideband mode
❍ 246 Hz to 28 kHz in narrowband mode

Markers

• Multiple markers
• Delta markers
• To Max function
• Drag and drop
• Marker to center

TDMA Phone functionality

Part of Agilent E7474A Option 100, 120, 150.

The TDMA/AMPS phone component of the Agilent E7474A system includes 
three main functions. Each one is associated with a control/display window 

1. Spectrum measurement allows some out of band tuning above and below 

specified frequency ranges. These extended ranges are shown in brackets - []. 

The performance is not specified in these ranges. Characteristic noise floor 

increase is 2 dB with respect to specified range. Characteristic amplitude 

accuracy is unchanged with respect to specified range.
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called a virtual front panel. For the phone measurement data, there are two 
additional displays for data in different formats.

• Phone control (see page 6-40)
• Phone measurement data (see page 6-41)

❍ Large display virtual front panel (see page 6-42)
❍ Handoff/reselection history (see page 6-43)

• Phone messaging display (see page 6-44)

TDMA Phone call control 

This functionality provides automated control of the handset from the PC. The 
phone control virtual front panel provides the control functions listed below.

Call controls

• Call initiation mode
❍ Sequence
❍ Single (long) call

• Call mode preference
❍ Digital preferred
❍ Force digital
❍ Force analog

• Call initiation control
❍ Start/continue
❍ Pause
❍ Stop

• Automatic call sequencing
❍ Access time (duration of call)
❍ Redial wait (duration between calls)
❍ Total calls (number of calls to be executed)

• Automatic redial
❍ On a dropped call
❍ On a blocked call (failed origination)
❍ Redial interval (wait duration after drop or block)
❍ Maximum redial attempts

• Phone number pick list
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Statistics logging controls

• Attempted calls
• Dropped calls
• Blocked calls (failed originations)

In addition to control functionality, the phone control virtual front panel 
displays the information listed below.

Display fields (text)

• Channel
• State (conversation, idle and other phone states)
• Access time counter
• Redial time counter
• Calls remaining counter
• Total attempts
• Total drops
• Total blocks
• Dropped call rate
• Blocked call rate

TDMA Phone Measurement Data 

The Agilent E7474A system extracts various measurement data from the 
mobile handset. You control extraction of the specific measurement types with 
a set of check boxes. The data types are listed below.

Display fields (text)

• Server Data
❍ Channel
❍ Channel set
❍ Time slot
❍ RSSI
❍ MAC
❍ Timing advance
❍ BER
❍ Color code
❍ Site
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• Mobile data
❍ State
❍ Mode (TDMA, analog)
❍ MIN

• Best MAHO
❍ Channel
❍ RSSI

• System data
❍ System identification (SID)
❍ Home or roam
❍ Provider

Bar graph displays

• Serving channel
• MAHO channels

Line graph displays

• RSSI
• MAC
• BER
• Timing advance
• Best MAHO RSSI
• Handoff
• Reselection

Large Display Virtual Front Panel (Big Font Mode)

The large font display allows the user to select a specific set of parameters to 
look at in a text display that is easily viewed.

Display Options

• Serving channel
• Channel set
• Time slot
• RSSI
• MAC
• Timing advance
6-42 Wireless Solutions Getting Started Guide



Chapter 6: Hardware and Software Specifications
Agilent E7474A TDMA System Specifications
• BER
• Color code
• Site
• State (conversation, idle, etc.)
• Status (TDMA, Analog, etc.)
• MIN
• SID
• Best MAHO channel
• Best MAHO RSSI
• Home or roam
• Provider

Handoff/Reselection History

The hand-off history virtual front panel displays a tabular list of hand-offs and 
reselections. Each hand-off or reselection is listed as two lines:

• The before line displays the values of the key parameters immediately 
prior to the hand-off or reselection.

• The after line displays the same parameters immediately following the 
hand-off or reselection.

Tabular display of hand-offs and reselections (text)

• Hand-off or reselection indicator (home or roam)
• Time
• Delta RSSI (RSSI after - RSSI before)
• Key parameters before and after
• Serving channel
• RSSI
• BER
• Mode (TDMA, Analog,)
• Site
• Channel set
• Color code
• Timing advance
• Time slot
• MAC
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TDMA Phone Messaging

The Agilent E7474A system extracts and decodes the layer 3 over-the-air 
messaging from the handset. The user can select any or all of the message 
types listed below from which to extract and decode messaging.

Message type selection controls

• Digital Channel
❍ RACH
❍ F-BCCH
❍ E-BCCH
❍ SMSCH
❍ PCH
❍ ARCH
❍ RDTC, FACCH
❍ RDTC, SACCH
❍ FDTC, FACCH
❍ FDTC, SACCH

• Analog Channel
❍ RECC
❍ FOCC
❍ RVC
❍ FVC

In the messaging display, the user can double-click on any message to expand 
it to the next level of detail. A snapshot function captures the last 50 messages 
to a separate display while the main display continues to update.

Message logging controls

• Log to display
• Snapshot
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Hardware Specifications

For full details on receiver types and options, refer to the online Agilent 
System Options and Accessories Guide. For more information on view and 
printing this guide, refer to “Viewing and Printing Online Documents” on 
page 3-15

Agilent E7474A Option 300, 310 Cellular Receiver Specifications

Model E6452A Receiver, 
Options 300, 310

Frequency Frequency range 824 to 849 MHz
869 to 894 MHz

Frequency accuracy
With GPS time
synchronization

±1 ppm 

±0.05 ppm, characteristic

IF bandwidth 1.25 MHz, characteristic

30 KHz, characteristic

Aging of TCXO ±1 ppm/year

Amplitude Accuracy 1.25 MHz 
IF

±1 dB from –40 dBm to 
–100 dBm (20° to 30°C)

±2 dB from –40 dBm to 
–100 dBm (0° to 55°C)

Accuracy, 30 kHz IF ±1.5 dB from –40 dBm to 
–100 dBm (20° to 30°C)

± 2.5 dB from –40 dBm to 
-100 dBm (0° to 55°C)

Noise figure 8.0 dB typical 

Maximum safe input 
level

+10 dBm, 20V DC, 
characteristic

1 dB compression 
point a

–15 dBm, characteristic
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Adjacent channel 
desensitization b

Adjacent channel 
rejectionc

Internally generated 
spurious, input referred

–25 dBm typical

45 dB typical

–120 dBm

Input/Output RF input 50Ω Type-N 

Connectors Computer RS-232 (DB9) Male 

GPS RS-232 (DB9) Male 

Power DC power jack 100 mils, positive center

Miscellaneous Operating 
temperature range

0°C to 55°C

Maximum relative 
humidity

80% for temperatures up to 31°C, decreasing linearly 
to 50% relative humidity at 40°C

Storage temperature 
range

–40°C to +70°C

Dimensions 6 in x 3-5/8 in x 8 in

15.24 cm x 9.21 cm x 20.32 cm

Weight 4.6 lbs (2.1 kg)

Power (option 300) 9 to 34 V DC, 9W

Power (option 310, 
internal GPS)

9 to 34 V DC, 10W

Internal GPSd 
(Option 310)

GPS Receiver 8 Channel internal GPS receiver

Connector type SMA

Differential compatible without dead reckoning

a. It is recommended the input signal level not exceed –40 dBm.
b. Adjacent channel desensitization applies to wideband mode (1.25 MHz IF filter) and is defined

as: 1 dB compression of tuned signal with interfering signal 1.25 MHz from tuned signal.
c. Adjacent channel rejection applies to the narrowband mode (30 kHz IF filter) and is defined as:

Suppression of interfering signal ± 30 kHz from tuned signal.
d. Systems fitted with an internal GPS do not support connection to external GPS receivers.

Model E6452A Receiver, 
Options 300, 310
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Agilent E7474A Option 320, 330 PCS Receiver Specifications

Model E6450B Receiver
Options 320, 330

Frequency Frequency range 1850 to 1910 MHz
1930 to 1990 MHz

Frequency accuracy
With GPS time
synchronization

±1 ppm 

±0.05 ppm, characteristic

IF bandwidth 1.25 MHz, characteristic

30 KHz, characteristic

Aging of TCXO ±1 ppm/year

Amplitude Accuracy 1.25 MHz 
IF

±1 dB from –40 dBm to 
–100 dBm (20° to 30°C)

±2 dB from –40 dBm to 
–100 dBm (0° to 55°C)

Accuracy, 30 kHz IF ±1.5 dB from –40 dBm to 
–100 dBm (20° to 30°C)

± 2.5 dB from –40 dBm to 
-100 dBm (0° to 55°C)

Noise figure 8.0 dB typical 

Maximum safe input 
level

+10 dBm, 20V DC, 
characteristic

1 dB compression 
point a

–15 dBm, characteristic

Adjacent channel 
desensitization b

Adjacent channel 
rejectionc

Internally generated 
spurious, input referred

–25 dBm typical

45 dB typical

–120 dBm

Input/Output RF input 50Ω Type-N 
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Connectors Computer RS-232 (DB9) Male 

GPS RS-232 (DB9) Male 

Power DC power jack 100 mils, positive center

Miscellaneous Operating 
temperature range

0°C to 55°C

Maximum relative 
humidity

80% for temperatures up to 31°C, decreasing linearly 
to 50% relative humidity at 40°C

Storage temperature 
range

–40°C to +70°C

Dimensions 6 in x 3-5/8 in x 8 in

15.24 cm x 9.21 cm x 20.32 cm

Weight 4.6 lbs (2.1 kg)

Power (option 320) 9 to 34 V DC, 9W

Power (option 330, 
internal GPS)

9 to 34 V DC, 10W

Internal GPSd 
(Option 330)

GPS Receiver 8 Channel internal GPS receiver

Connector type SMA

Differential compatible without dead reckoning

a. It is recommended the input signal level not exceed –40 dBm.
b. Adjacent channel desensitization applies to wideband mode (1.25 MHz IF filter) and is defined

as: 1 dB compression of tuned signal with interfering signal 1.25 MHz from tuned signal.
c. Adjacent channel rejection applies to the narrowband mode (30 kHz IF filter) and is defined as:

Suppression of interfering signal ± 30 kHz from tuned signal.
d. Systems fitted with an internal GPS do not support connection to external GPS receivers.

Model E6450B Receiver
Options 320, 330
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Agilent E7475A GSM900, DCS1800 and 
GSM1900 System Specifications

Software Measurement Specifications

The Agilent E7475A measurement software has the following measurement 
capabilities and functionality:

• “GSM Broadcast Channel Analysis” on page 6-49
• “GSM Interference Analysis” on page 6-51
• “CW Power Measurements” on page 6-53
• “Channel Power Measurements” on page 6-54
• “Spectrum Measurements” on page 6-55
• “GSM Phone Call Control” on page 6-58
• “GSM Phone Measurement Data” on page 6-60
• “GSM Phone Messaging” on page 6-61
• “GSM Phone Scan Measurements” on page 6-62

GSM Broadcast Channel Analysis

Part of Agilent E7475A Option 110, 120.

The Agilent E7475A system is capable of collecting comprehensive RF 
measurement data. These measurements are independent of network 
parameter settings. The systems execute three different types of broadca
channel measurements (listed below). Any or all of them can be executed
simultaneously. 

Measurement Types

• All BCH The system measures the power of all GSM channels in 
the user selected range. The results are displayed as a trace 
with one point for each channel. If 20 or less channels are 
found in the range, they are displayed as a bar graph with 
amplitude versus frequency.
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• Top N The system measures all of the GSM channels in the user 
selected range and returns the N strongest GSM channels 
received. N is a user-defined variable from 1 to 20. The 
results are displayed in a bar graph of amplitude versus 
frequency or a line graph of amplitude versus time. If a 
measured channel is a broadcast channel, the BSIC can be 
decoded and a BER measurement can be returned1.

• User list: Returns power measurements from a user-defined list of 
frequencies or channels. There can be up to 40 ARFCN 
defined in the list. The user inputs a list of up to 40 GSM 
channels to be measured. The measurements are displayed 
in a bar graph of amplitude versus frequency or a line 
graph of amplitude versus time. If a measured channel is a 
broadcast channel, the BSIC can be decoded. It is also 
possible to display the highest powers of the top N 
ARFCNs from this list.The user list frequencies can be 
imported from a text file. This allows regularly-used sets 
of frequencies or channels to be stored for quick loading 
into the application.

Measurement Controls

• Frequency Units
❍ Frequency
❍ Channel

• Measurement types
❍ All BCH
❍ Top N
❍ User list

• ARFCN (Absolute Radio Frequency Channel Number)
❍ Start ARFCN, start of range
❍ Stop ARFCN, end of range

1. An estimated BER is calculated based on the number of the bit errors in the 

mid-amble of the synchronization burst.
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Markers (Trace Displays only)

• Multiple markers
• Delta Markers
• To Max function
• Drag and drop

Display Controls

• Power Display (Y-axis parameter)
❍ dBm
❍ RxLev

• Display Mode
❍ Amplitude versus Frequency
❍ Amplitude versus Time

• Show Value (bar graphs only)
❍ Power (dBm)
❍ Power in RxLev
❍ BSIC (if BSIC decode selected)
❍ BER (if BSIC decode selected)
❍ Name of cell site (if BSIC decode selected)

Measurement Results

• GSM Carrier Power
• BSIC
• BER

GSM Interference Analysis

Part of Agilent E7475A Option 110, 120.

The Agilent E7475A can make adjacent channel and co-channel interference 
measurements. The measurement returns the ratios of the power at the 
user-defined carrier frequencies and power of channels either adjacent or on 
the same channel.

Measurement controls

• Adjacent Channel measurement:
The system can make adjacent channel interference measurements. For 
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two, user-selectable channels, it can return the ratio in dB of the power in 
each channel to that in the immediately adjacent channels. 

• Co-Channel measurement:
For a single-user, selectable channel, the system can return:
❍ Total power in the channel
❍ Carrier to interferer ratio
❍ Fading
❍ Bar graph of symbol delay spread (± 6 symbols).
❍ Decoded BSIC of the primary signal in the channel.

Measurement Controls

• Frequency Units
❍ Frequency
❍ Channel

• Measurement types
❍ Adjacent channel analysis
❍ Co-channel analysis

Display Controls

• Show Value (bar graphs only)
❍ Power in dBm

Measurement Results

• Adjacent carrier (A)
❍ Ratio of power C/N+1 (dB)
❍ Ratio of power C/N-1 (dB)

• Adjacent carrier (B)
❍ Ratio of power C/N+1 (dB)
❍ Ratio of power C/N-1 (dB)

• Average power over 8 timeslots (default) - adjacent channel
• Peak power measurement - adjacent channel
• Co-Channel

❍ Total power received in channel (dBm)
❍ Primary power of strongest signal path (dBm)
❍ Peak deviation Fading from primary power (dB)
❍ Ratio of primary power / interferer (dB)
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❍ Primary BSIC and cellsite name
❍ Secondary BSIC and cellsite name
❍ Status of measurement

• Symbol Delay Spread (multi-path) graph
• Power at ± 6 symbol offsets

CW Power Measurements

Part of Agilent E7475A Option 110, 120.

The Agilent E7475A system can measure the peak power (CW Power) at 
user-defined frequencies within a user-defined resolution bandwidth. The user 
can define the frequencies to be measured in two different ways.

Frequency Entry Methods

• List: Enter an arbitrary list of frequencies. The user list frequencies can 
be imported from a text file. This allows regularly-used sets of 
frequencies or channels to be stored for quick loading into the application.

• Trace: Enter a start frequency, step size, and count. The system measures 
at the start frequency, at the (start + step) frequency,..., (start + (count - 
1*step) frequency. For example, if the start frequency is set to 900 MHz, 
the step size is set to 1 MHz, and the count is set to 4; the measurements 
are made at 900 MHz, 901 MHz, 902 MHz and 903 MHz. Frequencies 
can be specified in terms of frequency units or channel number.

Measurement Controls

• Frequency 
❍ Arbitrary list (List)
❍ Start/Step/Count (Trace)

• IF Bandwidth
❍ 1.25 MHz (wideband mode)
❍ 200 kHz (narrowband mode)

• Resolution Bandwidth (CW Power only)
❍ 8.36 kHz to 950 kHz in wideband mode
❍ 1.68 kHz to 190 kHz in narrowband mode
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Channel Power Measurements

Part of Agilent E7475A Option 110, 120.

The Agilent E7475A system can measure the total power (Channel Power) 
within a user-defined bandwidth at a user-defined set of frequencies. This 
differs from the CW power measurement in that the total power is integrated 
across the specified channel width. The user can define frequencies to be 
measured in two different ways.

Frequency Entry Methods

• List Enter an arbitrary list of frequencies. The user list frequencies can be 
imported from a text file. This allows regularly used sets of frequencies or 
channels to be stored for quick loading into the application.

• Trace The spectrum virtual front panel can be used to quickly diagnose 
RF problems. The system operates in both the downlink and uplink GSM 
bands.Enter a start frequency, step, size and count. The system measures 
at the start frequency, at the (start + step) frequency,..., (start + (count - 
1*step) frequency. For example, if the start frequency is set to 900 MHz, 
the step size is set to 1 MHz, and the count is set to 4; the measurements 
are made at 900 MHz, 901 MHz, 902 MHz and 903 MHz.

Frequencies can be specified in terms of frequency units or channel number.

Measurement Controls

• Frequency
❍ Arbitrary list (List)
❍ Start/Step/Count (Trace)

• IF Bandwidth
❍ 1.25 MHz (wideband mode)
❍ 200 kHz (narrowband mode)

• Channel Width (Channel Power only)
❍ GSM900 (option 300, 305, 310)

▲ 30 kHz to 35 MHz in wideband mode
▲ 5 kHz to 35 MHz in narrowband mode

❍ DCS1800 (option 320, 330)
▲ 30 kHz to 75 MHz in wideband mode
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▲ 5 kHz to 75 MHz in narrowband mode
❍ GSM1900 (option 340, 350)

▲ 30 kHz to 60 MHz in wideband mode
▲ 5 kHz to 60 MHz in narrowband mode

Spectrum Measurements

Part of Agilent E7475A Option 110, 120.

The spectrum virtual front panel can be used to quickly diagnose RF 
problems. The spectrum display provides the controls listed below. 
Frequencies can be specified in terms of frequency units or channel number.

Measurement Controls

• Frequency, tunable range1

❍ GSM900 (option 300, 310)
▲ 880 - 915 MHz [876 - 917 MHz]
▲ 925 - 960 MHz [921 - 962 MHz]

❍ GSM-R (option 305)
▲ 876 - 915 MHz [876 - 917 MHz]
▲ 921 - 960 MHz [921 - 962 MHz]

❍ DCS1800 (option 320, 330)
▲ 1710 - 1785 MHz [1705 - 1790 MHz]
▲ 1805 - 1880 MHz [1800 - 1885 MHz]

❍ GSM1900 (option 340, 350)
▲ 1850 - 1910 MHz [1845 - 1915 MHz]
▲ 1930 - 1990 MHz [1925 - 1995 MHz]

• Frequency, maximum span
❍ GSM900 (option 300, 310) - 41 MHz
❍ GSM-R (option 305) - 41 MHz
❍ DCS1800 (option 320, 330) - 85 MHz

1. Spectrum measurement allows some out of band tuning above and below 

specified frequency ranges. These extended ranges are shown in brackets - []. 

The performance is not specified in these ranges. Characteristic noise floor 

increase is 2 dB with respect to specified range. Characteristic amplitude 

accuracy is unchanged with respect to specified range.
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❍ GSM1900 (option 340, 350) - 70 MHz
• IF Bandwidth

❍ 1.25 MHz (wideband mode)
❍ 200 kHz (narrowband mode)

• Resolution Bandwidth
❍ 8.36 kHz to 950 kHz in wideband mode
❍ 1.68 kHz to 190 kHz in narrowband mode

Markers

• Multiple markers
• Delta Markers
• To Max function
• Drag and drop

Spectrum noise floor

• Narrowband mode, 300 kHz span
❍ -139 dBm average
❍ -138 dBm peak

• Wideband mode, 300 kHz span
❍ -131 dBm average
❍ -130 dBm peak

• Narrowband mode, 25 MHz span
❍ -130 dBm average
❍ -129 dBm peak

• Wideband mode, 25 MHz span
❍ -125 dBm average
❍ -123 dBm peak

GSM Power Measurements

The Agilent E7475A system is capable of measuring power using various 
methods. The following list describes how the techniques are used, calculated, 
and displayed.

• Spectrum and CW analyzer
❍ Peak power measurement.

• Channel analyzer
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❍ Total channel power.
• Broadcast channel and adjacent channel analyzer

❍ Power averaged over 8 timeslots.
❍ Peak power measurement.

• Broadcast channel with BSIC decoding
❍ Power is measured over 1 timeslot.

• Co-channel analyzer
❍ Power of the dominant component over 1 timeslot.

• Adjacent Channel Analyzer
❍ Power averaged over 8 timeslots.
❍ Peak power averaged over 8 timeslots.
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GSM Phone functionality

Part of Agilent E7475A Option 100, 120, 150.

The phone component of the Agilent E7475A system includes four main 
functions. 

• Phone Call Control (see page 6-58)
• Phone Measurement data (see page 6-60)
• Phone Messaging display (see page 6-61)
• Phone Scan Measurement data (see page 6-62)

GSM Phone Call Control 

This functionality provides automated control of the handset from the PC. The 
phone control virtual front panel provides the control functions listed below.

Call controls

• Call initiation mode
❍ Sequence
❍ Single (long) call
❍ Termination

• Call initiation control
❍ Start/continue
❍ Pause
❍ Stop

• Automatic call sequencing
❍ Access time (duration of call)
❍ Redial wait (duration between calls)
❍ Total calls (number of calls to be executed)

• Automatic redial
❍ On a dropped call
❍ On a blocked call (failed origination)
❍ Redial interval (wait duration after drop or block)
❍ Maximum redial attempts

• Phone number pick list
• Call option

❍ Full rate of speech
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❍ Enhanced full rate of speech (if supported by network)
• Select channel

❍ Force handover to an ARFCN
❍ Prevent handover from an ARFCN
❍ Force broadcast channel (BCH)

• Mobile behavior
❍ Restrict timeslot to be used by the mobile (0-7)
❍ Ignore cell barring

Statistics logging controls

• Attempted calls
• Dropped calls
• Blocked calls (failed originations)
• Handover data

In addition to control functionality, the phone control virtual front panel 
displays the information listed below.

Display fields (text)

• Call information
❍ Access time counter
❍ Redial time counter
❍ Calls remaining

• Statistics
❍ Dropped call rate
❍ Blocked call rate
❍ Total attempts
❍ Total drops
❍ Total blocks

• Handover Information
❍ Successful handovers
❍ Failed handovers
❍ Attempted handovers

• Serving cell ARFCN
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GSM Phone Measurement Data 

The Agilent E7475A system extracts various measurement data from the 
mobile handset. You control extraction of the specific measurement types with 
a set of check boxes. The data types are listed below.

Display fields (text)

• State (No service, idle or dedicated)
• Serving cell information

❍ BCH
❍ BSIC (base station identity code)
❍ Cell identity
❍ Cell name
❍ LAC (Location area code)
❍ MNC (mobile network code)
❍ MCC (mobile country code)

• Mobile measurement information
❍ TCH (traffic) ARFCN
❍ RxLev (full or sub)
❍ RxQual (full or sub)
❍ Mobile transmit power
❍ Timing advance
❍ Timeslot
❍ Radio link timeout counter (RLTC)
❍ Frame erasure rate (FER)

Tabular displays

• Frequency hopping sequence
• Neighbor cell list
• C1 and C2 path loss and re-selection parameters (not for Sagem 

OT-35G/D phones)

Graph displays

• Serving cell and neighbor cells amplitude versus frequency
• Serving cell and neighbor cells amplitude versus time
• Mobile measurements

❍ RxQual versus time (displayed as RxQual-sub or RxQual-full)
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❍ RxLev versus time (Can be displayed as RxLev-sub or RxLev-full.)
❍ Tx power versus time
❍ Timing advance versus time

GSM Phone Messaging 

The Agilent E7475A system extracts and decodes the Layer 3 over-the-air 
messaging from the handset. The user can select any or all of the channel 
types listed below from which to extract and decode messaging.

Message type selection controls

• Layer 3 messages
❍ Call control
❍ Radio resource
❍ Mobility management

• Layer 2 messages
❍ Sub-set of layer 2 messages1.

In the messaging display, the user can double-click on any message to expand 
it to the next level of detail. A snapshot function captures the last 50 messages 
to a separate display while the main display continues to update.

Message logging controls

• Log to display
• Layer 2 messages
• Layer 3 messages
• Snapshot 

1. The Layer 2 protocol decodes are dependent on the test mobile phone hardware 

used. Currently the Sagem OT35x, OT55x and OT75x provide only the 

Information (I) messages and the SABM messages. The Sagem OT95x and the 

Orbitel 907 test mobiles provide the full Layer 2 commands covered in 

GSM 04.06 version 5.2.1 table 4.
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GSM Phone Scan Measurements

Part of Agilent E7475A Option 130

The Agilent E7475A system enables the phone to switch into a scanning 
mode and to pass these measurements for display and recording. The mobile 
scans all broadcast channels1.

Measurement Types

• All BCH The system will scan through and measure the power in all the 
frequency channels in its operating range. The results are 
displayed as a trace with one point for each of the channels.

• Top N The system will scan through and measure the power in all the 
frequency channels is its operating range. The Top N channels, 
where N is an integer between 1 and 20, are then displayed in 
either a bar graph of amplitude versus frequency or a line graph 
of amplitude versus time.

• User list The user inputs a list of up to 20 GSM channels to be measured. 
The results are displayed in a bar graph of amplitude versus 
frequency or a line graph of amplitude versus time.

Measurement Controls

• Frequency units
❍ Frequency
❍ Channel

• Measurement types
❍ All BCH
❍ Top N
❍ User list

Markers (Trace Displays only)

• Multiple markers
• Delta markers
• To Max function

1. When a test mobile is being used as a frequency scanner, it cannot be used to set 

up calls and log other data at the same time.
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• Drag and drop

Display Controls

• Power display (Y-axis parameter)
❍ dBm
❍ RxLev

• Display mode
❍ Amplitude versus frequency
❍ Amplitude versus Time

• Show value (bar graphs only)
❍ Power (dBm)
❍ Power in RxLev

Measurement Results

• GSM carrier power
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Hardware Specifications

For full details on receiver types and options, refer to the online Agilent 
System Options and Accessories Guide. For more information on view and 
printing this guide, refer to “Viewing and Printing Online Documents” on 
page 3-15

Agilent E7475A Options 300, 310, 320, 330, 340, and 350 Receiver 
Specifications

Model Agilent E7475A 
Option 300, 310
(E6451A)

Agilent E7475A 
Option 320, 330
(E6453A)

Agilent E7475A 
Option 340, 350
(E6454A)

Frequency Frequency range 880 to 915 MHz
925 to 960 MHz

1710 to 1785 MHz
1805 to 1880 MHz

1850 to 1910 MHz
1930 to 1990 MHz

Frequency accuracy ±1 ppm

IF bandwidth 1.25 MHz, characteristic (wideband mode)

200 kHz, characteristic (narrowband mode)

Aging of TCXO ±1 ppm/year

Amplitude Accuracy, 1.25 MHz IF 
bandwidth

± 0.5 typical (-25 dBm to -100 dBm)

Accuracy, 200 kHz IF 
bandwidth

± 0.5 typical (-25 dBm to -100 dBm)

Noise figure 8 dB typical 

Maximum safe input level +10 dBm, 20V DC, characteristic 

1 dB compression point a –15 dBm, characteristic

Adjacent channel 
desensitization b

Adjacent channel 
rejectionc

Internally generated 
spurious, input referred

–25 dBm typical

45 dB typical

–120 dBm

Input/Output RF input 50Ω Type-N 
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:

Connectors Computer RS-232 (DB9) 
Male 

GPS RS-232 (DB9) 
Male 

Power DC power jack 100 mils, positive center

Miscellaneous Operating temperature 
range

0°C to 55°C

Maximum relative humidity 80% for temperatures up to 31°C, 
decreasing linearly to 50% relative 
humidity at 40°C

Storage temperature 
range

–40°C to +70°C

Dimensions 6 in x 3-5/8 in x 8 in

15.24 cm x 9.21 cm x 20.32 cm

Weight 2.1 kg (4.6 lbs)

Power (options 300, 320, 
340)

Power (internal GPS, 
Option 310, 330, 350)

9 to 34 V DC, 9W

9 to 34 V DC, 10W

Internal GPSd 
(Option 310, 
330, 350)

GPS Receiver 8 Channel internal GPS receiver

Connector type SMA

Differential compatible without dead reckoning

a. It is recommended the input signal level not exceed –25 dBm.
b. Adjacent channel desensitization applies to the wideband mode (1.25 MHz IF Filter) and is

defined as: 1 dB compression of tuned signal with interfering signal ±1.25 MHz from tuned
signal.

c. Adjacent channel rejection applies to the narrowband mode (200 kHz IF filter) and is defined as
Suppression of interfering signal ± 200 kHz from tuned signal.

d. Systems fitted with an internal GPS do not support connection to external GPS receivers.

Model Agilent E7475A 
Option 300, 310
(E6451A)

Agilent E7475A 
Option 320, 330
(E6453A)

Agilent E7475A 
Option 340, 350
(E6454A)
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HP E7475A Options 305 Receiver Specifications

Model Agilent E7475A 
Option 305
(E6451A-E03)

Frequency Frequency range 876 to 915 MHz
921 to 960 MHz

Frequency accuracy ±1 ppm

IF bandwidth 1.25 MHz, characteristic (wideband mode)

200 kHz, characteristic (narrowband mode)

Aging of TCXO ±1 ppm/year

Amplitude 880 to 915 MHz and 925 to 960 MHz range:

Accuracy, 1.25 MHz IF 
bandwidth

± 0.5 dB typical (-25 dBm to -100 dBm)

Accuracy, 200 kHz IF 
bandwidth

± 0.5 dB typical (-25 dBm to -100 dBm)

Noise figure 8 dB typical 

876 to 880 MHz and 921 to 925 MHz range:

Accuracy, 1.25 MHz IF 
bandwidth

± 1 dB typical (-25 dBm to -100 dBm)

Accuracy, 200 kHz IF 
bandwidth

± 1 dB typical (-25 dBm to -100 dBm)

Noise figure 11 dB typical 

Maximum safe input level +10 dBm, 20V DC, characteristic 

1 dB compression point a –15 dBm, characteristic

Adjacent channel 
desensitization b

Adjacent channel 
rejectionc

Internally generated 
spurious, input referred

–25 dBm typical

45 dB typical

–120 dBm

Input/Output RF input 50Ω Type-N 
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Agilent E7475A GSM900, DCS1800 and GSM1900 System Specifications

:

Connectors Computer RS-232 (DB9) Male 

GPS RS-232 (DB9) Male 

Power DC power jack 100 mils, positive center

Miscellaneous Operating temperature 
range

0°C to 55°C

Maximum relative 
humidity

80% for temperatures up to 31°C, decreasing linearly to 
50% relative humidity at 40°C

Storage temperature 
range

–40°C to +70°C

Dimensions 6 in x 3-5/8 in x 8 in

15.24 cm x 9.21 cm x 20.32 cm

Weight 2.1 kg (4.6 lbs)

Power (option 305) 9 to 34 V DC, 9W

Internal GPS 
(Option 305)

Not supplied

a. It is recommended the input signal level not exceed –25 dBm.
b. Adjacent channel desensitization applies to the wideband mode (1.25 MHz IF Filter) and is

defined as: 1 dB compression of tuned signal with interfering signal ±1.25 MHz from tuned
signal.

c. Adjacent channel rejection applies to the narrowband mode (200 kHz IF filter) and is defined as
Suppression of interfering signal ± 200 kHz from tuned signal.

Model Agilent E7475A 
Option 305
(E6451A-E03)
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General Hardware Specifications and Minimum 
System Requirements

Personal Computer Recommendations, Minimum

The PC requirements differ depending on the operating system, and on 
whether you wish to collect data from a single phone or multiple phones.

Single phone

• Windows 95/98
❍ Minimum: 233 MHz Pentium, 64 Mbytes RAM
❍ Recommended: 266 MHz Pentium II or III, 64 Mbytes RAM

• Windows NT
❍ Minimum: 233 MHz Pentium, 64 Mbytes RAM
❍ Recommended: 266 MHz Pentium II or III, 128 Mbytes RAM

Multiple phone

• Windows 95/98
❍ Minimum: 266 MHz Pentium, 64 Mbytes RAM
❍ Recommended: 366 MHz Pentium II or III, 64 Mbytes RAM

• Windows NT
❍ Minimum: 266 MHz Pentium, 64 Mbytes RAM
❍ Recommended: 366 MHz Pentium II or III, 128 Mbytes RAM

Common Requirements

• RS-232 DB9 Serial Port
• Parallel port: 25-pin bidirectional
• 90 Mbytes disk space for software installation
• 200 Mbytes disk space for data (recommended)
• CD-ROM drive recommended
• 800 x 600 display resolution minimum
• For multiple phone capability, two PCMCIA slots
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General Hardware Specifications and Minimum System Requirements
Supported Phones

Agilent E7473A CDMA systems:

• Qualcomm QCP-800, QCP-820, QCP-860, QCP-1900, QCP-1920, 
QCP-1960, QCP-2700, QCP-2760

• Sony CM-D500, CM-D600, CM-M1300, CM-B1201SPR, 
CM-S1101SPR

• Samsung SCH-1000
• Lucky Goldstar LG1300 Korean PCS
• Toshiba CM10 for Cellular J-CDMA

Agilent E7474A TDMA systems:

• Motorola StarTAC ST7790 TDMA/AMPS - 800 MHz
• Motorola StarTAC ST7797 TDMA/AMPS - 800 MHz and 

TDMA 1900 MHz

Agilent E7475A GSM systems:

• Sagem OT-35G GSM900
• Sagem OT-35D DCS1800
• Sagem OT-55G GSM900
• Sagem OT-55D DCS1800
• Sagem OT-55P GSM1900
• Sagem OT-55R GSM-R
• Sagem OT-75M Dual Band
• Sagem OT-95
• Orbitel ST-907

External GPS Receiver Requirements

• TSIP, TAIP, or NMEA communication protocol
• RS-232 (DB9) interface
• Any external GPS will have to output a GPS 1 pulse/second signal for 

Pilot correlation for Agilent E7473A options 110, 111, or 120 and 
Agilent E7490A option 111.
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General Hardware Specifications and Minimum System Requirements
GPS Systems Supported1

• Bosch Travel Pilot RGS08 Professional
• Magneti Marelli RP Nav200
• GARMIN GPSII/III
• Trimble DR
• Trimble 455/DR and 450
• Trimble SVeeSix
• Trimble 400

Differential GPS Receiver Requirements

• DCI RDS-3000

Antennas

• Receiver RF input specifications:
❍ Input impedance: 50Ω
❍ Connector type: Type-N

1. Not all these systems can provide 1 pulse/second signal for Pilot correlation.
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Chapter 7: Safety and Regulatory Information
Warning and Caution Notices
Warning and Caution Notices

Review this product and related documentation to familiarize yourself with 
safety markings and instructions before you operate the system. This product 
has been designed and tested in accordance with appropriate international 
standards.

WARNING The WARNING notice denotes a hazard. It calls attention to a procedure, 
practice, or the like, that, if not correctly performed or adhered to, could result in 
personal injury. Do not proceed beyond a WARNING notice until the indicated 
conditions are fully understood and met.

CAUTION The CAUTION notice denotes a hazard. It calls attention to an operating 
procedure, practice, or the like, which, if not correctly performed or adhered 
to, could result in damage to the product or loss of important data. Do not 
proceed beyond a CAUTION notice until the indicated conditions are fully 
understood and met. 
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Warning and Caution Notices
Instrument Markings

When you see this symbol on your instrument, you should refer to the 
instrument’s instruction manual for important information.

This symbol indicates hazardous voltages.

The laser radiation symbol is marked on products that have a laser output.

This symbol indicates that the instrument requires alternating current (ac) input.

This symbol indicates that the instrument requires direct current (dc) input.

The CE mark is a registered trademark of the European Community. If it is 
accompanied by a year, it indicates the year the design was proven.

The CSA mark is a registered trademark of the Canadian Standards Association.

ISM 1-A This text indicates that the instrument is an Industrial Scientific and Medical 
Group 1 Class A product (CISPER 11, Clause 4).

This symbol indicates that the power line switch is ON.

This symbol indicates that the power line switch is in STANDBY position.

The C-Tick mark is a registered trademark of the Spectrum Management Agency 
of Australia. This signifies compliance with the Australian EMC Framework 
Regulations under the terms of the Radio communications Act of 1992

This symbol indicates that the power line switch is in OFF position.

!
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General Safety Considerations

The Agilent digital receiver has been designed and tested in accordance with 
IEC Publication 1010, Safety Requirements for Electronic Measuring 
Apparatus, and has been supplied in a safe condition. The documentation 
contains information and warnings which must be followed by the user to 
ensure safe operation and to maintain the product in a safe condition.

WARNING • If this product is not used as specified, the protection provided by the 
equipment could be impaired. This product must be used in a normal 
condition (in which all means for protection are intact) only.

• No operator serviceable parts are inside this system. Refer servicing to a 
qualified Agilent Technologies, Inc. service center. To prevent electrical 
shock, do not remove the covers.

• To prevent electrical shock, disconnect the Agilent receiver from mains 
before cleaning. Use a dry cloth or one slightly dampened with water to 
clean the external case parts. Do not attempt to clean the receiver internally.
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General Safety Considerations
Product Installation, Use, and Storage

CAUTIONS • This Agilent digital receiver is designed for use in INSTALLATION 
CATEGORY II and POLLUTION DEGREE 2, per IEC 1010 and 664 
respectively.

• Enclosure protection IP40 according to IEC 529. 

• Install the system according to the enclosure protection provided. This 
system does not protect against the ingress of water. This instrument 
protects against entry of solid foreign objects greater than, or equal to, 
one millimeter. 

Product Power

CAUTIONS • The input power to the Agilent digital receiver should not exceed 
–15 dBm. Power levels greater than +10 dBm will damage the 
instrument.

• For continued protection against fire hazard, replace the line fuse 
(cigarette lighter/2 amp 32 V FB fuse) only with the same type of rating 
(type nA/nV). The use of other fuses or materials is prohibited.

• If you use external power, install the instrument so the detachable power 
cord is readily identifiable and is easily reached by the operator. The 
detachable power cord is the instrument disconnecting device. It 
disconnects the mains circuit from the mains supply before other parts of 
the instrument. 

• If you do not use external power, position the product so you can easily 
operate the disconnecting device. 
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Declarations of Conformity
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